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Prologue

Welcome

Welcome to Geing Started with Ubuntu, an introductory guide wrien to
help new users get started with Ubuntu.

Our goal is to cover the basics of Ubuntu (such as installation and work-
ing with the desktop) as well as hardware and soware management, work-
ing with the command line, and security. We designed this guide to be
simple to follow, with step-by-step instructions and plenty of screenshots,
allowing you to discover the potential of your new Ubuntu system.

Please bear in mind that this guide is still very much a work in progress
and always will be. It is wrien specifically for Ubuntu ., and although
we have aimed to not limit our instructions to this version, it is unavoidable
that some things will change over the life of Ubuntu. Whenever a new
version of Ubuntu is released, we will incorporate updates and changes into
our guide, and make a new version available at http://www.ubuntu-manual.
org.

Geing Started with Ubuntu . is not intended to be a comprehensive
Ubuntu instruction manual. It is more like a quick-start guide that will get
you doing the things you need to do with your computer quickly and easily,
without geing bogged down with technical details. As with prior versions,
Ubuntu . incorporates many new features, including enhancements to
the Unity shell. More about the Unity shell and what it means can be found
in Chapter : e Ubuntu Desktop.

For more detailed information on using Unity and the Ubuntu desktop,
see the “Ubuntu Desktop Guide,” which can be obtained in the following
ways:

‣ in the Dash, type yelp;
‣ in the desktop menubar, click Help ‣Help with Ubuntu; or
‣ go to https://help.ubuntu.com, Ubuntu . ‣Ubuntu Desktop Help.

e Internet is also an excellent resource. For example, on https://help.
ubuntu.com you will find documentation on installing and using Ubuntu,
and at the Ubuntu Forums (ubuntuforums.org) you find answers to many
Ubuntu related questions. More information about Ubuntu’s online

and system documentation can be found in
Chapter 8: Learning More. Popular forums
for Ubuntu discussion and support are the
Ubuntu Forums, http://ubuntuforums.org, and
Askubuntu at http://askubuntu.com.

If something isn’t covered in this manual, chances are you will find the
information you are looking for in one of those locations. We will try our
best to include links to more detailed help wherever we can.

Ubuntu Philosophy

e term “Ubuntu” is a traditional African concept that originated from
the Bantu languages of southern Africa. It can be described as a way of
connecting with others—living in a global community where your actions
affect all of humanity. Ubuntu is more than just an operating system: it is
a community of people that come together voluntarily to collaborate on
an international soware project that aims to deliver the best possible user
experience.

http://www.ubuntu-manual.org
http://www.ubuntu-manual.org
https://help.ubuntu.com
https://help.ubuntu.com
https://help.ubuntu.com
http://ubuntuforums.org
http://askubuntu.com
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The Ubuntu Promise

‣ Ubuntu will always be free of charge, along with its regular enterprise
releases and security updates.

‣ Ubuntu comes with full commercial support from Canonical and hun-
dreds of companies from across the world.

‣ Ubuntu provides the best translations and accessibility features that the
free soware community has to offer.

‣ Ubuntu’s core applications are all free and open source. We want you to
use free and open source soware, improve it, and pass it on.

A brief history of Ubuntu

Ubuntu was conceived in  by Mark Shuleworth, a successful South
African entrepreneur, and his company Canonical. Shuleworth recognized Canonical is the company that provides financial

and technical support for Ubuntu. It has
employees based around the world who work
on developing and improving the operating
system, as well as reviewing work submitted by
volunteer contributors. To learn more about
Canonical, go to http://www.canonical.com.

the power of Linux and open source, but was also aware of weaknesses that
prevented mainstream use.

Shuleworth set out with clear intentions to address these weaknesses
and create a system that was easy to use, completely free (see Chapter :
Learning More for the complete definition of “free”), and could compete
with other mainstream operating systems. With the Debian system as a
base,Shuleworth began to build Ubuntu. Using his own funds at first, Debian is the Linux operating system that

Ubuntu is based upon. For more information
visit http://www.debian.org/.

installation s were pressed and shipped worldwide at no cost to the end
user. Ubuntu spread quickly, the size of the community rapidly increased,
and it soon became the most popular Linux distribution available.

With more people working on the project than ever before, Ubuntu con-
tinues to see improvement to its core features and hardware support, and
has gained the aention of large organizations worldwide. One of IBM’s
open source operating systems is based on Ubuntu. Additionally, in ,
the French Police began to transition their entire computer infrastructure to
a variant of Ubuntu—a process which has reportedly saved them “millions
of euros” in licensing fees for Microso Windows. By the year , the
French Police anticipates that all of their computers will be running Ubuntu.
Canonical profits from this arrangement by providing technical support and
custom-built soware.

While large organizations oen find it useful to pay for support services, For information on Ubuntu Server Edition, and
how you can use it in your company, visit http://
www.ubuntu.com/business/server/overview.

Shuleworth has promised that the Ubuntu desktop system will always
be free. As of , Ubuntu is installed on an estimated % of the world’s
computers. is equates to millions of users worldwide, and is growing
each year. Because of a lack of registration, the percentage of Ubuntu users
should be treated as an estimate.

What is Linux?

Ubuntu is built on the foundation of Linux, which is a member of the Unix
family. Unix is one of the oldest types of operating systems and has pro-
vided reliability and security in professional applications for almost half a
century. Many servers around the world that store data for popular web-
sites (such as YouTube and Google) run some variant of a Unix system.
e Linux kernel is best described as the core, or almost the brain, of the
operating system.

e Linux kernel is the controller of the operating system; it is responsi-
ble for allocating memory and processor time. It can also be thought of as
the program which manages any and all applications on the computer itself.

http://www.canonical.com
http://www.debian.org/
http://www.ubuntu.com/business/server/overview
http://www.ubuntu.com/business/server/overview
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Linux was designed from the ground up with security and hardware While modern graphical desktop environments
have generally replaced early command-line
interfaces, the command line can still be a
quick and efficient way of performing many
tasks. See Chapter 6: Advanced Topics for
more information, and Chapter 2: The Ubuntu
Desktop to learn more about gnome and other
desktop environments.

compatibility in mind, and is currently one of the most popular Unix-based
operating systems. One of the benefits of Linux is that it is incredibly flex-
ible and can be configured to run on almost any device—from the smallest
micro-computers and cellphones to larger super-computers. Unix was en-
tirely command line-based until graphical user interfaces (s) began to
emerge in the early s.

ese early s were difficult to configure, clunky, and generally only A desktop environment is a sophisticated and
integrated user interface that provides the
basis for humans to interact with a computer
using a monitor, keyboard and a mouse.

used by seasoned computer programmers. In the past decade, however,
graphical user interfaces have come a long way in terms of usability, reli-
ability, and appearance. Ubuntu is just one of many different Linux distri-
butions, and uses one of the more popular graphical desktop environments To learn more about Linux distributions, see

Chapter 8: Learning More.called .

Is Ubuntu right for you?

New users to Ubuntu may find that it takes some time to feel comfortable
when trying a new operating system. You will no doubt notice many sim-
ilarities to both Microso Windows and Mac  , and some differences.
Users coming from Mac   are more likely to notice similarities due to the
fact that both Mac   and Ubuntu originated from Unix.

Before you decide whether or not Ubuntu is right for you, we suggest
giving yourself some time to grow accustomed to the way things are done
in Ubuntu. You should expect to find that some things are different from
what you are used to. We also suggest taking the following into account:

Ubuntu is community based. at is, Ubuntu is developed, wrien, and
maintained by the community. Because of this, support is probably
not available at your local computer store. Fortunately, the Ubuntu
community is here to help. ere are many articles, guides, and manuals
available, as well as users on various Internet forums and Internet Relay
Chat () rooms that are willing to assist beginners. Additionally, near
the end of this guide, we include a troubleshooting chapter: Chapter :
Troubleshooting.

Many applications designed for Microso Windows or Mac   will not run on Ubuntu.
For the vast majority of everyday computing tasks, you will find suitable
alternative applications available in Ubuntu. However, many profes-
sional applications (such as the Adobe Creative Suite) are not developed
to work with Ubuntu. If you rely on commercial soware that is not
compatible with Ubuntu, yet still want to give Ubuntu a try, you may
want to consider dual-booting. Alternatively, some applications devel- To learn more about dual-booting (running

Ubuntu side-by-side with another operating
system), see Chapter 1: Installation.

oped for Windows will work in Ubuntu with a program called Wine. For
more information on Wine, go to http://www.winehq.org.

Many commercial games will not run on Ubuntu. If you are a heavy gamer,
then Ubuntu may not be for you. Game developers usually design games
for the largest market. Since Ubuntu’s market share is not as substantial
as Microso’s Windows or Apple’s Mac  , most game developers
will not allocate resources towards making their games compatible with
Ubuntu. If you just like to play a game every now and then, there is See Chapter 5: Software Management to learn

more about Ubuntu Software Center.active game development within the community, and many high quality
games can be easily installed through the Ubuntu Soware Center.

http://www.winehq.org
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Contact details

Many people have contributed their time to this project. If you notice any
errors or think we have le something out, feel free to contact us. We do
everything we can to make sure that this manual is up to date, informative,
and professional. Our contact details are as follows:

e Ubuntu Manual Team
Website: http://www.ubuntu-manual.org/
Email: ubuntu-manual@lists.launchpad.net
: #ubuntu-manual on irc.freenode.net
Bug Reports: http://bugs.ubuntu-manual.org

About the team

Our project is an open source volunteer effort to create and maintain qual-
ity documentation for Ubuntu and its derivatives.

Our mission is to provide a wide range of quality educational materi-
als to lower the Linux barrier to entry for new users and in turn increase
Ubuntu’s market share.

Want to help?

We are always looking for talented people to work with, and due to the size
of the project we are fortunate to be able to cater to a wide range of skill
sets:

‣ Authors, editors
‣ Programmers (Python or TEX)
‣ User interface designers
‣ Icon and title page designers
‣ Event organizers and ideas people
‣ Testers
‣ Web designers and developers
‣ Translators and screenshoers
‣ Bug reporters and triagers

To find out how you can get started helping, please visit http://ubuntu-manual.
org/getinvolved.

Conventions used in this book

e following typographic conventions are used in this book:

‣ Buon names, menu items, and other  elements are set in boldfaced
type.

‣ Menu sequences are sometimes typeset as File ‣ Save As…, which means,
“Choose the File menu, then choose the Save As….”

‣ Monospaced type is used for text that you type into the computer, text
that the computer outputs (as in a terminal), and keyboard shortcuts.

http://www.ubuntu-manual.org/
ubuntu-manual@lists.launchpad.net
irc.freenode.net
http://bugs.ubuntu-manual.org
http://ubuntu-manual.org/getinvolved
http://ubuntu-manual.org/getinvolved


1 Installation

Getting Ubuntu

Before you can get started with Ubuntu, you will need to obtain a copy of Many companies (such as Dell and System76)
sell computers with Ubuntu preinstalled. If
you already have Ubuntu installed on your
computer, feel free to skip to Chapter 2: The
Ubuntu Desktop.

the Ubuntu installation image for  or . Some options for doing this are
outlined below.

Minimum system requirements

Ubuntu runs well on most computer systems. If you are unsure whether it The majority of computers in use today will
meet the requirements listed here; however,
refer to your computer documentation or
manufacturer’s website for more information.

will work on your computer, the Live  is a great way to test things out
first. Below is a list of hardware specifications that your computer should
meet as a minimum requirement.

‣  GHz x processor (Pentium  or beer)
‣   of system memory ()
‣   of disk space (at least   is recommended)
‣ Graphics card capable of × resolution
‣ Sound card
‣ A network or Internet connection

Downloading Ubuntu

e easiest and most common method for geing Ubuntu is to download
the Ubuntu  image directly from http://www.ubuntu.com/download.
Choose how you will install Ubuntu:

‣ Download and install
‣ Try it from a  or  stick
‣ Run it with Windows

For the Download and install, or Try it from a  or  stick options, se-
lect whether you require the -bit or -bit version (-bit is recommended
for most users), then click “Start download.”

Installing and run alongside Windows

For the Run it with Windows option, simply select “Start download,” and
then follow the instructions for the Ubuntu installer for Windows.

32-bit vs 64-bit

Ubuntu and its derivatives are available in two versions: -bit and -bit.
is difference refers to the way computers process information. Comput- 32-bit and 64-bit are types of processor

architectures. 64-bit is newer, and most recent
computers will come with a 64-bit capable
processor.

ers capable of running -bit soware are able to process more information
than computers running -bit soware; however, -bit systems require
more memory in order to do this. Nevertheless, these computers gain per-
formance enhancements by running -bit soware.

‣ If your computer has a -bit processor install the -bit version.
‣ If your computer is older, a netbook, or you do not know the type of

processor in the computer, install the -bit version.

http://www.ubuntu.com/download
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If your computer has a -bit processor, click on the “-bit” option
before you click “Start download.”

Downloading Ubuntu as a torrent

When a new version of Ubuntu is released, the download servers can get Torrents are a way of sharing files and informa-
tion around the Internet via peer-to-peer file
sharing. A file with a .torrent extension is made
available to users, which is then opened with a
compatible program such as uTorrent, Deluge,
or Transmission. These programs download
parts of the file from other people all around
the world.

“clogged” as large numbers of people try to download or upgrade Ubuntu
at the same time. If you are familiar with using torrents, you may wish to
download the torrent file by clicking “Alternative downloads,” and then
“BitTorrent download” to obtain your copy of the  image this way in-
stead. You may see significant improvements to your download speed, and
will also be helping to spread Ubuntu to other users worldwide.

Burning the CD image

Once your download is complete, you will be le with a file called ubuntu- While the 64-bit version of Ubuntu is referred
to as the “AMD64” version, it will work on Intel,
AMD, and other compatible 64-bit processors.

.-desktop-i.iso or similar (i here in the filename refers to the -bit
version. If you had downloaded the -bit version, the filename would
contain amd instead). is file is a  image—a snapshot of the contents
of a —which you will need to burn to a .

Creating a bootable USB drive

If your  is able to boot from a  port, you may prefer to use a 
memory stick instead of burning a . Scroll down to “Burn your  or
create a  drive,” select  or  stick, choose the  you are using to
create the  drive, and then click Show me how. If you select the “
Stick” option, your installation will be running from the  memory stick.
In this case, references to Live , will refer to the  memory stick.

The Live CD/USB stick

e Ubuntu  and  stick function not only as installation media, but
also allow you to test Ubuntu without making any permanent changes to
your computer by running the entire operating system from the  or 
stick.

Your computer reads information from a  at a much slower speed than In some cases, your computer will not recognize
that the Ubuntu CD or USB is present as it
starts up and will start your existing operating
system instead. Generally, this means that
the priority given to boot devices when your
computer is starting needs to be changed. For
example, your computer might be set to look
for information from your hard drive, and then
to look for information on a CD or USB. To run
Ubuntu from the Live CD or USB, we want the
computer to look for information from the
appropriate device first. Changing your boot
priority is usually handled by BIOS settings; this
is beyond the scope of this guide. If you need
assistance with changing the boot priority, see
your computer manufacturer’s documentation
for more information.

it can read information off of a hard drive. Running Ubuntu from the Live
 also occupies a large portion of your computer’s memory, which would
usually be available for applications to access when Ubuntu is running from
your hard drive. e Live / experience will therefore feel slightly
slower than it does when Ubuntu is actually installed on your computer.
Running Ubuntu from the / is a great way to test things out and
allows you to try the default applications, browse the Internet, and get a
general feel for the operating system. It’s also useful for checking that your
computer hardware works properly in Ubuntu and that there are no major
compatibility issues.

To try out Ubuntu using the Live / stick, insert the Ubuntu  into
your  drive, or connect the  drive and restart your computer.

Aer your computer finds the Live / stick, and a quick loading
screen, you will be presented with the “Welcome” screen. Using your
mouse, select your language from the list on the le, then click the but-
ton labeled Try Ubuntu. Ubuntu will then start up, running directly from
the Live / drive.
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Figure 1.1: The “Welcome” screen allows you to
choose your language.

Once Ubuntu is up and running, you will see the default desktop. We
will talk more about how to actually use Ubuntu in Chapter : e Ubuntu
Desktop, but for now, feel free to test things out. Open some applications,
change seings and generally explore—any changes you make will not be
saved once you exit, so you don’t need to worry about accidentally breaking
anything.

When you are finished exploring, restart your computer by clicking the Alternatively, you can also use your mouse to
double-click the “Install Ubuntu 11.10” icon that
is visible on the desktop when using the Live
CD. This will start the Ubuntu installer.

“Power” buon in the top right corner of your screen (a circle with a line
through the top) and then select Restart. Follow the prompts that appear on
screen, including removing the Live  and pressing Enter when instructed,
and then your computer will restart. As long as the Live  is no longer in
the drive, your computer will return to its original state as though nothing
ever happened!

Installing Ubuntu

e process of installing Ubuntu is designed to be quick and easy. To help
you get started, we have included step-by-step instructions below, along
with screenshots so you can see how things will look along the way.

At least  of free space on your hard drive is required in order to
install Ubuntu; however,   or more is recommended. is will ensure
that you will have plenty of room to install extra applications later on, as
well as store your own documents, music, and photos.

Getting started

To get started, place the Ubuntu  in your  drive and restart your com- Clicking on the underlined “release notes” link
will open a web page containing any important
information regarding the current version of
Ubuntu.

puter. Your computer should load Ubuntu from the . When you first start
from the , you will be presented with a screen asking you whether you
want to first try out Ubuntu or install it. Select the language you want to
view the installer in and click on the Install Ubuntu buon. is will start
the installation process.

If you have an Internet connection, the installer will ask you if you
would like to “Download updates while installing.” We recommend you
do so. e second option, “Install this third-party soware,” includes the
Fluendo MP codec, and soware required for some wireless hardware. If
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you are not connected to the Internet, the installer will help you set up a
wireless connection.

e “Preparing to install Ubuntu” screen will also let you know if you
have enough disk space and if you are connected to a power source (in case
you are installing Ubuntu on a laptop running on baery). Once you have
selected your choices, click Continue.

Internet connection

If you are not connected to the Internet, the installer will ask you to choose
a wireless network (if available). We recommend that you connect during install,

though updates and third-party software can be
installed after installation.. Select Connect to this network, and then select your network from the

list.
. If the list does not appear immediately, wait until a triangle/arrow ap-

pears next to the network adapter, and then click the arrow to see the
available networks.

. In the Password field, enter the network  or  key (if necessary).
. Click Connect to continue.

Figure 1.2: Set up wireless.

Allocate drive space

is next step is oen referred to as partitioning. Partitioning is the process If you are installing on a new machine with no
operating system, you will not get the first
option. The upgrade option is only available if
you are upgrading from a previous version of
Ubuntu.

of allocating portions of your hard drive for a specific purpose. When you
create a partition, you are essentially dividing up your hard drive into sec-
tions that will be used for different types of information. Partitioning can
sometimes seem complex to a new user; however, it does not have to be. In
fact, Ubuntu provides you with some options that greatly simplify this pro-
cess. e Ubuntu installer will automatically detect any existing operating
system installed on your machine, and present installations options based
on your system. Not all of the options listed below may appear:

. Install alongside other operating systems
. Upgrade Ubuntu … to .
. Erase … and install Ubuntu
. Something else
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Install alongside other operating systems.

If you are a Windows or Mac user and you are trying to install Ubuntu for Ubuntu provides you with the option of either
replacing your existing operating system
altogether, or installing Ubuntu alongside
your existing system. The latter is called dual-
booting. Whenever you turn on or restart your
computer, you will be given the option to select
which operating system you want to use for
that session.

the first time, select the Install alongside other operating systems option.
is option will enable you to choose which operating system you wish to
use when you computer starts. Ubuntu will automatically detect the other
operating system and install Ubuntu alongside it.

For more complicated dual-booting setups, you will need to configure the parti-
tions manually.

Figure 1.3: Choose where you would like to
install Ubuntu.

Upgrade Ubuntu … to 11.10

is option will keep all of your Documents, music, pictures, and other
personal files. Installed soware will be kept when possible (not all your
currently installed soware may be supported on the new version). System-
wide seings will be cleared.

Erase disk and install Ubuntu

Use this option if you want to erase your entire disk. is will delete any
existing operating systems that are installed on that disk, such as Windows
, and install Ubuntu in its place. is option is also useful if you have
an empty hard drive, as Ubuntu will automatically create the necessary
partitions for you.

Formaing a partition will destroy any data currently on the partition. Be sure to
back up any data you want to save before Formaing.

Something else

is option is for advanced users and is used to create special partitions, or

Ubuntu installs a home folder where your
personal files and configuration data are
located by default. If you choose to have your
home folder on a separate partition, then in the
event that you decide to reinstall Ubuntu or
perform a fresh upgrade to the latest release,
your personal files and configuration data won’t
be lost.

format the hard drive with a file system different to the default one.
Aer you have chosen the installation type, click Continue, or Install

More information and detailed instructions
on partitioning are available at: https://help.
ubuntu.com/community/HowtoPartition.

Now.

https://help.ubuntu.com/community/HowtoPartition
https://help.ubuntu.com/community/HowtoPartition
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Confirm Partition choices and start install

If you chose Something else, configure the partitions as you need. Once
you are happy with the way the partitions are going to be set up, click the
Install Now buon at the boom right to move on.

To reduce the time required for installation, Ubuntu will continue the
installation process “in the background” while you configure important
user details—like your username, password, keyboard seings and default
timezone.

Where are you?

Figure 1.4: Tell Ubuntu your location.

e next screen will display a world map. Using your mouse, click your
geographic location on the map to tell Ubuntu where you are. Alternatively,
you can use the drop-down lists underneath the map. is allows Ubuntu
to configure your system clock and other location-based features. Click
Forward when you are ready to move on.

Keyboard layout

Next, you need to tell Ubuntu what kind of keyboard you are using. In most
cases, you will find the suggested option satisfactory. If you are unsure
which keyboard option to select, you can click the Detect Keyboard Layout
buon to have Ubuntu determine the correct choice by asking you to press
a series of keys. You can also manually choose your keyboard layout from
the list of options. If you like, enter text into the box at the boom of the
window to ensure you are happy with your selection, then click Continue.

Who are you?

Ubuntu needs to know some information about you so it can set up the
primary user account on your computer. When configured, your name will
appear on the login screen as well as the MeMenu, which we discuss in
Chapter : e Ubuntu Desktop.

On this screen you will need to tell Ubuntu:

‣ your name
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Figure 1.5: Verify that your keyboard layout is
correct.

‣ what you want to call your computer
‣ your desired username
‣ your desired password
‣ how you want Ubuntu to log you in

Figure 1.6: Setup your user account.

Enter your full name under “Your name?”. e next text field is the name
your computer uses, for terminals and networks. You can change this to
what you want, or keep the predetermined name. Next is your username,
the name that is used for the Me Menu, your home folder, and behind the
scenes. You will see this is automatically filled in for you with your first
name. Most people find it easiest to stick with this. However, it can be
changed if you prefer.

Next, choose a password and enter it into the password field on the
le, and then enter same password into the password field on the right.
When both passwords match, a strength rating will appear to the right
that will show you whether your password is “too short,” “weak,” “fair,” or
“strong.” You will be able to continue the installation process regardless
of your password strength, but for security reasons it is best to choose a
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strong one. is is best achieved by having a password that is at least six
characters long, and is a mixture of leers, numbers, symbols, and upper-
case/lowercase. Avoid obvious passwords that include your birth date,
spouse’s name, or the name of your pet.

Login Options

Finally, at the boom of this screen you have three options from which to
choose regarding how you wish to log in to Ubuntu.

‣ Log in automatically
‣ Require my password to log in
‣ Encrypt my home folder

Log in automatically

Ubuntu will log in to your primary account automatically when you start
up the computer so you won’t have to enter your username and password.
is makes your login experience quicker and more convenient, but if
privacy or security are important to you, we don’t recommend this option.
Anyone who can physically access your computer will be able to turn it on
and also access your files.

Require my password to login

is option is selected by default, as it will prevent unauthorized people
from accessing your computer without knowing the password you cre-
ated earlier. is is a good option for those who, for example, share their
computer with other family members. Once the installation process has
been completed, an additional login account can be created for each family
member. Each person will then have their own login name and password,
account preferences, Internet bookmarks, and personal storage space.

Encrypt my home folder

is option provides you with an extra layer of security. Your home folder
is where your personal files are stored. By selecting this option, Ubuntu
will automatically enable encryption on your home folder, meaning that
files and folders must be decrypted using your password before they can be
accessed. erefore if someone had physical access to your hard drive (for
example, if your computer was stolen and the hard drive removed), they
would not be able to see your files without knowing your password.

If you choose this option, be careful not to enable automatic login at a later date.
It will cause complications with your encrypted home folder, and will potentially
lock you out of important files.

Installation Slideshow

Ubuntu will now finish installing on your hard drive. As the installation
progresses, a slideshow will give you an introduction to some of the default
applications included with Ubuntu. ese applications are covered in more
detail in Chapter : Working with Ubuntu.

Aer approximately twenty minutes, the installation will complete and
you will be able to click Restart Now to restart your computer and start
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Figure 1.7: The first slide in the installation
slideshow.

Ubuntu. e  will be ejected, so remove it from your  drive and press
Enter to continue.

Figure 1.8: You are now ready to restart your
computer.

Wait while your computer restarts, and you will then see the login win-
dow (unless you selected automatic login).

Click your username and enter your password, then press Enter or click
Log in. You will then be logged in to Ubuntu and will be presented with
your new desktop!
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Ubuntu installer for Windows

You can install and run Ubuntu alongside your current installation of Win-
dows:

. Download the Ubuntu installer for Windows http://www.ubuntu.com/
download/ubuntu/windows-installer

. Run the download file
. Install Ubuntu

Download and run the installer

Aer the file, wubi.exe, is downloaded, run the file to start the installation. If
a security message appears, click Continue, to proceed with the installation:

Figure 1.9: User Account Control dialog

Install

e Ubuntu Installer will start. Choose and enter a “Username” and “Pass-
word.” e password must be entered twice to ensure accuracy. Aer
choosing a password, click Install. e Ubuntu Installer will download and
install Ubuntu. is process will take some time. e download file size is
Mb. Aer the installation is complete, click Finish on the “Completing
the Ubuntu Setup Wizard” screen to reboot the computer.

Figure 1.10: Ubuntu Windows Installer

Installation complete

Aer the computer restarts, you can select “Ubuntu” from the boot menu.
You will then be logged in to Ubuntu and will be presented with your new
desktop!

http://www.ubuntu.com/download/ubuntu/windows-installer
http://www.ubuntu.com/download/ubuntu/windows-installer


2 The Ubuntu Desktop

Understanding the Ubuntu desktop

Initially, you may notice many similarities between Ubuntu and other Ubuntu 11.10 has an emphasis on “social
from the start” and features social network
integration in the desktop for sites like Twitter
and Facebook.

operating systems such as Microso Windows or Mac  . is is because
they are all based on the concept of a graphical user interface ()—i.e.,
you use your mouse to navigate the desktop, open applications, move files,
and perform most other tasks. In short, things are visually oriented, which
means that it’s important for you to become familiar with where and what
to click in Ubuntu.

Figure 2.1: The Ubuntu 11.10 default desktop.

Unity

All -based operating systems use a desktop environment. Desktop envi-
ronments encompass many things, such as:

‣ e look and feel of your system
‣ e way the desktop is laid out
‣ How the desktop is navigated by the user

In Linux distributions (such as Ubuntu), there are a number of desktop To read more about other variants of Ubuntu,
refer to Chapter 8: Learning More.environments available for use. Ubuntu uses Unity as the default desktop

environment.
, ,  and  are other popular desktop environments.

Since Ubuntu uses Unity, we will focus this guide on exploring the Unity
desktop.

Aer installation and log in, you will see the Unity desktop. Let’s explore
the default layout that is in front of you. is initial view is comprised of
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the e Desktop Background and two bars—one at the top of your desktop,
e Top Bar, and one on the le, Using Launcher.

The Desktop Background

Below the Top Bar is an image that covers the entire desktop. is is the
desktop background or wallpaper and the one you see in front of you be-
longs to the default Ubuntu . theme known as Ambiance. To learn more
about customizing your desktop including changing your background, see
the section on Customizing your desktop below.

The Top Bar

e Top Bar incorporates all of the functions that you need. First, the right “Top Bar” is also referred as “Top Panel.”

part of the bar is the Indicator area. To access an indicator, just le-click on
it. Starting from the le, the Indicators are: For more about:

‣ the Messaging Indicator see Microblogging;
‣ the Network Indicator see Getting online;
‣ the Session Indicator see Session options.

‣ the Keyboard Indicator—allows you to select the keyboard layout you
would like and change your keyboard preferences.

‣ the Messaging Indicator—incorporates all your social applications. From
here, you can access your instant messenger, your email client, your
microblogging application, and even UbuntuOne, your personal cloud!

‣ the Network Indicator—allows you to manage your network connections
and connect quickly and easily to a wired or wireless network.

‣ the Sound Indicator—allows you to adjust the sound volume, and access
your music player and Sound Seings.

‣ the Clock—shows you the current time and provides you with an easy
way to access your calendar and Time and Date seings.

‣ the Me Menu—allows you to easily switch between different users and
access your online and user accounts

‣ the Session Indicator—provides you an easy way to access System Set-
tings, Updates, Printers, and session options for locking your computer,
logging out of your session, restarting the computer, or shuing down
completely.

Figure 2.2: The Indicators of the Top Bar.

Every application has a menu (like File, Edit, View etc.), called the ap-
plication menu. In Unity, the application menu isn’t on the titlebar of the
application, like in other desktop environments, but is instead located on
the le area of the Top Bar. To show an application’s menu, just move your
mouse to the Top Bar. is is the second key concept of the Top Bar, the
incorporation of application menus on the Top Bar. is feature of Unity
provides you with more free work space; especially beneficial for netbook
and laptop users. Note that some older applications may still

display their menu within the application
window.

The Launcher

e bar on the le side of the screen is called the Launcher. e Launer
provides you with an easy way to access applications, mounted devices
and Trash. If you run a maximized application, Launer is automatically
hidden. To show the Launcher, move your mouse to the le side of your
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screen. Starting from the top, the first item of the Launer is the Dash—we
will describe the Dash in depth later—next there are some applications, the
Workspace lens, any mounted devices, and at the boom of the Launcher
is the Trash. By default there are some applications on the Launer, like Workspaces helps you to select the workspace

or the window you want. Trash contains
deleted files.

Tip: Pressing Meta+Swill show the Workspaces.

Firefox. Also, all of the applications that you are running are available from
the Launer, including the minimized applications.

The Dash

e Dash is a tool that helps you to access the application, files and mu- The Dash allows the user to search for informa-
tion: locally (installed applications, recent files,
bookmarks, etc.) and remotely (Twitter, Google
Docs, etc.). This is accomplished by utilizing one
or more Lenses; each responsible for providing
a category of search results for the Dash. For
more information regarding the Dash and
lenses, see: https://wiki.ubuntu.com/Unity

sic, you want, if you are a Windows user you can see the Dash as a more
advanced approach of the Start menu. If you are a Mac user, the Dash is
something like Launchpad in the dock. If used a previous version of Ubuntu
or another  distro, Dash replaces the  menus.

To explore the Dash, move your cursor to the Launer and click on the
top icon, containing the Ubuntu logo.

Figure 2.3: The Dash

Now, you can see the search bar on the top, some shortcuts for your
media, mail and photo applications as well as icons to restrict your search
to particular file-types below. ese are called lenses. When you type in the
search bar, the Dash will start searching for applications, files, folders or
music that match what you’ve typed.

Figure 2.4: Dash lenses

At the boom area of the Dash, are four icons, Home, Application Lens,
File Lens and Music Lens. Lenses serve to specialize search categories in the
Dash.

Search for files and applications with the Dash

As mentioned, the Dash is the tool that helps you find what you want. So
if you are searching for an application, a file, a music album etc, the Dash
is the right place for you. e search bar in the the Dash will locate both
applications and files.

https://wiki.ubuntu.com/Unity
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If you want to maximize the Dash, you only have to click on the icon at
the boom right corner of the Dash.

Search applications

If you need an application, open the the Dash and press on the Application
Lens. e Dash automatically categorizes the application to “Most Fre-
quently Used,” “Installed,” and “Apps Available for Download.” Enter the
name of the application you are looking for, and the Dash will return the
results. If you can’t find what you want, you can also filter the results by
pressing Filter results in the top right corner of the Dash, and then selecting
a category.

More information on the applications you will need can be found in
Chapter : Working with Ubuntu.

Figure 2.5: You can see the default results when
you press Application Lens, and also the criteria
on the right side.

Search Files and Folders

Open the Dash, and then click on the File Lens. Now you can see files cat-
egorized to “Recent,” “Downloads,” and “Folders.” You can add criteria to
fine-tune the results. To do this, click on Filter results and select file or
folder modification times, or file type (.odt, .pdf, .doc, .tex., etc.), or its size.

Browsing files on your computer

ere are two ways to locate files on your computer; either search for You can open your Home folder from the
Launcherthem or access them directly from their folder. You can search for a file

via the Dash or Files & Folders in the Launer. You can use the Files &
Folders tool to access commonly used folders (such as Documents, Music,
Downloads), and most recently accessed files.



   

Places

On the desktop, hover your mouse over the Top Bar, and select Places. e If you do not see the desktop menu, click
somewhere on the desktop and it will appear.Places menu holds a list of commonly used folders (such as Documents,

Music, Downloads, and the Home Folder). You can also browse the disks
on your computer by clicking Computer in this menu. If you set up a home
network, you will find a menu item to access shared files or folders. You can
also access the Search for Files tool from the Places menu, or browse a list
of recently opened folders.

Your Home Folder

e home folder is where your personal files are located. When you open
your personal folder, you will see that there are several folders inside:
Desktop (which contains any files that are visible on the desktop), Docu-
ments, Downloads, Music, Pictures, Public, Templates, and Videos.

Using Launcher

Running applications

To run an application from the Launer, just click on the application’s If you hold the Meta key for a while, a number
will appear on each of the first ten applications.
You can launch an application with a numbern
on it, with Meta+n.

icon. Any running application exists on the Launer, and has one or more
triangles on the le side of its icon, indicating the number of the application
windows. e application that is on the foreground has a white triangle on
the right side of the application’s icon.

You can also run an application through the Dash. We will talk about the
Dash, in the e Dash section.

If you minimize an application, it is minimized to the Launcher, and can
be restored later from there.

Figure 2.6: You can see the Home Folder on the
foreground, having a triangle on the right of its
icon. And Firefox with two triangles, indicating
that there are two opened windows of the
browser.

Adding and removing applications from Launcher

If you want to add an application to the Launer, there are two ways to do
so:

‣ Open the Dash, find the application you want, and then drag and drop it
on the Launcher

‣ Run the application you want to add to the Launcher, and then right-
click on the application’s icon on the Launcher, and select Keep in
launer.

If you want to remove an application from the Launer, right-click on
the application’s icon and then select Remove from launer or deselect
Keep in launer—if the application is running.

Workspaces

Workspaces are virtual desktops—separate views of your desktop which
let you group your open windows. ese virtual desktops increase the size
of your working area. Workspaces are meant to reduce cluer and make
the desktop easier to navigate. By default Ubuntu has four workspaces.
For example, you can have all the media applications windows on one
workspace, the web browser and office suite windows on another.
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Switching between workspaces

To explore workspaces, click on the Workspaces lens, located on the
Launcher. is lens let you switch workspaces, and choose the one you
want to work on.

Managing windows

When you open a program in Ubuntu (such as a web browser or a text
editor—see Chapter : Working with Ubuntu for more information on using
applications)—a window will appear on your desktop. If you have used
another operating system before, such as Microso Windows or Mac 
, you are probably familiar with the concept of a “window”—the box that
appears on your screen when you start a program. In Ubuntu, the top part
of a window (the titlebar) will have the title of the window in the center,
and three buons in the top le corner. From le to right, these buons
close, minimize, and maximize the window. Additionally, you can right-click
anywhere on the titlebar for a list of other window management options.

Closing, maximizing, restoring, and minimizing windows

Figure 2.7: This is the Top Bar of a window,
named Titlebar. The close, minimize, and
maximize buttons are on the top-left corner of
windows.

To close a window, click on the “×” in the upper le corner of the window
—this will be the first buon on the le-hand side. e buon immediately
to the right of this, is used to minimize the window to the Launcher. Once
minimized the window will no longer be visible, but its corresponding icon
will remain on the Launer. is icon will have a triangle on the le side
of it, indicating the program is still running. Clicking this icon, will restore
the window to its original position. Finally, the right-most buon of this
group will maximize the window, making it fill the entire screen. Clicking
this buon again will return the window to its original size. Note that if you
maximize a window its buons and menu are automatically hidden from
view. To show them, just move your mouse to the le side of the Top Bar.

Moving and resizing windows

To move a window around the workspace, place the mouse pointer over the You can also move a window by holding the Alt
key and dragging the windowwindow’s titlebar, then click and drag the window while continuing to hold

down the le mouse buon. To resize a window, place the pointer on an
edge or corner of the window so that it turns into a larger arrow, the resize
icon. You can then click and drag to resize the window.

Figure 2.8: TheWorkspaces Lens on the
Launcher.

Switching between open windows

In Ubuntu there are many ways to switch between open windows. Meta key (Meta), is also known as the Windows
key (Win key). Press Meta+D to hide all window
and display the desktop, the same works to
restore all windows.

. If the window is visible on your screen, you can click any portion of it to
raise it above all other windows.
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. Use Alt+Tab to select the window you wish to work on. Hold down
the Alt key, and keep pressing Tab until the window you’re looking for
appears in the popup.

. Click on the corresponding icon on Launcher. Move your mouse to
le side of your screen to show the Launcher, and right-click on the
application icon. If the application has multiple windows open, double-
click on the icon in order to select the window you want.

Moving a window to different workspace

To move a window to a different workspace, make sure the window isn’t
maximized. If it is maximized click on the right-most buon to restore it to
its original size. en right-click on the window’s title bar, and select:

‣ Move to Workspace Le, to move the window to the le workspace
‣ Move to Workspace Right, to move the window to the right workspace
‣ Move to Another Workspace, and then choose the Workspace you want,

to move the window to the preferred workspace.

Window always on the top or on visible workspace

At times, you may want to have a window always on top so that it can be
seen or monitored while you work with other applications. For example
you may want to browse the web and at the same time have the instant
messenger on the top, to watch the chat.

To do this you can right-click on the window’s title bar, and then select
Always on the top. Note that this window will be on the top of all windows
that are opened on the current workspace.

If you want to have a window always on the top regardless of which
workspace the window is on, right-click on the window’s titlebar, and then
select Always on Visible Workspace. Doing so this window will be always
on the top of all windows, on all workspaces.

Nautilus file manager

Just as Windows has Windows Explorer and Mac   has Finder to browse
files and folders, Ubuntu uses the Nautilus file manager by default. We will
now look at Nautilus in more detail.

The Nautilus file manager window

When you select the Home Folder shortcut in the launcher, or click on
a folder in Files & Folders, the Dash, or on the desktop, the Nautilus file
manager window opens up. e normal window contains the following
features:

Menubar e menubar is located at the top of the screen. ese menus
allow you to modify the layout of the browser, navigate, bookmark
commonly used folders and files, and view hidden folders and files. If you bookmark a folder, it will appear in the

Bookmarksmenu and in the left pane.Toolbar e toolbar has tools for navigation and a tool to make the con-
tents of the window larger or smaller. A drop-down list gives you the
option of switching the view from Icon View to List View or Compact
View. e search icon (which looks like a magnifying glass) opens a field
so you can search for a file by name.
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Additional Navigation Tools Just below the toolbar, you will see a represen- If you start typing a location starting with a /
character, Nautilus will automatically change
the navigation buttons into a text field labeled
Location. It is also possible to convert the
navigation buttons into a text field by pressing
Ctrl+L.

tation of where you are currently browsing. is is similar to the history
function of most browsers; it keeps track of where you are and allows
you to backtrack if necessary. You can click on the locations to navigate
back through the file browser.

Le Pane e le pane of the file browser has shortcuts to commonly-used
folders. When you bookmark a folder, it appears in the le pane. No
maer what folder you open, the le pane will always contain the same
folders. is le pane can be changed to display different features, such
as Information, Tree, History etc., by clicking the down arrow beside
“Places” near the top.

Central Pane e largest pane shows the files and folders in the directory
that you are currently browsing.

Figure 2.9: Nautilus file manager displaying
your home folder.

Navigating Nautilus

To navigate between directories, use the bookmarks in the le pane of What is a Directory? A Folder? A directory is a
division of space in a file system that you can
use to organize files. A folder is the name given
to a directory in a Graphical User Interface
environment like Nautilus.

the Nautilus file manager. You can also retrace your steps by clicking on
the name of a folder where it is listed just below the navigational icons.
Double-clicking on a visible directory will cause you to navigate to it in
Nautilus.

Opening files

A file in its simplest form, is data. Data can represent a text document,
database information, or data that will be used to produce music or video.
To open a file, you can either double-click on its icon or right-click and
select Open With (program).

Creating new folders

To create a new folder from within Nautilus click File ‣Create Folder, then Note that you can easily view hidden files
by clicking View ‣Show Hidden Files, or
alternatively by pressing Ctrl+H. Hiding files
with a dot (.) is not a security measure—instead
it provides a way of keeping your folders
organized and tidy.

name the folder that appears by replacing the default “untitled folder” with
your desired label (e.g., “Personal Finances”). You can also create a new
folder by pressing Ctrl+Shift+N, or by right-clicking in the file browser
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window and selecting Create Folder from the popup menu (this action will
also work on the desktop).

Hidden Files and Folders

If you wish to hide certain folders or files, place a dot (.) in front of the
name (e.g., “.Personal Finances”). In some cases it is impossible to hide files
and folders without prefixing them with a dot. In Nautilus these folders can
be hidden by creating a .hidden file. Open the file and enter in the name of
the file or folder you wish to hide. Make sure that each file or folder is on a
separate line. When you open Nautilus the folder will no longer be visible.

Copying and moving files and folders

You can copy files or folders in Nautilus by clicking Edit ‣Copy, or by right- You can also use the keyboard shortcuts
Ctrl+X, Ctrl+C and Ctrl+V to cut, copy and
paste (respectively) files and folders.

clicking on the item and selecting Copy from the popup menu. When using
the Edit menu in Nautilus, make sure you’ve selected the file or folder you
want to copy first (by le-clicking on it once).

Multiple files can be selected by le-clicking in an empty space (i.e.,
not on a file or folder), holding the mouse buon down, and dragging the
cursor across the files or folders you want. is “click-drag” move is useful
when you are selecting items that are grouped closely together. To select
multiple files or folders that are not positioned next to each other, hold
down the Ctrl key while clicking on each item individually. Once multiple
files and/or folders are selected you can use the Edit menu to perform
actions just like you would for a single item. When one or more items have When you “cut” or “copy” a file or folder,

nothing will happen until you “paste” it
somewhere. Paste will only affect the most
recent item that was cut or copied.

been “copied,” navigate to the desired location then click Edit ‣ Paste (or
right-click in an empty area of the window and select Paste) to copy them
to the new location.

While the copy command can be used to make a duplicate of a file or In the Nautilus Editmenu, you will also find
the Copy To andMove To buttons. These can
be used to copy or move items to common
locations, and can be useful if you are using
panes (see below). Note that it is unnecessary
to use Pastewhen using these options.

folder in a new location, the cut command can be used to move files and
folders around. at is, a copy will be placed in a new location, and the
original will be removed from its current location.

To move a file or folder, select the item you want to move then click
Edit ‣Cut. Navigate to your desired location, then click Edit ‣ Paste.

. As with the copy command above, you can also perform this action If you click on a file or folder, drag it, and then
hold down the Alt key and drop it to your
destination folder, a menu will appear asking
whether you want to copy, move or link the
item. Notice that the symbol of the mouse
cursor changes from an arrow into a question
mark as soon as you hold down the Alt key

using the right-click menu, and it will work for multiple files or folders at
once. An alternative way to move a file or folder is to click on the item, and
then drag it to the new location.

Using multiple tabs and multiple Nautilus windows

Opening multiple Nautilus windows can be useful for dragging files and
folders between locations. e option of tabs is also available in Nautilus,
as well as the use of panes. When browsing a folder in Nautilus, to open a When dragging items between Nautilus

windows, tabs or panes, a small symbol will
appear over the mouse cursor to let you
know which action will be performed when
you release the mouse button. A plus sign
(+) indicates you are about to copy the item,
whereas a small arrow means the item will be
moved. The default action will depend on the
folders you are using.

second window select File ‣New Window or press Ctrl+N. is will open a
new window, allowing you to drag files and folders between two locations.
To open a new tab, click File ‣New Tab or press Ctrl+T. A new row will
appear above the space used for browsing your files containing two tabs
—both will display the directory you were originally browsing. You can
click these tabs to switch between them, and click and drag files or folders
between tabs the same as you would between windows. You can also open
a second pane in Nautilus so you can see two locations at once without
having to switch between tabs or windows. To open a second pane, click
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View ‣Extra Pane, or press F3 on your keyboard. Again, dragging files and
folders between panes is a quick way to move or copy items.

Searching for files and folders on your computer

You can search for files and folders using the Dash, the Launcher’s Files and Search for files and folders quickly by pressing
Ctrl+F in Nautilus and then typing what you
want to find.

Folders lens or Nautilus.

Search using the Dash

In the Dash, click Sear for Files. Open the drop-down menu on the right
side of the search bar. Select Folders, All Files, or one of the special folders,
e.g., Documents. It is sufficient to type the first few leers of the file or
folder you are searching for.

Search using the Launcher’s Files and Folders lens

Go to the Launcher’s Files and Folders lens. Open the drop-down menu on
the right side of the search bar. Select Folders, All Files, or one of the special
folders, e.g., Documents. It is sufficient to type the first few leers of the file
or folder you are searching for.

Search using Nautilus

In Nautilus, click Go ‣ Sear for Files, or press Ctrl+F. is opens the
search field where you can type the name of the file or folder you want to
find.

Customizing your desktop

Figure 2.10: You can change most of your
system’s settings here.

Most customizations can be reached via the Session Indicator and then
selecting System Settings to open the System Seings application win-
dow. e Dash, Desktop appearance, emes, Wallpapers, Screensavers,
Accessibility, and other configuration seings are available here. For more
information see Session options.
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Appearance

Figure 2.11: You can change the theme in the
Theme tab of “Appearance Preferences”.

You can change the background, fonts, and window theme to further
modify the look and feel of your desktop. To begin, open Appearance by
either right-clicking on your background and selecting Change Desktop
Baground or selecting Session Indicator then System Settings then
Appearance .

Theme

e “Appearance” window will display the current selected background
wallpaper and theme when it opens. You may select a theme that will
control the appearance of your windows, buons, scroll bars, panels, icons,
and other parts of the desktop. e Ambiance theme is used by default, but
there are other themes you can choose from. Just click once on the theme
you want to try. e theme will change immediately.

Desktop background

Under Background, you may choose from Wallpapers, Pictures Folder,
and Colors and Gradients. When Wallpapers is selected, you will see
Ubuntu’s default selection of backgrounds. To change the background
simply click the picture you would like to use. You’re not limited to this
selection though.

To use one of your own pictures, click the +… buon, and navigate
to the image you want. Double-click it, and the change will take effect
immediately. is image will also then be added to your list of available
backgrounds.

If you are aer a larger selection of desktop backgrounds, click the “Get
More Backgrounds Online” link at the boom of the Appearance Prefer-
ences window. is link will open your web browser, and direct you to the
http://art.gnome.org/backgrounds website.

Accessibility

Ubuntu has built-in tools that make using the computer easier for people
with certain physical limitations. You can find these tools by opening the

http://art.gnome.org/backgrounds
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Dash and searching for “Universal Access.” On the Seeing tab you can man-
age the text size, the contrast of the interfaces, enable a zoom tool and even
a screen reader. Selecting high-contrast themes and larger on-screen fonts
can assist those with vision difficulties. You can activate “Visual Alerts”
though the Hearing tab, if you have hearing impairment. Also you can ad-
just keyboard and mouse seings to suit your needs through the Typing
and Pointing and Cliing tabs respectively.

Figure 2.12: Universal allows you to enable
extra features to make it easier to use your
computer.

Orca screen reader

Orca is a useful tool for people with visual impairments, and comes pre-
installed. To run Orca, click on the Dash and type Orca, and click on the
shown result. Orca is the Screen Reader of the Universal Access, and can
be launched once the “Screen Reader” is activated. Orca’s voice synthesizer
will activate and assist you through the various options such as voice type,
voice language, Braille, and screen magnification. Once you have finished
selecting your seings, you will need to log out of the computer (Orca will
offer to do this for you). When you log back in, the Orca seings you chose
will automatically run every time you use your computer.

Session options

When you have finished working on your computer, you can choose to log
out, suspend, restart, or shut down through the Session Indicator on the
far right side of the top panel. You can also quickly access these options by
pressing the Ctrl+Alt+Del keys.

Logging out

Logging out will leave the computer running but return you to the login
screen. is is useful for switching between users, such as when a different
person wishes to log in to their account, or if you are ever instructed to “log
out and back in again.” You should save your work before logging out.
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Suspend

To save energy, you can put your computer into suspend mode, which
will save its current condition and allow you to start more quickly while
remaining on but using very lile energy. Suspending the computer spins
down the hard disk and saves your session to memory, so it is very quick to
suspend and resume from suspension.

Hibernate

Hibernate is similar to suspend, except that instead of saving your session
to memory, hibernate will save your session to the hard disk. is takes
a lile longer, but with the added benefit that hibernation uses no power
while it is in a hibernated state.

Rebooting

To reboot your computer, select Shut Down… from the “Session Indicator”
and click on Restart.

Shut down

To totally power down your computer, select Shut Down… from the “Ses-
sion Indicator” and click on Shutdown.

Other options

From the Session Indicator, you can also select Lo Screen to require You can lock your screen quickly by using the
keyboard shortcut Ctrl+Alt+L. Locking your
screen is recommended if you move away from
your computer for a short amount of time.

a password before using the computer again—this is useful if you need
to leave your computer for some duration. You can also use the Session
Indicator to set up a guest session for a friend to try Ubuntu, or to switch
users to log into another user account without closing your applications.

Getting help

Ubuntu, just like other operating systems, has a built-in help reference, Many applications have their own help which
can be accessed by clicking the Helpmenu
within the application window.

called the Ubuntu Desktop Guide. To access it, click on the Dash and type
Help. Alternately, you can press F1 while on the desktop, or click Ubuntu
Help in the Top Bar.

If you can’t find an answer to your question in this manual or in the
Ubuntu Desktop Guide, you can contact the Ubuntu community through
the Ubuntu Forums (http://ubuntuforums.org).

We encourage you to check any information
you find on other websites with multiple
sources when possible, but only follow direc-
tions if you understand them completely.

Many Ubuntu users open an account on the forums to receive help, and
in turn provide support to others as they gain more knowledge. Another
useful resource is the Ubuntu Wiki (https://wiki.ubuntu.com), a website
maintained by the Ubuntu community.

http://ubuntuforums.org
https://wiki.ubuntu.com
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Figure 2.13: The built-in system help provides
topic-based help for Ubuntu.



3 Working with Ubuntu

All the applications you need

If you are migrating from a Windows or Mac platform, you may wonder if
the programs that you once used are available. Some of the programs you
already use have native Linux versions. And, for those that don’t, there are
free and open-source applications that will cover your needs. is section
will recommend some alternates that will work well on Ubuntu. Most of You can search for more applications in the

Ubuntu Software Center, by the category that
you are interested in.

the applications listed in this section are available via the Soware Center.
ose followed by an asterisk (*) can be downloaded directly from their
official websites.

Office Suites

‣ Windows: Microso Office, LibreOffice
‣ Mac OS: iWork, Microso Office, LibreOffice
‣ Linux: LibreOffice, KOffice, GNOME Office, Kexi (database application)

In Ubuntu you may choose among many office suites. e most popular
suite is the LibreOffice (formerly OpenOffice). Included in the suite:

‣ Writer—word processor
‣ Calc—spreadsheet
‣ Impress—presentation manager
‣ Draw—drawing program
‣ Base—database
‣ Math—equation editor

LibreOffice Suite is installed by default. Note that Base is not installed by
default and it can be installed through Ubuntu Soware Center.

Email Applications

‣ Windows: Microso Outlook, Mozilla underbird
‣ Mac OS: Mail.app, Microso Outlook, Mozilla underbird
‣ Linux: Mozilla underbird, Evolution, KMail

As with office suites, there are multiple options for email applications.
One very popular email application is Mozilla underbird, which is also
available for Windows. underbird is the default email application in
Ubuntu. Another option is Evolution—similar to Microso Outlook, it also
provides a calendar.

Web Browsers

‣ Windows: Microso Internet Explorer, Mozilla Firefox, Opera, Chromium,
Google Chrome

‣ Mac OS: Safari, Mozilla Firefox, Opera, Chromium, Google Chrome
‣ Linux: Mozilla Firefox, Opera*, Chromium, Google Chrome*, Epiphany

e most popular web browsers can be installed directly from the
Ubuntu Soware Center.

Opera is available for download from http://
www.opera.com/browser/download/. Google
Chrome is available for download from https/
/chrome.google.com.

http://www.opera.com/browser/download/
http://www.opera.com/browser/download/
https//chrome.google.com
https//chrome.google.com
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PDF Readers

‣ Windows: Adobe Reader
‣ Mac OS: Adobe Reader
‣ Linux: Evince, Adobe Reader, Okular

Evince is a user-friendly and minimalistic reader, and it is the default
PDF reader. If Evince doesn’t cover your needs, Adobe Reader is available
for Ubuntu too.

Multimedia Players

‣ Windows: Windows Media Player, VLC
‣ Mac OS: icktime, VLC
‣ Linux: Totem, VLC, Mplayer, Kaffeine

For multimedia, Ubuntu users have a wide variety of options for high
quality players. Two popular and powerful media players for Ubuntu are
VLC and Mplayer. Meanwhile, the classic and user-friendly Totem is the
default media player in Ubuntu.

Music Players and Podcatchers

‣ Windows: Windows Media Player, iTunes, Winamp
‣ Mac OS: iTunes
‣ Linux: Banshee, Rhythmbox, Amarok, Audacity, Miro

ere are several options for listening to music with Ubuntu: Banshee
(installed by default), Rhythmbox, and Amarok, among others. With these
you can listen to music and your favorite podcasts. Audacity is similar to
Winamp. ere is Miro for those of you who watch video podcasts and TV
series from the Internet.

CD/DVD Burning

‣ Windows: Nero Burning ROM, InfraRecorder
‣ Mac OS: Burn, Toast Titanium
‣ Linux: Brasero, Kb, Gnome-baker, Nero Burning ROM*

e are several popular disk burning applications such as Gnome-baker,
Brasero, Ubuntu’s default CD burner, and Kb. ese burners are powerful
tools, offering user-friendly interfaces, many features and they are all open
source and free of charge! Also Nero Burning ROM is available for Linux,
but you have to buy it.

Photo Management

‣ Windows: Microso Office Picture Manager, Picasa
‣ Mac OS: Aperture, Picasa
‣ Linux: Shotwell, gumb, Picasa*, Gwenview, F-Spot

You can view and manage your favorite photos with Shotwell, Ubuntu’s
default photo manager, or with gumb, Picasa, Gwenview, and Fspot.

Picasa is available for download from http://
picasa.google.com/linux/.

http://picasa.google.com/linux/
http://picasa.google.com/linux/
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Graphics Editors

‣ Windows: Adobe Photoshop, GIMP
‣ Mac OS: Adobe Photoshop, GIMP
‣ Linux: GIMP

GIMP is a very powerful graphics editor. You can create your own
graphics, taper your photographs, modify your pictures. GIMP, a power-
ful alternative to Photoshop, covers the needs of novice users, professional
photographers, and designers.

GIMP is not loaded by default, but can be installed via the Soware Center.

Instant Messaging

‣ Windows: Windows Live Messenger, AIM, Yahoo! Messenger, Google
Talk

‣ Mac OS: Windows Live Messenger, AIM, Yahoo! Messenger, Adium,
iChat

‣ Linux: Empathy, Pidgin, Kopete, aMSN

None of the other platform IM clients have Linux versions. However,
you can use Pidgin, Empathy or Kopete to communicate over most proto-
cols including: AIM, MSN, Google Talk (Jabber/XMPP), Facebook, Yahoo!,
and ICQ. is means you need only one client to communicate with all of
your friends. e drawback is that some of these clients have limited video
support. If you are using MSN exclusively, aMSN may be worth a try.

VoIP Applications

‣ Windows: Skype, Google Video Chat
‣ Mac OS: Skype, Google Video Chat
‣ Linux: Ekiga, Skype, Google Video Chat

VoIP technologies allow you to talk to people over the Internet. e
most popular such application is Skype, which is available for Linux. An
open-source alternative Ekiga supports voice communication using the SIP
protocol. Note that Ekigka isn’t compatible with the Skype.

BitTorrent Clients

‣ Windows: uTorrent, Azureus
‣ Mac OS: Transmission, Azureus
‣ Linux: Transmission, Deluge, Azureus, KTorrent

ere are a number of BitTorrent clients for Ubuntu: Transmission,
Ubuntu’s default client, is simple and light-weight, Deluge, Azureus and
KTorrent offer many features and can satisfy the most demanding of users.

Getting online

If you are in a location with Internet access, you will want to make sure
you are connected in order to get the most out of your Ubuntu operating
system. is section of the manual will help you check your connection and
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configure it where necessary. Ubuntu can connect to the Internet using a
wired, wireless, or dialup connection. It also supports some more advanced
connection methods, which we will briefly discuss at the end of this section.

A wired connection refers to when your computer is physically con-
nected to a router or an Ethernet port with a cable. is is the most com-
mon connection for desktop computers.

A wireless connection is when your computer is connected to the Inter-
net via a wireless radio network, also known as Wi-Fi. Laptop computers
commonly use Wi-Fi due to portability, making it easy to access the Inter-
net from different rooms in the house or when traveling.

In order to connect wirelessly, you must be in a location with a working
wireless network. To have your own, you will need to purchase and install
a wireless router or access point. Some locations may already have a publicly
accessible wireless network available.

A dialup connection is when your computer uses a modem to connect to
an Internet service provider through your telephone line.

NetworkManager

In order to connect to the Internet in Ubuntu, you need to use the Network- If you are unsure whether your computer has a
wireless card, check with your manufacturer.Manager utility. NetworkManager allows you to turn all networking on or

off, and helps you manage your wired, wireless, and other connections.

Figure 3.1: NetworkManager will display this
icon in the top panel when you are connected
to a wired network.

You can access all the functions of NetworkManager using its icon in
the top panel. is icon may look different depending on whether you cur-
rently have a working connection, and whether the connection is wired or
wireless. If you are unsure, try hovering your mouse over the icon until a
short description appears near the cursor. is will read “Wired network
connection ‘Auto eth0’ active” (for example) if you have a working wired
connection, or otherwise something else related to networking or connec-
tions such as “No connection” or “Networking disabled.”

Figure 3.2: Here you can see the currently
active “auto eth0” connection listed in the
NetworkManager menu.

Clicking this icon will bring up a list of network connections that are
available to you. If you are currently connected to the Internet, the name of
this connection will be highlighted in bold.

is menu also includes options to let you enable or disable networking,
view technical details about your current connection, or edit all connection
seings. In the image above, the check box next to Enable Networking is
currently selected; you can deselect it to disable all network connections.
is may be useful if you need to shut off all wireless communication, such
as when in an airplane.

Establishing a wired connection

If you have an Ethernet cable running from a wall socket, a router, or some
other device, then you will want to set up a wired network connection in
Ubuntu.

In order to connect with a wired connection, you need to know whether Are you already online? If the NetworkManager
icon in the top panel shows a connection, then
you may have successfully connected during the
installation process. If so, you do not need to
follow the rest of this section.

your network connection supports . Dynamic Host Configuration
Protocol, is a way for computers on your network to automatically receive
configuration information from your Internet service provider (). is is
usually the quickest and easiest way of establishing a connection between
your computer and your  in order to access the Internet, although some
s may provide what is called a static address instead. If you are unsure
whether your  supports , you may wish to contact their customer
service line to check. ey will also be able to provide you with information
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on your static address if one has been allocated to you (in many cases s
only allocate static addresses to customers upon request).

Automatic connections with DHCP

If your network supports , you may already be set up for online access.
To check this, click on the NetworkManager icon. ere should be a “Wired
Network” heading in the menu that is displayed. If “Auto eth0” appears
directly underneath, then your computer is currently connected and prob-
ably already set up correctly for . If “disconnected” appears in gray
underneath the wired network section, look below to see if an option la-
beled “Auto eth0” appears in the list. If so, click on it to aempt to establish
a wired connection.

To check if you are online, click on the NetworkManager icon in the top
panel and select the Connection Information option.

Figure 3.3: This window displays your IP address
and other connection information.

You should see a window showing details about your connection. If your

An Internet Protocol (IP) address is a numerical
label assigned to devices on a computer
network. It is the equivalent of phone numbers
for your house and allows your computer to
be uniquely identified so you can access the
Internet and share files with others.

 address is displayed as ... or starts with ., then your computer
was not successfully provided with an address through . If it shows
another address, it is most likely that your connection was automatically
configured correctly. To test out your Internet connection, you may want to
open the Firefox web browser to try loading a web page. More information
on using Firefox can be found later in this chapter.

If you are still not online aer following these steps, you may need to try

To access the “Connection Information”
window, you will need to make sure that
networking is enabled. Otherwise this option
will be gray and you will not be able to select
it through the menu of the NetworkManager
icon. To enable networking, click on the
NetworkManager icon and select Enable
Networking from the popup menu.

seing up your Internet configuration manually, using a static  address.

Manual configuration with static addresses

If your network does not support , then you need to know a few items
of information before you can get online.

‣ An  address is a unique address used for identifying your computer on
the Internet. When connecting through  this is likely to change at
times. However, if your  has provided you with a static address then
it will not. An  address is always given in the form of four numbers
separated by decimal points, for example, ....

‣ e network mask tells your computer how large the network is that
it belongs to. It takes the same form as an  address, but is usually
something like ...

‣ e gateway is the  address at your ’s end. It helps your computer
connect or “talk” with their network, which acts as a “gateway” between
your computer and the Internet.

‣  servers are one or more  addresses of “Domain Name System”
servers. ese servers convert standard web addresses (like http://www.
ubuntu.com) into  addresses such as .... is step allows
your computer to “find” the correct web site when you enter the web
address you wish to visit. A minimum of one  server is required, up
to a maximum of three. e additional ones are used in case the first one
fails.

To manually configure a wired connection, click on the NetworkManager If you do not already have these settings, you
will need to consult your network administrator
or ISP customer support to receive them.

icon and select Edit Connections. Make sure you are looking at the Wired
tab inside the “Network Connections” window that is displayed.

e list may already have an entry such as “Auto eth0,” or a similar
name. If a connection is listed, select it and then click the Edit buon. If no
connection is listed, click the Add buon instead.

http://www.ubuntu.com
http://www.ubuntu.com
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If you are adding a connection, you first need to provide a name for the
connection so you can distinguish it from any others that are added later. In
the “Connection name” field, choose a name such as “Wired connection .”

Figure 3.4: In this window you can manually edit
a connection.

To set up the connection:

. Under the connection name, make sure that the Connect automatically
option is selected.

. Switch to the v Settings tab.
. Change the Method to “Manual.”
. Click on the Add buon next to the empty list of addresses.
. Enter your  address in the field below the Address header.
. Click to the right of the  address, directly below the Netmask header,

and enter your network mask. If you are unsure of your network mask,
“...” is the most common.

. Click to the right of the network mask, directly below the Gateway
header, and enter the address of your gateway.

. In the  servers field below, enter the addresses of your  server. If
your network has more than one  server, enter them all, separated by
spaces or commas.

. Click Apply to save your changes.

A  address is a hardware address for your computer’s network card, and
entering it is sometimes important when using a cable modem connection or
similar. If you know the  address of your network card, this can be entered in
the appropriate text field in the Wired tab of the editing window.

When you have returned to the Network Connections screen, your
newly-added connection should now be listed. Click Close to return to the
desktop. If your connection is configured correctly, the NetworkManager
icon should have changed to show an active connection. To test if your
connection is properly set up, refer to the instructions above for checking a
 connection.

Wireless

If your computer is equipped with a wireless (Wi-Fi) card and you have a
wireless network nearby, you should be able to set up a wireless connection
in Ubuntu.

Connecting to a wireless network for the first time

If your computer has a wireless network card, you should be able to connect
to a wireless network. Most laptop and netbook computers have a wireless
network card.

Ubuntu is usually able to detect any wireless networks that are available To improve speed and reliability of your
connection, try to move closer to your router or
access point.

within range of your wireless card. To see a list of wireless networks, click
on the NetworkManager icon. Under the “Wireless Networks” heading, you
should see a list of available wireless networks. Each network will be shown
with a name on the le, and a signal meter on the right. A signal meter
looks like a series of bars—the more bars that are filled in, the stronger the
connection will be.

A wireless network may be open to anyone to connect, or may be pro-
tected with network security. A small padlock will be displayed next to the
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signal meter of any wireless networks that are protected. You will need to
know the correct password in order to connect to these.

To connect to a wireless network, select the desired network’s name
from the list. is will be the name that was used when the wireless router
or access point was installed. If you are in a workplace or a location with a
publicly accessible wireless network, the network name will usually make it
easy to identify.

If the network is unprotected (i.e., the network signal meter does not
display a padlock), a connection should be established within a few seconds.
e NetworkManager icon in the top panel will animate as Ubuntu aempts
to establish a connection. If it connects successfully the icon will change
to display a signal meter. A notification message in the upper right of your
screen will also appear, informing you that a connection was established.

If the network is secured, Ubuntu will display a window called “Wireless
Network Authentication Required” once it tries to connect. is means that
a password is required in order to connect.

Figure 3.5: Enter your wireless network
passphrase.

If you know the password, enter it in the Password field, and then click
Connect. As you type your password, it will be obscured to prevent others
from seeing it. If you prefer, you can select the Show password option to
see the password as you type.

Aer you click the Connect buon, the NetworkManager icon in the top
panel will animate as it tries to connect to the network. If you have entered
the correct password, a connection will be established and the Network-
Manager icon will change to show signal meter bars. Again, Ubuntu will
display a pop up message in the upper right of your screen informing you
that a connection was established.

If you entered the wireless network’s password incorrectly, Network- Select the Show Password option to make sure
you haven’t made a mistake when entering the
password.

Manager will aempt to establish a connection then return to the “Wireless
Network Authentication Required” window. You can aempt to enter the
correct password again, or click Cancel to abort your connection. If you do
not know the password to the network you have selected, you will need to
get the password from the network administrator.

Once you have successfully established a wireless network connection,
Ubuntu will store these seings (including the network password) in order
to make it easier to connect to the same wireless network in future. You
may also be prompted to select a keyring password here. e keyring stores
network and other important passwords in the one place, so you can access
them all in future by just remembering your keyring password.

Connecting to a saved wireless network

If you have previously successfully established a wireless connection, that
connection’s password will be saved on your computer. is will allow you
to connect to the same network without having to re-enter the password.
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In addition, Ubuntu will automatically try to connect to a wireless net-
work within range if it has its seings saved. is will work for both open
and secured wireless networks.

If you have many saved wireless networks that are in range, Ubuntu
may choose to connect to one of them, while you may prefer to connect to
another. In this case, click on the NetworkManager icon. You should see a
list of wireless networks in range, along with their signal meters. Click on
your desired network.

If the password and other seings have not changed, Ubuntu will con-
nect to the wireless network you chose. If the password has changed,
Ubuntu will open the “Wireless Network Authentication Required” win-
dow. In this case, follow the instructions in the previous section.

Connecting to a hidden wireless network

In some circumstances, you may need to connect to a hidden wireless net-
work. ese hidden networks do not broadcast their names, which means
that they will not show up in the list of wireless networks in the Network-
Manager menu. In order to be able to connect to a hidden network, you will
need to get its name and security seings from your network administrator.

To connect to a hidden network:

. Click on the NetworkManager icon in the top panel.
. Select the Connect to Hidden Wireless Network option. Ubuntu should

open the “Connect to Hidden Wireless Network” window.
. By default, the Connection field should show “New…”—you can leave

this unchanged.
. In the Network name field, enter the name of the wireless network. is

name is also known as a . Please enter the network name exactly as
it was given to you.

. In the Wireless security field, select one of the options. If the network
is open, leave this field as “None.” If you do not know the correct seing
for the network you will not be able to connect to the hidden network.

. Click on the Connect buon.

e rest of the process should work exactly as in the section on the
initial connection to wireless networks. Once set up according to the in-
structions above, the hidden network should show up in the list of saved
networks.

Disabling and enabling your wireless network card

Wireless access in Ubuntu is enabled by default if you have a wireless Some computers may have a physical switch or
button to turn offWi-Fi.network card in your computer. In certain cases, for example on airplanes,

you may need or be required to turn your wireless radio off.
To do this, click on the NetworkManager icon, and deselect the Enable

Wireless option. Your wireless network will be turned off, and your com-
puter will no longer search for available wireless networks.

To turn wireless networking back on, click on the NetworkManager icon,
and click on the Enable Wireless option to re-select it. Your wireless net-
work will be turned back on. Ubuntu will then search for nearby wireless
networks and will connect to any saved networks within range.
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Changing an existing wireless network

At times, you may want to change the seings for a wireless connection
that you have previously saved. Its password may have changed, or your
system administrator asked you to change some networking or security
seings.

To edit a saved wireless network connection:

. Click on the NetworkManager icon and select Edit Connections…
. A “Network Connections” window should open. Click on the Wireless

tab to see a list of saved wireless connections.
. By default, this list shows connections in the order of most recently used

to least recently used. Find the connection you want to edit, click on it,
and then click Edit.

. Ubuntu should open a window called “Editing ⟨connection name⟩”, where
⟨connection name⟩ is the name of the connection you are editing. e
window should display a number of tabs.

. Above the tabs, you may change the Connection name field if you want
to give the connection a more recognizable name.

. If the Connect automatically option is not selected, Ubuntu will detect
the wireless network but will not automatically connect to it without
you choosing it from the NetworkManager menu. Select or deselect this
seing as needed.

. On the Wireless tab of the “Editing ⟨connection name⟩” window, you
may need to edit the  field. A  is the wireless connection’s net-
work name—if set incorrectly, the network may not be detected and
a connection may not be made. Please make sure that the  is set
according to your network administrator’s instructions.

. Below the , you should see the Mode field. e “Infrastructure”
mode means that you would be connecting to a wireless router or access
point. is is the most common mode for wireless networks. e “Ad-
hoc” mode is a computer-to-computer mode and is oen only used in
advanced cases.

. On the Wireless Security tab of the “Editing ⟨connection name⟩” win-
dow, you may need to change the Security field to the correct seing.
A selection of None means that you are using an open network with
no security. Other selections may require slightly different additional
information:

 /-bit Key is an older security seing still in use by some wire-
less networks. If your network uses this security mode, you will need
to enter a key in the Key field that should appear aer you select this
mode.

 -bit Passphrase is the same older security seing as the entry
above. However, instead of a key, your network administrator should
have provided you with a text passphrase—a password—to connect
to the network. Once you select this security mode, you will need to
enter your passphrase in the Key field.

 &  Personal is the most common security mode for wireless
network connections at home and at businesses. Once you select this
mode, you will need to enter a password in the Password field.

If your network administrator requires , Dynamic , or 
&  Enterprise security, you will need to have the administrator
help you set up those security modes.

. On the v Settings tab, you may need to change the Method field
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from “Automatic ()” to “Manual,” or one of the other methods. For
seing up manual seings (also known as static addresses), please see
the section above on manual set up for wired network connections.

. When you finish making changes to the connection, click Apply to save
your changes and close the window. You can click Cancel to close the
window without making changes.

. Finally, click Close on the “Network Connections” window to return to
the desktop.

Aer making changes, your new seings should go into effect immedi-
ately.

Other connection methods

ere are other ways to get connected with Ubuntu.
With NetworkManager, you can also configure Mobile Broadband con-

nections to keep online through your cellular or other mobile data carrier.
You can also connect to s (Digital Subscriber Lines), which are a

method of Internet connection that uses your telephone lines and a “
modem.”

It’s also possible to use NetworkManager to establish a  (Virtual A VPN is a “Virtual Private Network,” and is
sometimes used to help secure connections.
DSLs are “Digital Subscriber Lines,” a type of
broadband connection.

Private Network) connection. ese are commonly used to create secure
connectivity to a workplace.

e instructions for making connections using mobile broadband, s,
or s, are beyond the scope of this guide.

Browsing the web

Once you have connected to the Internet, you should be able to browse the
web with Ubuntu. Mozilla Firefox is the default application for browsing the
web in Ubuntu.

Figure 3.6: The default Ubuntu home page for
the Firefox web browser.
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Starting Firefox

To start Firefox, click on the Dash (the top-most icon in the Launcher) and
either search for ‘firefox’ using the search box or click on the ‘Browse the
Web’ buon. If your keyboard has a “” buon, you can also press that
buon to start Firefox.

Navigating web pages

Viewing your homepage

When you start Firefox, you will see your home page. By default, you will
see the Ubuntu Start Page.

To go to your home page quickly, press Alt+Home.

Navigating to another page

To navigate to a new web page, you need to enter its Internet address (also URL stands for uniform resource locator and
WWW stands for world wide web.known as a ) into the Location Bar. s normally begin with “hp://”

followed by one or more names that identify the address. One example is
“http://www.ubuntu.com/.”

Figure 3.7: You can enter a web address or
search the Internet by typing in the location
bar.

To navigate:

. Click on the Location Bar to select the  that is already there.
. Enter the  of the page you want to visit. e  you type replaces

any text already in the Location Bar.
. Press Enter.

To quickly select the  of the Location Bar, press Ctrl+L.
If you don’t know a , try typing something specific to the page you

want to visit (for example a name or other search request) into the Location
Bar and press Enter. is will search your preferred search engine—Google
by default—for that term, and take you to the web page that is the top result
from the search.

Clicking a link

Most web pages contain links you can click to move to other pages.
To click a link:

. Move the mouse pointer until it changes to a pointing finger. is hap-
pens whenever the pointer is over a link. Most links are underlined text,
but buons and pictures on a web page can also be links.

. Click on the link once. While Firefox locates the link’s page, status
messages will appear at the boom of the window.

Retracing your steps

If you want to visit a page you have seen before, there are several ways to To go backwards and forwards you can also use
Alt+Left to go backwards or Alt+Right to go
forwards.

do so.

‣ To go back or forward one page, click on the Ba or Forward buon, at
the le side of the Location Bar.

http://www.ubuntu.com/


     .

‣ To go back or forward more than one page, click on the small trian-
gle next to the Forward buon. You should see a list of pages you’ve
recently visited. To return to a page, select it from the list.

‣ To see a list of any s you’ve entered into the Location Bar, click on
the down arrow at the right end of the Location Bar. To view a page,
select it from the list.

‣ To choose from pages you’ve visited during the current session, open
the History menu and choose from the list in the boom section of the
menu.

‣ To choose from pages you’ve visited during the past several sessions,
open the History menu and select Show All History. Firefox should
open a “Library” window, which shows a list of folders. Click on the
folders to displays sub-folders, or titles of web pages you’ve visited in the
past. Click on a page’s title to view that page.

Stopping and reloading

If a page is loading too slowly or you no longer wish to view a page, click Stop and Reload buttons are at the right end of
the Location Bar.on the Stop buon or press Esc.

To reload the current page or to get the most up-to-date version, click on
the Reload buon or press Ctrl+R.

Opening new windows

At times, you may want to have more than one browsing window. is may
help you organize your browsing session beer, or separate web pages that
you are viewing for different reasons.

ere are three ways to create a new window:

‣ On the top bar, open the File menu, then select New Window.
‣ Right-click on the Firefox’s icon on the Launcher, and then select Open

New Windows
‣ Press Ctrl+N.

Once a new window has opened, you can use it just like the first window
—including navigation and opening tabs.

Opening a link in a new window

Sometimes, you may want to click on a link to navigate to another web
page, but do not want the original page to close. To do this, you can open
the link you’d like to click in its own window.

ere are two ways to open a link in its own window:

‣ Right-click on a link to open its popup menu. Select the Open Link in
New Window option. A new window will open, containing the web
page for the link you clicked.

‣ Press-and-hold the Shift key while clicking a link. is will also open
the web page in a new window.

Tabbed browsing

If you would like to visit more than one web page at a time, you can use
Tabbed Browsing to navigate the web.

Tabbed browsing lets you open several web pages within a single Firefox
window, each displaying in its own tab. is frees up space on your desktop
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since you don’t have to have a window open for every web page you’re
currently visiting. You can open, close, and reload web pages in one place
without having to switch to another window.

You can alternate quickly between different tabs by using the keyboard
shortcut Ctrl+Tab.

Opening a new blank tab

ere are three ways to create a new blank tab:

‣ Click on the Open new tab buon on the right side of the last tab.
‣ On the top bar, open the File menu, and then select New Tab.
‣ Press Ctrl+T.

When you create a new tab, it will contain a blank page with the Loca-
tion Bar focused. Start typing a web address () or other search term to
open a website in the new tab.

Opening a link in its own tab

Sometimes, you may want to click on a link to navigate to another web
page, but do not want the original page to close. To do this, you can open
the link you’d like to click in its own tab.

ere are many ways to open a link in its own tab:

‣ Right-click on a link to open its popup menu. Select the Open Link in
New Tab option. A new tab will open, containing the web page for the
link you clicked.

‣ If your mouse has a middle buon, or a wheel, click on the link with the
middle mouse buon or wheel. A new tab should open, containing the
web page for the link you clicked.

‣ Press-and-hold the Ctrl key while clicking the le mouse buon on the
link. A new tab should open, containing the web page for the link you
clicked.

‣ Click on a link, holding both le and right mouse buons.
‣ Click on the link with the le mouse buon, and keep holding down

the mouse buon. Drag the link up to a blank space on the tab bar, and
release the mouse buon. A new tab should open, containing the web
page for the link you dragged.

Closing a tab

Once you have finished viewing a web page in a tab, you can close that tab.
ere are various ways to close a tab:

‣ Click on the Close buon on the right side of the tab you want to close.
‣ Open the File menu, and then select Close Tab.
‣ Click on the tab you want to close with the middle mouse buon, or the

mouse wheel, if you have one.
‣ Press Ctrl+W.
‣ Click on the tab with both mouse buons.

Restoring a closed tab

Sometimes, you may close the wrong tab by accident, or want to bring back
a tab that you’ve recently closed.

To bring back a tab you’ve closed, do one of the following:
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‣ Open the History menu, select Recently Closed Tabs, and then choose
the name of the tab you want to restore.

‣ Press Ctrl+Shift+T to re-open the most recently closed tab.

Changing the tab order

To move a tab to a different location on the tab bar, drag it there using your
mouse. Click-and-hold on the tab and drag the tab to a new place on the tab
bar. While you are dragging the tab, Firefox will display a small indicator to
show where the tab will be moved. When moving a tab to a new window it may

reload the page. Remember to save your work
before doing this.

Moving a tab between windows

If you have more than one Firefox window open, you can move an open
tab to a different window. You can also split a tab off to become its own
window.

To move a tab from one Firefox window to another already open win-
dow, click-and-hold on the tab and drag it to the tab bar on the other Fire-
fox window. When you release the mouse buon, the tab will be aached
to the new window.

To move a tab from one window into its own window, click-and-hold
on the tab and drag the tab below the tab bar. When you release the mouse
buon, the tab will become a new window.

Searching

You can search the web, or other collections, from within Firefox without
first visiting the home page of the search engine.

By default, Firefox will search the web using the Google search engine.

Searching the web

To search the web in Firefox, type a few words into the Firefox search Bar.
For example, if you want to find information about the Ubuntu:

. Click on the Sear Bar.
. Type the phrase “Ubuntu.” Your typing replaces any text currently in the

Search Bar.
. Press Enter to search.

Search results from Google for “Ubuntu” should appear in the Firefox
window.

Selecting search engines

Figure 3.8: These are the other search engines
you can use—by default—from the Firefox
search bar.

If you do not want to use Google as your search engine in the Search Bar,
you can change the search engine that Firefox uses.

To change the search engine, click on the icon on the le side of the

The Ubuntu home page’s search bar uses
Google by default, but will automatically use
Yahoo if Yahoo is selected in the Search Bar.

Search Bar. Choose one of the other search engines in the list. Some search
engines, like Google, Yahoo, Bing search the whole web; others, like Ama-
zon.com, Wikipedia only search specific sites.

Searching the web for words selected in a web page

Sometimes, you may want to search for a phrase that appears on a different
web page. Instead of copying and pasting the phrase into the Search Bar,
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Firefox allows you to search the web for words you select within a web
page.

. Highlight any words in a web page using your le mouse buon.
. Right-click on the text you’ve highlighted to open a popup menu. Select

the option Sear [Sear Engine] for “[your selected words]”.

Firefox should open a new tab containing search results for your high-
lighted words, found using the currently selected search engine.

Searching within a page

Figure 3.9: You can search within web pages
using the Find Toolbar.

You may want to look for specific text within the web page you are
viewing. To find text within the current page in Firefox:

. Press Ctrl+F or choose Edit ‣ Find to open the Find Toolbar at the bot-
tom of Firefox.

. Enter the text you want to find into the Find field in the Find Toolbar.
e search automatically begins as soon as you type something into the
field.

. Once some text has been matched on the web page, you can:

‣ Click Next to find text in the page that is below the current cursor
position.

‣ Click Previous to find text that is above the current cursor position.
‣ Click on the Highlight all buon to highlight occurrences of your

search words in the current page.
‣ Select the Mat case option to limit the search to text that has the

same capitalization as your search words.

To find the same word or phrase again, press F3 or click on the Edit
menu and select Find Again.

Viewing web pages full screen

To display more web content on the screen, you can use Full Screen mode.
Full Screen mode condenses the Firefox’s toolbars into one small toolbar. To
enable Full Screen mode, simply choose View ‣ Full Screen or press F11.

Copying and saving pages

With Firefox, you can copy part of a page so that you can paste it elsewhere,
or save the page or part of a page as a file on your computer.

Copying part of a page

To copy text from a page:

. Highlight the text and/or images with your mouse.
. Right click on highlighted text and select Copy or press Ctrl+C.
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You can paste the text into other applications.
To copy a text or image link () from a page:

. Position the pointer over the link or image.
. Right-click on the link or image to open a popup menu.
. Select Copy Link Location. Note that if the image works as a link you

can copy you would have to select Copy Image Location

You can paste the link into other applications or into Firefox’s Location Bar.

Saving all or part of a page

To save an entire page in Firefox:

. Choose File ‣ Save Page As from the top bar. Firefox should open the
“Save As” window.

. Choose a location for the saved page.
. Type a file name for the page, and click Save.

To save an image from a page:

. Position the mouse pointer over the image.
. Right-click on the image to display a popup menu.
. Select Save Image As. Firefox should open the “Save Image” window.
. Choose a location for the saved image.
. Enter a file name for the image and click Save.

Changing your homepage

By default, Firefox will show the Ubuntu Start Page when you start Firefox.
If you prefer to view another page when you start Firefox, you will need to
change your homepage preference.

Figure 3.10: You can change Firefox settings in
this window.

To change your homepage:

. Navigate to the page that you would like to become your new homepage.
. Choose Edit ‣ Preferences from the top bar.
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. In the “Startup” section on the General tab, which is shown by default,
click on the Use Current Page buon. If you had more than one tab
open then all the tabs will be opened when Firefox starts. If you prefer to
have one page open, close the other tabs and repeat steps –. The homepage can also be set by entering the

addresses that should be open in the Home
Page, with a pipe—|—separating pages to be
opened in a new tab

. Click Close.

Download settings

In Edit ‣ Preferences you can change how Firefox behaves with downloads. The Downloads window shows the progress
of currently downloading files, and lists files
downloaded in the past. It can be used to open
or re-download files.

You can tell Firefox where to place downloaded files, or to ask where each
time. You can also set the behavior of Firefox’s Downloads window. e
Downloads window can be hidden entirely, or set to hide when downloads
finish.

Bookmarks

When browsing the web you may want to come back to certain web pages
again without having to remember the .

In Firefox, you can create bookmarks, which are saved in the web browser
and which you can use to navigate back to your picked web pages.

Bookmarking a page

Aer navigating to a web page you can save its location by bookmarking it.
ere are two ways to bookmark a page:

‣ From the top bar, choose Bookmarks ‣Bookmark is Page. A window
will open. Provide a descriptive name for the bookmark, and click on the
Done buon.

‣ Press Ctrl+D. A pop-up will appear. Provide a descriptive name for the
bookmark, and click on the Done buon.

Navigating to a bookmarked page

To navigate to a bookmarked page, open the Bookmarks menu from the
top bar , and then choose your bookmark’s name. Firefox should open the
bookmark in the current tab.

You can also press Ctrl+B to display bookmarks in a sidebar on the le side of
the browser window. Press Ctrl+B again to hide the sidebar.

Deleting a bookmark

If you would like to delete a bookmark that you have previously made,
open the Bookmarks menu from the top bar, and then right-click on your
bookmark’s name. Firefox should open a popup menu for your bookmark.
Select the Delete option from the menu. Your bookmark should then be
deleted.

History

Whenever you are browsing the web, Firefox is saving your browsing his-
tory. is allows you to come back to a web page that you have recently
visited, without needing to remember the page’s , or even bookmarking
it.
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To see your most recent history, open the History menu from the top
bar. e menu should then display several of the most recent web pages
that you were viewing. Choose one of the pages to return to it.

To see the web pages you have visited recently, press Ctrl+H. Firefox will
open a “sidebar” on the le side of the browser window, that contains your
browsing history, categorized as “Today,” “Yesterday,” “Last  days,” “is
month,” the past  months (listed month by month), and finally “Older than
 months.” If history for a category does not exist, that category will not be
listed.

Click on one of the date categories in the sidebar to expand it. en it
will reveal the pages you visited during that period. en, once you find the
page you need, click on its title to return to it.

You can also search for a page by its title. Enter a few leers, or a word,
in the Sear field at the top of the history sidebar. e sidebar should then
display a list of web pages whose titles match your search words. Click on
the title of the page you need to return to it.

If you would like to hide the history sidebar again, press Ctrl+H again.

Clearing private data

At times, you may want to delete all private data that Firefox stores about
your browsing history. While this data is stored only on your computer, you
may want to remove it if you share access to your computer.

To delete your private data, open the Tools menu from the top bar, and
select Clear Recent History. In the drop down list for the Time range to
clear, choose how far back you would like Firefox to delete.

If you would like more control over what you clear, click on the Details
text to display a list of options.

When done, click on the Clear Now buon.

Using a different web browser

Figure 3.11: You can change the default
browser with the “System Info” utility. To use it,
open System Info from System Settings… -click
on Session Indicator, on the top right corner of
your screen-.

If you install a different web browser on your computer, you may want
to use it as the default browser when you click on links from emails, instant
messages, and other places.

To change your preferred web browser, open click on the Session In-
dicator and then search for “System Info,” and open it. en click on “De-
fault Applications” from the sidebar, and choose your new preferred web
browser from the Web dropdown list.
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Reading and composing email

Introduction to Thunderbird

underbird is an easy to setup and use email client developed by Mozilla.
It is free, fast and comes packed full of useful features. Even if you are
new to Ubuntu and underbird, you will be up and running in no time,
checking your email and staying in touch with friends and family.

Setting up Thunderbird

In the top right corner of the Ubuntu desktop you will see an envelope icon
in the notification area. is is the messaging menu, from here you can
launch underbird by clicking set up mail. Alternatively you can click the
Ubuntu buon in the top le corner of the screen at the top of the launcher
to bring up the Dash and type Thunderbird into the search box. Once
underbird opens you will be greeted by a pop-up box that will prompt
you to setup your email account.

Figure 3.12: setting up Thunderbird

Enter your name in the first text box, your email address in the second
text box, for example username@domain.com and your email password in
the third text box.

Once you have done this click the continue buon. underbird will au-
tomatically set up your email account for you. When underbird finishes
detecting your email seings click “create account” and underbird will do
the rest. You can also set underbird as your default news and  reader
by checking the boxes in the pop-up box that appears aer you click create
account. If you don’t want to see this message box every time you start
underbird simply deselect Always perform this e when starting
underbird. You are now ready to start using underbird.

mailto:username@gmail.com


     .

Around the Thunderbird workspace

Now that you have your email account set up lets get to know the under-
bird workspace. underbird is designed to be very user friendly and easy
to navigate. When you open it you will see the main workspace with your
email folders (all folders window) on the le. On the right of the screen you
will see two windows. e top right window displays a list of your email
and the boom right window displays the current email you are viewing.
e size of these windows can be easily re-sized to suit your own needs.
To do this simply le click and hold the dividing bar that separates the two
windows and drag the bar up or down to your desired position. e all
folders windows is where you can see all your mail folders. You will see:

Your remote folders for your account are listed here and can include:

‣ inbox: Where your email is stored and accessed
‣ email address folder: You will see one of these folders for each of the

accounts you have setup
‣ dras: Where your dra mails are stored
‣ sent mail: Where the emails you have sent are stored
‣ spam: is is where suspected spam email is stored so you can check

them to make sure you haven’t lost any important emails
‣ trash: is is where messages you’ve deleted are stored so you can dou-

ble check to make sure you haven’t accidentally deleted an important
email (also one of the local folders)

‣ important: is is where emails you have marked as important are stored
‣ starred: is is where emails you have marked with a star are stored
‣ personal: is is where emails you have marked as personal are stored
‣ receipts: You can move important receipts to this folder. Records of your

on line purchases for example
‣ travel: You can use this folder to store travel emails such as flight times

and bookings
‣ work: You can store work emails in this folder to keep them separate

from your personal email
‣ outbox: Where the emails you are in the process of sending are stored

(also one of the local folders)

Across the top of the underbird workspace you will see four control
buons, get mail, write, address book and tag. ese are used to get your
mail, write your mail, access your address book and tag your email mes-
sages.

At the top and to the right of the all folders window you will see a set of
quick filter buons, unread, starred, contact, tags andattament. You can
use these buons to filter your email messages so that you only see your
unread mail, your favorite mail (starred), mail from people in your address
book, mail you have tagged and mail that includes aachments.

If you are used to a more traditional desktop and you have underbird
maximized to full screen you might be wondering where the menus are,
they are still there and if you want to access them, move your mouse to the
top of the screen and you will see the familiar menus, file, edit, view, go,
message, tools and help.

At the top of the window that displays your email you can see five action
buons, reply, forward, arive, junk, and delete. You will find these very
useful for quickly replying to email, forwarding your email to another
person, archiving (backing up) your email, marking an email as junk mail
and quickly deleting an email. To the le of these quick action buons you



   

will see information about the email you are viewing that includes who the
email is from, the subject of the email, the address to reply to and who the
email was sent to.

Using your address book

At the top of the main workspace you will see the address book buon,
click this buon to access your address book. Once the address book opens
you will see the address book window, from here you can organize your
contacts very easily. At the top of the address book window you will see
five buons, new contact, new list, properties, write and delete.

‣ new contact: is buon allows you to add a new contact and add as
much detail as you like including, name, nickname, address, email, addi-
tional email, screen name, work number, home number, fax, pager and
mobile/cell number.

‣ new list: is buon allows you to add lists for your contacts such as
family, friends, acquaintances, etc.

‣ properties: is buon allows you to rename your address book name.
e default name is ’personal address book’ but using this buon you
can change the name to what suits you best.

‣ write: is buon allows you to quickly send an email to a selected con-
tacted without needing to go back to the main underbird workspace.
Simply select a contact from your contacts list and click this buon to
send them an email.

‣ delete: is buon allows you to quickly delete a contact from your
address book. Just select the contact you want to delete and press this
buon to remove the contact from your address book.

Checking and reading messages

underbird will automatically check your email account for new messages
every ten minutes or so but if you need to manually check for new mes-
sages le click the get mail buon in the top le corner of the workspace.
underbird will then check your email account for new messages and
download them. As they are downloaded you will see your email appear in
the message window on the right side of the workspace. When you click
on one of your emails it will appear in the window below your email list.
If you want to view your email in a full window double le click your cho-
sen email and underbird will display the email in a full window in its
own tab. At the top of the open email you will see information about the
email and the five quick action buons, reply, forward, arive, junk and
delete, as previously discussed. If an email has remote content you will see
a message asking if you want to display the email or not.

You may want to filter your emails from time to time; this is easily done
with underbird. When you have an email selected and you want to tag
the email simply click the tag buon and a drop down list will be displayed.
In the list you have the options to Remove All Tags or Mark as…, Impor-
tant, Work, Personal, To Do, Later or create a new tag that is more suited
to your own personal requirements.

Composing and Replying to Messages

To compose a new email message click the write buon in the top le of
the workspace. is will bring up a new window where you will compose
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your new email. In the To: field, enter the email address of the destination
—the contact to whom you are sending this email. If there is more than one
contact to whom you are writing, separate multiple recipients with commas.
If a contact that you are addressing is in your address book, you can address
them by name. Start typing the name of the contact; underbird will dis-
play the list of mailing contacts below your text. Once you see the contact
you intend to address, click on their email address or use the down arrow
key and then Enter to select the address. If you would like to carbon-copy
(Cc) some contacts, click the To: field and select Cc: Contacts on the To:
and Cc: lines will receive the email, and will see the rest of the contacts to
whom an email was sent. If you would like to send an email to some con-
tacts without disclosing to whom your email was sent, you can send a blind
carbon-copy, or Bcc. To enable Bcc, select Bcc: by clicking the To: field and
selecting Bcc: Any contacts entered in the Bcc: field will receive the mes-
sage, but none of the recipients will see the names or emails of contacts on
the Bcc: line.

Instead of typing the email addresses, or names, of the contacts you
are addressing in the message, you can also select the contacts from your
address book. Start typing a few leers from your contact’s first or last
name in the To: field to filter the list to only show mailing contacts. Once
you identify the contact you would like to address, click on their name in
the list. If you’ve added the contact in error, delete their address and enter
the correct address.

You may enter a subject for your email in the Subject field. Messages
should have a subject to help the recipient to identify the email while glanc-
ing at their message list; if you do not include a subject, underbird will
warn you about this. Enter the contents of your message in the big text field
below the subject. ere is no practical limit on the amount of text you can
include in your message. By default underbird will auto-detect the cor-
rect format for your email but you can change this by clicking Options then
mouse over Format and select your preferred option from the list.

You have a choice of Auto-Detect, Plain Text Only, Rich Text (HTML)
Only and Plain and Rich (HTML) Text. When you have finished composing
your email, click on the Send buon on the window’s toolbar. Your message
will be placed in the Outbox, and will be sent to your desired recipient.

Attaching files

At times, you may want to send files to your contacts. To send files, you
will need to aach them to your email message. To aach a file to an email
you are composing, click on the Aach buon and when the new window
opens select the file you want to send and click open. at file will then be
aached to the email when you click send.

Replying to Messages

In addition to composing new messages, you may want to reply to messages
that you receive. ere are three types of email replies:

‣ Reply (or “Reply to Sender”)—sends your reply only to the sender of the
message to whom you are replying.

‣ Reply to All—sends your reply to the sender of the message, as well as
anyone else on the To or Cc lines.

‣ Forward—allows you to send the message, with any additional comments
you may add, to some other contacts.
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To use any of these methods, click on the message to which you want
to reply and then click the Reply, Reply to All, or Forward buon on the
message toolbar. underbird will open the reply window. is window
should look much like the window for composing new messages, but the
To, Cc, Subject, and main message content fields should be filled in from the
message to which you are replying. Edit the To, Cc, Bcc, Subject or main
body as you see fit. When your reply is finished, click on the Send buon
on the toolbar. Your message will be placed in the Outbox, and will be sent.

Using instant messaging

Instant messaging allows you to communicate with people you know in real
time. Ubuntu includes the Empathy application that lets you use instant
messaging features to keep in touch with your contacts. To start Empathy,
open the Messaging Menu (the envelope icon on the menubar), then select
Chat.

Empathy lets you connect to many instant messaging networks. You
can connect to: Facebook Chat, Google Talk, Jabber, People Nearby, ,
Gadu-Gadu, Groupwise, , , , mxit, myspace, , sametime, silc,
, , Yahoo!, and Zephyr.

Running Empathy for the first time

When you open Empathy for the first time you will need to configure it
with the details of your instant messaging accounts.

When Empathy starts you will see the “Welcome to Empathy” window.
Choose the option corresponding to your situation.

You have a previous account

If you have an account that you have used previously with another instant
messaging program, then select the Yes, I’ll enter my account details now
option. en, click Forward to continue.

On the next screen, choose your account type from the drop-down list
below What kind of at account do you have?. en, enter your account
details in the field below.

Depending on the account type that you choose, Empathy may request
that you enter a username, or an  for your account, followed by a pass-
word.

Figure 3.13: Creating a new instant messenger
account in Empathy.

If you do not remember your account information, you will need to visit
the website of the instant messaging service to retrieve that information. (It
is suggested that you visit the web sites where you have instant messenger
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accounts, before you start Empathy, so you can gather all of the credentials
for each account.)

If you have another account to add then select the Yes option, and click
Forward to repeat the above process. When you have entered all of your
accounts leave the No, that’s all for now option selected, and click Apply to
finish the setup process.

Next, Empathy should display the “Please enter personal details” screen.
If you choose to fill in this information, you will be able to communicate
with people who are on your local network either at home or from the
office.

Enter your first name in the First name field, and your last name in
the Last name field. Enter a nickname that you want to use on your lo-
cal network in the Niname field. When you have completed all of the
information, click Apply.

If you don’t want to communicate with people on your local network,
select the I don’t want to enable this feature for now option, and click
Apply.

You do not have a previous account

If you don’t have an account that you can use, then you can create one by
selecting the No, I want a new account option. Click Forward to display
the next set of options.

Choose the account type that you would like to create from the drop-
down list below What kind of at account do you want to create? You
can create either a Jabber or a Google Talk account. Note: If you wish to create a type of account

other than one of these, then you will need
to visit the relevant website and create the
account first. Then follow the instructions in
the “You have an account” section.

Next, enter the account name that you would like in the text field, and in
the following text field enter a password of your choice. If you would like
to set up another account then select the Yes option, and repeat the above
process.

When you have entered all the accounts leave the No, that’s all for now
option selected, and click Forward.

Empathy should display the “Please enter personal details” window.
Providing this information allows you to communicate with people who are
on your local network either at home or in the workplace.

Enter your First name in the text field, and enter your Last name in the
next field. In the Niname field enter a nickname by which you would like
to be identified. When you have filled all of the text fields click Apply to
save your seings.

If you don’t want to talk to people on your local network then select the
I don’t want to enable this feature for now option and click Apply.

You want to talk to people nearby

If you would only like to communicate with people on your local network
either at home or in the workplace, then you should select the No, I just
want to see people online nearby for now option.

Click Forward to display the next set of options. en enter your First
name in the text field, and enter your Last name in the next field. In the
Niname field enter a nickname by which you would like to be identified.
When you have filled all of the text fields, click Forward.
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Figure 3.14: You can talk to people nearby by
entering your information.

Changing account settings

If you need to add more accounts aer the first launch, open the Edit menu,
then select Accounts. Empathy will then display the “Accounts” window.

Adding an account

To add an account click on the + buon on the boom le of the “Accounts”
window. Empathy should display some options on the right-hand side
of the window. Choose your account type from the Protocol drop-down
list. Next, enter your account name in the first text field. en enter your
password in the Password text field. Finally click on the Log in buon to
save and verify your seings.

Editing an account

You might need to edit an account if you change the password or get the
password wrong. Fortunately, this is very easy to do. Select the account you
want to change on the le side of the “Accounts” window. Empathy should
show the current information for the account. Once you have made your
changes, click Save.

Removing an account

To remove an account select the account on the le hand side of the win-
dow and click on the - buon. Empathy should open the “Do you want to
remove” window. Click on the Remove buon to confirm that you want to
remove the account, or click Cancel to keep the account.

Editing contacts

Adding a contact

To add a contact open the Chat menu, then select Add contact. Empathy
should open the “New Contact” window.

In the Account drop-down list, choose the account that you want to add
the contact to. When creating a contact you must select the service that
matches the service your contact is using.

For example if your contact’s address ends in “@googlemail.com” then
you will need to add it to an account that ends in “@googlemail.com”.
Likewise if the contact’s email ends in “@hotmail.com” then you will need
to add it to an account ending in “@hotmail.com.”

Aer choosing the account you wish to add the contact to, enter their
login , their username, their screen name or their email address in the
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Identifier text field. Next, in the Alias text field, enter the name you want to
see in your contact list. Click Add to add the contact to your list of contacts.

Removing a contact

Click on the contact that you want to remove, then on the Unity bar at the
top of the screen, open the Edit menu, select Contact, then Remove. is
will open the “Remove contact” window.

Click on the Remove buon to confirm that you want to remove this
contact, or click Cancel to keep the contact.

Communicating with contacts

Text

To communicate with a contact, select the contact in Empathy’s main win-
dow and double-click their name. Empathy should open a new window
where you can type messages to your contact, and see a record of previ-
ously exchanged messages.

To send a message to the contact, enter your message in the text field be-
low the conversation history. When you have typed your message press the
Enter key to send the message to your contact. If you are communicating
with more than one person then all of the conversations will be shown in
tabs in your Empathy window.

Audio

If your contact has audio capabilities then there will be a microphone icon
next to their name. Click on the microphone icon to open the popup menu.
Select the Audio call option from the menu. Empathy should then open the
“Call” window.

is window shows your picture on the right and your contact’s picture
on the le. Ensure that your microphone and speakers are connected, and
proceed with the audio conversation. You can finish the conversation by
clicking on the Hang up buon.

Video

If your contact has video chat capabilities then there will be a webcam icon
next to their name. Click on the icon to open a popup menu. Select the
Video call option from the menu. Empathy should then open the “Call”
window. is window shows your webcam view in the top right and your
contact’s webcam will be in the middle. If you don’t have a webcam then
your picture will be shown instead. You can finish the call by clicking on
the Hang up buon.

Sending and receiving files

Sending a file

When you are in a conversation with a contact and you would like to send
them a file, open the Contact menu, then select Send file. Empathy should
open the “Select file” window. Find the file you wish to send, and click on
the Send buon. A “File Transfers” window will open showing the file and
its transfer progress. When the file transfer is complete, you can close the
“File Transfers” window.
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Receiving a file

When a contact wants to send you a file, the status icon to the le of the
contact’s name will flash with an icon of a paper plane. To receive the file,
double-click the contact’s name. Empathy will open the “Select a destina-
tion” window. Choose the location where you would like Empathy to save
the file, and click Save. Empathy should open the “File Transfers” window.
e “File Transfers” window shows you the progress of current file transfer.
You can stop the file transfer by clicking on the Stop buon, open trans-
ferred files by clicking on the Open buon, and clear the list of completed
transfers by clicking on the Clear buon.

Changing your status

You can use your status to show your contacts how busy you are or what
you are doing. You can use the standard statuses, which are:

‣ Available
‣ Busy
‣ Away
‣ Invisible
‣ Off-line

ese can be changed in one of two ways. e first method is in the
main Empathy window from the drop-down list at the top of the window.

e same drop-down list lets you set a custom status by choosing “Cus-
tom Message…” next to the icon that matches your status. Enter what you
would like your status to say, and click on the green check mark.

e second method is to click the Messaging Icon on the top Unity Bar.
From this menu, you will see all of the same options that Empathy presents,
but accessible without having to open the application window.

Changing your picture

Your picture is what your contacts will see next to your name in their con-
tact list. e default picture is the outline of a person. You can change your
picture by opening the Edit menu, then choosing Personal Information.
Empathy should open the “Personal Information” window. From the Ac-
count drop-down list choose the account that you want to change, then
click on the picture on the right-hand side of the window. Empathy should
open the “Select Your Avatar Image” window. Find the file containing your
picture, and click Open. If you would like to return it to the default avatar,
click on the No Image buon, instead.

Desktop Sharing

Desktop sharing is a very niy feature available with Ubuntu. It can be used
for a lot of purposes like troubleshooting, online meetings or just showing
off your cool desktop to your friend. It is very easy to get remote desktop
sharing working between two Ubuntu machines.

. Click on System ‣ Preferences ‣Remote Desktop and select Allow re-
mote desktop. It is strongly recommended you add a password, for security
reasons.

. Open Empathy and login using your Google/Jabber client 
. Double click on the user with whom you want to share your desktop
. From the new window, click on Contact ‣ Share your desktop.
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It should be noted that the other user will obviously be able to see the
information displayed on your screen. Please be sure to keep this in mind
if you have documents or files that are of a private nature open on your
desktop.

Microblogging

Figure 3.15: Gwibber Social Client

Gwibber is the default microblogging application that connects several
microblogging accounts in one window without loading a browser. Gwib-
ber can be used to access and post on Twier, Facebook, Identi.ca, Ping.fm,
Flickr, Digg, Status.net, Qaiku and FriendFeed. Support for Google+ will be
available once the API is released.

Upgrades and add-ons

If you intend to access Ping.fm, Flickr, Digg, Status.net, Qaiku or Friend-
Feed, you will need add-ons. Go to Ubuntu Soware Center and search for
Gwibber. Make sure the appropriate add-ons are selected and installed.

You also may like to install an add-on to search Gwibber feeds using
Unity Lens.

Gwibber feeds can be searched and accessed
from Unity Lens.

Setting up Gwibber Accounts

Access Gwibber from the Message menu on the top panel bar. Click Broad-
cast to start Gwibber.

To add a new account, click Edit and select Accounts. is will open a
new window for the “Accounts Manager”. Click the + buon to add a new
account. Aer you enter your login and password, choose an account color
and then click Add. You will have to authorize Gwibber to use Twier or
Facebook, and enable the  for Qaiku, if you are using Qaiku.

Removing accounts is easier. Go to the “Accounts Manager” window and
select the account to be removed. Click the − buon to remove the account.
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Figure 3.16: Gwibber Lens Add-on

Figure 3.17: Accessing Gwibber from the
Message Menu

Figure 3.18: Gwibber Accounts Window. You
can add more than one account from a service
provider.
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Figure 3.19: Clicking on the image would open
the Facebook page on a browser.

Using Gwibber to follow streams

Gwibber displays feeds from each service provider as streams. You can
select for them to be listed in either ascending or descending order by
selecting the Sort option under View menu. You can separate the feeds as
messages, replies, and private messages.

In addition, the aachments from the feed are sorted as images, links,
and videos. Clicking the image, link, or the video would take you to the
actual website by opening a new tab in your default browser.

Notifications

Feeds can be displayed in the notification bubble by selection for the op-
tion in the “Preferences” window. You can also choose the rate at which
Gwibber searches for new feeds.

Figure 3.20: Notifications from Gwibber can be
customized from the Preferences window.

Replying, liking, and retweeting

Each tweet can be liked, retweeted, or replied from within Gwibber’s win-
dow by selecting the Twier icon on the top right of each post.
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Figure 3.21: Facebook updates can similarly
liked and commented from within Gwibber

Status updates

Select the Message menu from the top panel and click Update Status. is You can deselect an account from posting using
Gwibber.would open a new window. Enter your status message and post it to all

your accounts in one click.

Advanced options

Gwibber can be customized to have individual colors for each account.
You can also shorten s as you post from Gwibber using a list of 
shortening services. Play with Gwibber and discover other cool things it
can do. Visit http://gwibber.com/docs/user-guide/current/master_social_
networking_with_gwibber.pdf for more information.

Viewing and editing photos

Shotwell Photo Manager is the default photo application in Ubuntu allow-
ing you to view, tag, edit, and share your photos. To start Shotwell, click
on the Ubuntu icon near the top le of the screen, then select the Shotwell
icon labeled View Photos.

Importing

When you launch Shotwell for the first time, you will be greeted by the
“Import” window. Aer the first launch, you can import more photos by
dragging the photos into the Shotwell window. You can also import photos
by connecting your camera or external storage device to the computer.

From a digital camera Connect your camera to the computer using the
data cable and power it on. If your camera is properly detected, you will
see a new window prompting you to launch an application. Select Shotwell
in the drop-down menu then click OK. Your camera will be listed in the
Shotwell sidebar. Select your camera in the sidebar. You will see a preview
of the camera’s contents. Select individual photos by pressing and holding

http://gwibber.com/docs/user-guide/current/master_social_networking_with_gwibber.pdf
http://gwibber.com/docs/user-guide/current/master_social_networking_with_gwibber.pdf
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Figure 3.22: Manage your collection, enhance
your photos while keeping the original, and
share your memories online using Shotwell
Photo Manager.

Ctrl and clicking on each photo you want to import, and then clicking
Import Selected on the boom bar of the window. Or, you can choose to
import all photos by clicking Import All.

From your computer You can import photos into Shotwell by dragging
photos from your file browser into the Shotwell window. Alternatively, you
can click File Import From Folder, ‣ select the folder containing the photos
you want to import.

From external hard drive,  flash drive, or / Importing photos from
external storage is similar to importing from your computer. Your external
storage device may also appear under the Camera label on the Shotwell
sidebar. Follow the instructions for importing from a camera or computer.

Choosing where Shotwell saves photos

e default location for the Shotwell Library is your Pictures folder. When
importing pictures in the “Import” window, you will be given the option to
copy the files to your Library, or keep the files in place.

If you have your photos stored on your computer, the option Import
in Place will be suitable so photos aren’t duplicated. If you are importing
photos from an external source, such as a portable hard drive,  flash
drive, or /, you should select Copy into Library so the photos are
copied to your computer—otherwise they won’t appear when you remove
the external source.

Viewing photos

Choose Library or any collection in the sidebar to display photos from
your selection. Use the slider on the boom bar to adjust the size of the
thumbnails. To view a full-window image, double-click an individual photo.
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In the full-window view, you can navigate through the collection using
the back and forward arrows, zoom on the image using the slider, pan by
clicking and dragging the image, and exit the full-window view by double-
clicking the image.

To view the collection in full-screen mode, press F11 or go to View ‣
Fullscreen. You can navigate through the collection using the toolbar that
is available by moving your mouse to the boom of the screen. To view a
slideshow presentation of the collection, press F5 or go to View ‣ Slideshow.
Press the Esc key to exit the Fullscreen or Slideshow views.

Organizing photos

Shotwell makes finding photos of the same type easier by using tags. You
can apply as many tags to a photo as you like. To apply tags to photos,
first select the photos. en right-click on the photos and select Add Tags.
Enter the tags you want into the text field, separated by commas. If you are
adding new tags, these will appear in the side bar on the right under the
Tags label.

Editing images

You may want to edit some of the photos you import into Shotwell. For
example, you may want to remove something at the edge, adjust the color,
reduce the red-eye effect, or straighten the image. To edit a photo, double-
click on the photo that you want to edit and then click on one of the follow-
ing buons:

Rotate

Click Rotate to rotate the image ° clockwise. You can click the buon
more than once and it will rotate the image clockwise in ° intervals.

Crop

Click Crop to change the framing of the photo. e image will darken and a
selection will appear. Adjust the selection to your desired crop by dragging
a corner or side. If you want to choose a specific aspect ratio, use the drop-
down menu to select one of the preset ratios or enter your own custom
ratio. A pivot buon is provided to change your selection from landscape to
portrait and vice versa. Once you are happy with the selection, click OK to
apply the crop or Cancel to discard it.

Red-eye reduction

If you have taken a photo and the flash has caused the subject to have red
eyes, you can fix this problem in Shotwell.

Click the Red-eye buon. A circle will appear.
Drag this circle over one of the subjects eyes and then use the slider to

adjust the circle size.
When the circle is over the eye, click Apply to fix the red eye. You will

need to repeat this for each individual eye. Use caution when adjusting
the size of the circle. A circle too large and covering the skin may cause
discoloration when applying the red-eye reduction.
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Adjust

Clicking Adjust will bring up a window that lets you edit a few things:

‣ Levels: Similar to contrast
‣ Exposure: How bright the image is
‣ Saturation: How colorful the image is
‣ Tint: e overall color
‣ Temperature: Whether the image is warm (more yellow) or cool (more

blue)
‣ Shadows: How dark the shadows are

To change these values, drag the sliders until you are satisfied with the
image. Click OK to apply the changes, Reset to undo the changes and start
over, or Cancel to discard the changes.

Enhance

Click Enhance to let Shotwell automatically adjust the color, levels, expo-
sure, contrast and temperature to make a more pleasing image.

Reverting an edited photo to the original

When you edit a photo in Shotwell, your original image remains untouched.
You can undo all of the changes and revert to the original version by right-
clicking on the photo, then selecting Revert to Original. is option is only
available for photos you have edited.

Sharing your photos

You can easily share your photos on the web using Shotwell’s Publish
feature. Select the photos you want to share, then click the Publish buon
located on the boom bar. Choose Facebook, Flickr, or Picasa Web Albums
in the drop-down menu and log-in with your credentials. Some services
may require you to authorize Shotwell before allowing the application to
publish photos. Follow the instructions on the window, select your desired
options, and click Publish to upload your images to the web.

Further information

We’ve only just touched on the features of Shotwell. To get more help,
select Help ‣ Contents. e User Manual option will take you to http://trac.
yorba.org/wiki/UsingShotwell. which gives more detailed instructions on
how to use Shotwell effectively.

Watching videos and movies

To watch videos or s in Ubuntu, you can use the Movie Player appli-
cation. To start the Movie Player, click on Dash, then search for “Movie
Player” and select it. is will open the “Movie Player” window.

Codecs

Watching s may require Ubuntu to install a “codec,” which is a piece of
soware that allows your computer to understand the contents of the ,
and display the video.

http://trac.yorba.org/wiki/UsingShotwell.
http://trac.yorba.org/wiki/UsingShotwell.
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Figure 3.23: Movie player (Totem) plays music
and videos.

Legal Notice: Patent and copyright laws operate differently depending on which
country you are in. Please obtain legal advice if you are unsure whether a par-
ticular patent or restriction applies to a media format you wish to use in your
country.

So that you can play all videos and s, you will need to install some
codecs. ese are located within the Multiverse repository. is is now
enabled by default.

To install the codecs, open the Ubuntu Soware Center, either through
Dash or the Launcher. When the “Ubuntu Soware Center” window opens,
use the search box in the top right and search for the following:

‣ ubuntu-restricted-extras
‣ libdvdread
‣ libdvdnav

When you find each one, select it with a double-click and then click the
Install buon. is may open an “Authenticate” window. If so, enter your
password then click Authenticate to start the installation process.

Playing videos from file

Open the Movie menu, then select Open…. is will open the “Select
Movies or Playlists” window. Find the file or files that you want to play
and click on the Add buon. e video or videos will start playing.

Playing a DVD

When you insert a  in the computer, Ubuntu should open the “You have
just inserted a Video . Choose what application to launch” window.
Make sure that Open Movie Player is chosen in the drop-down list and
then click OK. e “Movie Player” window will open and the movie will
start.

If the “Movie Player” window is already open, open Movie menu, then
select Play Disc… and the movie will start.
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Listening to audio and music

Ubuntu comes with the Banshee Music Player for listening to your music,
streaming Internet radio and managing playlists and podcasts. Banshee also
comes bundled with multiple ways to find and purchase music, TV shows,
Movies and even ways to subscribe to your favorite  feeds.

Figure 3.24: Banshee Music Player

Starting Banshee

To start Banshee, open the Dash, then click on Listen to Music with the
Banshee logo above it. You can also type Banshee then click on the Banshee
Icon, or browse the list of applications manually. Ubuntu . comes with
an indicator menu for sound-related devices. is menu includes a link to
start Banshee as well as basic playback and volume controls. To quit Ban-
shee, move your mouse into the upper right corner and window controls
will appear. en, click the orange x. You can also click Ctrl+Q on your
keyboard. Banshee will continue to run in the background, but you can still
control your music from the Sound indicator.

Playing music

To play music, you must first import music into your library. Choose Mu-
sic ‣ Import Folder or press Ctrl+O on your keyboard to import a folder
of media, a single file, an Amazon Mp purchase or media from an iPod,
iPhone or iPad. e Banshee toolbar contains most of the controls that you
will use for browsing and playing your music. If you want to play a song,
double-click a track or click it and press the Play buon on the toolbar (you
can also choose Playba ‣ Play from the menubar or press Space). When a
song is playing, the Play buon will become a Pause buon. Clicking on it
will pause the song. Next and Previous buons are next to the Play/Pause
buon. You can click on these buons to play the next and previous songs
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in your library or playlist. Banshee also has options to toggle Shuffle or Re-
peat modes. Banshee offers five different types of shuffling, all of which can
be accessed by clicking on the drop-down menu next to Next buon or by
using the global menubar (Playba ‣ Shuffle). Repeat controls are located
in boom right hand corner and through the global menubar (/menuPlay-
back ‣ Repeat).

Playing Audio CDs

To play your CD, insert it into your drive. It will automatically appear
within Banshee in the Side Pane beneath your Music Library and Video
Library. You can click the CD (named Audio CD, or the name of the album)
and double-click a track in it to play the tracks on the CD.

Importing/Ripping Audio CDs

Begin by inserting a CD. Banshee will automatically detect it and add it to
the side menu. Click the CD. Uncheck any tracks you don’t want imported.
Press the Import CD buon, located near the upper-right corner of Banshee.
Banshee will begin importing the CD. As it finishes each track, they will
appear in your Music Library.

Listening to Streaming Radio

Banshee is pre-configured to enable you to stream radio from various Streaming radio are radio stations that are
broadcast over the Internet.sources. ese include Internet broadcast stations (Radio from the Side

Pane) as well as Last.fm. Streaming radio is a term that refers to radio sta-
tions that are broadcast over the Internet. To listen to an Internet radio
station, right-click Radio in the Side Pane and enter all relevant information
into the corresponding field and click save. e station is now saved in Ban-
shee and you can play it by double-clicking it or by selecting it and clicking
the Play buon. To listen to music from Last.fm, configure your Account
Seings.

Connect digital audio players

Banshee can connect with many popular digital media players. Connected
players will appear in the Devices list. Features will vary depending on the
player (and oen the player’s popularity), but common tasks like transfer-
ring songs and playlists should be supported.

Listen to shared music

If you are on the same network as other Banshee users (or most other music DAAP stands for “Digital Audio Access Proto-
col,” and is a method designed by Apple Inc. to
let software share media across a network.

player soware), you can share your music and listen to their shared music.
Under the Online Media category in the sidepane, there is a subcategory
titled Shared Music. Media shares should be listed automatically, but you
may be required to add the IP manually. To do this click Media ‣Add Re-
mote DAAP Server. en enter the IP address and the port number. en
click OK. Clicking a shared library will enable you to browse and play songs
from other computers. You can also import music from shared libraries by
clicking Media ‣ Import Media (Ctrl+I) then scrolling down to the desired
media share.
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Figure 3.25: Banshee connected to an iPhone

Manage podcasts

Banshee can manage all of your favorite podcasts. Select Podcasts from the
Side Pane to view all added podcasts. e toolbar will display additional op-
tions to Subscribe to a New Podcast (the icon with the green cross) and Check
all Podcasts for New Episodes. Choose Media ‣Add Podcast, Ctrl+Shift+F,
or or press the Subscribe buon in the toolbar to import a podcast. Podcasts
will be automatically downloaded at regular intervals or you can manually
update feeds. Select an episode and click buonPlay. You can also delete
episodes.

View

Banshee comes with the option of a fullscreen mode. To enter fullscreen
mode press F on your keyboard or use the global menubar (View ‣ Fullscreen),
to exit from fullscreen mode press F. Banshee also has a browser bar that is
enabled by default (this area is the top half of the program window). It gives
you the option to search your music by artist (upper-right) or album (upper-
le). is browser can be disabled through the menubar (View ‣Browser)
or with your keyboard (Ctrl+B).

Banshee preferences

e default configuration of Banshee may not be exactly what you want.
Choose Edit ‣ Preferences to alter the application seings. e Preferences
tool is broken into three main areas: General, Source Specific and Extensions.

General Options include how you want Banshee to interact with the actual
media files as well as usability and bug reporting options.

Source Specific options allow you to choose the source of your music, your
music folder, and file organization, as well as how to sort albums by the
same artist and automatically detecting the BPM (Beats per Minute)
of your songs. ‣ [Extensions] options give you the opportunity to add
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functionality to Banshee. ey include Context Pane extensions, Core
extensions, Device Support extensions, Online Source extensions and
Utilities extensions.

Managing your music

Banshee supports creating playlists. Playlists are either static lists of songs
that are played in order or can be smart playlists based on filter criteria.
Playlists contain references to songs in your library. ey do not contain
the actual song file, or even the song in you library. If you remove a song
from a playlist (right-cli on the song ‣Remove from Playlist), it will
remain in your library and on your hard drive. To create a playlist, choose
Media ‣New Playlist, Ctrl+N or right-click Music in the side pane and click
New Playlist. en give the new playlist a name. You can then either drag
songs from you library to the new playlist in the side pane or right-click on
songs and select Add to Playlist and pick the playlist. Smart Playlists are
created almost the same way as static playlists. Choose Media ‣New Smart
Playlist. Next, define the filter criteria. You can add multiple filter rules
and select a name. Finally, click Save. Smart Playlists will appear in your
side pane with a different icon than any static playlists. You can update
any playlist by right-clicking on the name and choosing Edit. Banshee
supports song ratings. Select a song in your library and choose Edit ‣Rating
or right-cli on the song and click on the appropriate amount of stars.
Other song information such as Title, Artist, and Album can be arranged
from right-clicking a song, clicking Edit Tra Information, then looking
under the Basic Details tab. To delete a song, click delete or right-cli it
and select Remove from Library. To delete a song from your hard drive
entirely, right-cli it and select Delete from Drive. If you ever want to
move a song, highlight the song (or group of songs) from your library and
drag it to a folder or to your desktop. is will make a copy of the audio file
in the new location.

Banshee Extensions

Banshee comes with a variety of extensions. ese are tools that you can
enable and disable that add more features to Banshee. Examples include
Youtube searching, Wikipedia Integration, and various music stores. Some
extensions are enabled by default. To view the list of available extensions,
Choose Edit ‣ Preferences ‣Extensions.

Music stores

Banshee has two music stores which give you access to an extremely large
catalog of music with a variety of licensing options. e Ubuntu One Mu-
sic Store (see figure below) sells music from global major and minor music
labels. e store offers DRM-free (no copy protection) songs encoded in
high-quality MP format. You can browse the catalog, play previews, and
buy songs with the Ubuntu One Music Store. e Ubuntu One Music Store
also integrates with the Ubuntu One service as the name suggests. All
purchases are transferred to your personal cloud storage and then auto-
matically copied to all of your computers. For that reason, an Ubuntu One
account is required (it is free of charge and quick to register). e catalog of
music available for purchase will vary depending on where you live in the
world. More information about the Ubuntu One Music Store can be found
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at hps://one.ubuntu.com/music/. e Amazon Music Store is the other
music store included with Banshee. It offers a large variety of music from
various sources. Both stores have very competitive prices.

Figure 3.26: Amazon MP3 Store

Audio codecs

Different audio files (, , ) require unique tools to decode them
and play the contents. ese tools are called codecs. Rhythmbox will at-
tempt to detect any missing codecs on your system so you can play all of
your audio files. If a codec is missing, it will try to find the codec in online
resources and guide you through installation.

Banshee support

Banshee is used by many users throughout the world. ere are a variety of
support resources available in many languages.

‣ Click the Help buon for a variety of support options and information
about reporting Banshee bugs.

‣ e Banshee website: http://banshee.fm/
‣ e Multimedia & Video category of Ubuntu Forums: http://ubuntuforums.

org/forumdisplay.php?f=

Burning CDs and DVDs

To create a  or  open the Dash and search for Brasero Disc Burner,
then open Brasero. is opens Brasero, which gives you five options to
choose from. Each one of these is explained below.

Getting Started

Before you can get started with Brasero, you need to Create a new project.
ere are three types of projects that are available to you: Audio Project,

http://banshee.fm/
http://ubuntuforums.org/forumdisplay.php?f=334
http://ubuntuforums.org/forumdisplay.php?f=334
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Figure 3.27: Brasero burns music, video, and
data DVDs and CDs.

Data Project, and Video Project. Make your selection based on which you
require. Please note that at the moment Brasero does not support Blu-Ray.

ese following options apply for all projects except Disc copy and Burn
Image.

Adding files to a project

To add files to the list, click the Green + buon, which opens the “Select
Files” window. en navigate your way to the file you want to add, click
it, and then click the Add buon. Repeat this process for each file that you
want to add.

Removing files

If you want to remove a file from the project, click the file in the list and Icons of a broom are often used in Ubuntu to
represent clearing a text field or returning
something to its default state.

click on the Red - buon. To remove all the files in the list click on the
Broom shaped buon.

Saving a project

To save a project so that you can finish it later, choose Project ‣ Save. e
“Save Current Project” window will be opened. Choose where you would
like to save the project. en, in the Name: text field, enter a name for the
project so that you will remember it. Now click the Save buon.

Burning the disc

When you click the Burn… buon you will see the “Properties of …” win-
dow.

You can specify the burning speed in the Burning speed drop down. It is
best to choose the highest speed.

To burn your project directly to the disc, select the Burn the image
directly without saving it to disc option. With this option selected, no
image file is created and no files are saved to the hard disk.

e Simulate before burning option is useful if you encounter problems Temporary files are saved in the /tmp folder
by default. Should you wish to save these files
in another location, you will need to change
the setting in the Temporary files drop down
menu. Under normal conditions, you should not
need to change this setting.

burning discs. Selecting this option allows you to simulate the disc burning
process without actually writing data to a disc—a wasteful process if your
computer isn’t writing data correctly. If the simulation is successful, Brasero
will burn the disc aer a ten second pause. During that ten second pause,
you have the option to cancel the burning process.
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Blanking a disk

If you are using a disc that has  wrien on it and you have used it before, RW stands for Re-Writable which means that
disc can be used more than once.then you can blank it so that you can use it again. Doing this will cause you

to lose all of the data currently on the disc. To blank a disc, open the Tools
menu, then select Blank. e “Disc Blanking” window will be open. In the
Select a disc drop down choose the disc that you would like to blank.

You can enable the Fast blank option if you would like to shorten the
amount of time to perform the blanking process. However, selecting this
option will not fully remove the files; if you have any sensitive data on your
disc, it would be best not to enable the Fast blank option.

Once the disc is blank the you will see e disc was successfully blanked.
Click the Close buon to finish.

Audio project

If you record your own music, then you may want to transfer this music
onto an audio  so your friends and family can listen. You can start an
audio project by clicking Project ‣New Project ‣New Audio Project.

So that each file does not play straight aer each other you can add a
two second pause aer a file. is can be done by clicking the file and then
clicking the pause buon.

You can slice files into parts by clicking the Knife buon. is opens a
“Split Track” window. e Method drop down gives you four options each
one of these lets you split the track in a different way. Once you have split
the track click OK.

In the drop down at the boom of the main “Brasero” window make sure
that you have selected the disc that you want to burn the files to. en click
the Burn buon.

Data project

If you want to make a back up of your documents or photos it would be best
to make a data project. You can start a data project by clicking Project then
clicking New Project and then New Data Project.

If you want to add a folder you can click the Folder picture, then enter
the name of the folder.

In the drop down at the boom of the main “Brasero” window make sure
that you have selected the disc that you want to burn the files to. en click
the Burn buon.

Video project

If you want to make a  of your family videos it would be best to make
a video project. You can start a video project by clicking Project, then New
Project and then New Video Project.

In the drop down at the boom of the main “Brasero” window make sure
that you have selected the disc that you want to burn the files to. en click
the Burn buon.

Disc copy

You can copy a disc clicking Project, then New Project and then Disc copy.
is opens the “Copy /” window.
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If you have two / drives you can copy a disc from one to the other,
the disc that you want to copy to must be in the / drive. If
you have only one drive you will need to make an image and then burn it to
a disc. In the Select disc to copy drop-down choose the disc to copy. In the
Select a disc to write to drop-down either choose image file or the disc that
you want to copy to.

Image file

You can change where the image file is saved by clicking Properties, this
shows the “Location for Image File”. You can edit the name of the file in the
Name: text field.

e default save location is your home folder, you can change this by
clicking the + next to Browse for other folders. Once you have chosen
where you want to save it click Close.

Back in the “Copy /” window click Create Image. Brasero will
open the “Creating Image” and will display the job progress. When the
process is complete click Close.

Burn image

To burn an image, open the Project ‣New Project, and then Burn Image.
Brasero will open the “Image Burning Setup” window. Click on the Cli
here to select a disc image drop-down and the “Select Disc Image” window
will appear. Navigate your way to the image you wish to burn, click on it,
and then click Open.

In the Select a disc to write to drop-down menu, click on the disc to
which you’d like to write, then click Create Image.

Working with documents, spreadsheets, and presentations

LibreOffice suite is the default office suite when working with: word docu-
ments, spreadsheets, and slide presentations.

Working with documents

If you need to work with documents, you can use the LibreOffice Word Pro- The LibreOffice Word Processor is also known
as the LibreOffice Writer. Spreadsheet is also
known as Calc, and Presentation is known as
Impress.

cessor. To start the word processor, open the Dash home of the Launcher,
search for LibreOffice Writer and select it. Ubuntu should then open the
main window for the word processor.

Working with spreadsheets

If you need to work with spreadsheets, you can use the LibreOffice Spread-
sheet. To start the spreadsheet application, click on the Dash home, type
LibreOffice Calc and select LibreOffice Calc.

Working with presentations

If you need to work with slides for a presentation, you can use the Libre-
Office Impress. To start the presentation application, open the Dash home
menu, type LibreOffice Impress, and then click on it.



     .

Getting more help

Each of these applications comes with a comprehensive set of help screens.
If you are looking for more assistance with these applications, press the F1
key aer starting the application.

Ubuntu One

What is Ubuntu One?

Ubuntu One is an optional, online storage service that allows you to save
and access your data over the Internet and to share and synchronize infor-
mation with other people and devices. Ubuntu One is run by Canonical, the
people who develop Ubuntu.

Although the name implies that it is an Ubuntu-specific feature, at its Internet-based services such as Ubuntu One
are often referred to as “cloud services.” The
word “cloud” is often used to denote a remote
network such as the Internet, which would
often be drawn as a cloud shape on diagrams.

simplest, Ubuntu One can be used with any device that has a web browser
and Internet access, regardless of operating system. You don’t need to be
an Ubuntu user at all! However, to make best use of all the Ubuntu One
features, you will need to install some special Ubuntu One soware on
your device. ere are currently versions available for Windows, Android
and iPhone/iPad. (Of course, there is also an Ubuntu version, which is
automatically installed as part of the standard Ubuntu set up).

You may see this software referred to as the
Ubuntu One client (because it runs on a user’s
(i.e., client) machine, rather than a server. There
are also non-official Ubuntu One client versions
available for other operating systems, such as
Fedora.

Uses for Ubuntu One

Here are some situations where you may find Ubuntu One useful:

You have multiple devices and want to share files between them

If you oen work at several different machines, it can be frustrating to re-
alize that a file you want to use is stored on another machine. One solution
is to carry a  memory stick around and save files onto this. But there
are some problems with this: you may not have the stick with you when
you need it; the device you are using (a smartphone, say) may not have a
 socket; or the device’s  sockets may have been disabled (as they
oen are, i.e., in Internet cafés). Plus, there is always the risk of losing the
stick…Ubuntu One provides a neat alternative to this problem. Storing your
files online means they can be accessed from any device that has Internet
access.

You want to share files with family and friends

Ubuntu One allows you to share some of your online files with other peo-
ple. ere are several reasons you might want to do this. You don’t have
to send the files to them directly—for example, as email aachments. is
is particularly useful if the files are large: large aachments can be annoy-
ing for the recipients because they are slow to download and can clog up
inboxes. Instead of sending the files themselves, you include a link to them
instead. A typical example might be a couple away on holiday uploading
photographs from their smartphone to Ubuntu One for the rest of the fam-
ily back home to see. Sharing files online also makes it easier to collaborate.
Having a single copy of documents accessible by everybody makes it easier
to coordinate changes and avoids inadvertently creating multiple versions,
which might happen if documents are circulated around by email. A small
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club or society might find this useful, for example, to collaborate on doc-
uments such as agendas, publicity material, meeting minutes and so on.

Note that Ubuntu One is not a revision control
system. If you need revision and version control
features, have a look at Bazaar http://bazaar.
canonical.com

Which files you share and who you share them with is up to you. Files
can be visible just to you, to a defined group, or to everybody.

You want a simple way to backup files online

ere are many ways to lose data, for example:

‣ accidentally deleting a file (although you may be able to recover it from
the trash bin);

‣ inadvertently re-formaing a disk or partition;
‣ losing a  stick;
‣ device failure, such as a hard drive breaking;
‣ damage to media, such as scratching a  or ;
‣ fire, the etc.

It is always prudent to make backups of valuable files and Ubuntu One
provides a good solution because, whatever may befall your own media or
devices, your files will remain safe and secure on Ubuntu One servers.

You are a music fan and like to listen to music on different devices

Ubuntu One provides a neat solution for people who like to listen to music
on multiple devices. You can use your Ubuntu One account as an online
jukebox and have your music streamed to whatever device you are cur-
rently using. Your music collection is available at any time on any device.
You can also purchase music quickly and easily in the Ubuntu One Music
Store and have it delivered directly in to your account, ready for streaming.

Ubuntu One Music Streaming requires payment of a subscription.

How safe is Ubuntu One?

Before using Ubuntu One, you should bear the following points in mind: Ubuntu One uses the same encryption tech-
niques used to secure online banking.

‣ Uploading, downloading and synchronizing your information with
Ubuntu One is done over an encrypted connection, which prevents
anybody eavesdropping on your information as it is being transferred.

‣ Information uploaded to Ubuntu One can potentially be accessed by
Canonical, so as with other online services and websites, you are implic-
itly trusting them to respect your privacy. If you don’t feel you can trust
them with certain information, don’t upload it to Ubuntu One.

‣ If you violate the Ubuntu One terms and conditions and store illegal
material, Canonical may be required to hand the information over to law
enforcement agencies without your consent.

‣ Your online information can be accessed by anybody who knows (or can
guess) your account name and password. For this reason, you should
choose a good password and keep it secure.

Getting started with Ubuntu One

To use Ubuntu One, you will need to create an online account and subscribe 5GB is enough to store about 1,500 music files
or 5,000 photographs (depending on size).

http://bazaar.canonical.com
http://bazaar.canonical.com
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to the Ubuntu One service. Subscribing is free and will give you GB of
online storage. If you find this is not enough, you can purchase additional
storage in GB blocks for either a monthly or annual subscription.

Note: you will need an email address in order to set up Ubuntu One. If necessary,
first create an email account. You will also need to be connected to the Internet.

ere are two ways to create an Ubuntu One account. You can sign up
online by going to the Ubuntu One website https://one.ubuntu.com and
clicking the Sign Up link. Alternatively, you can sign up using the Ubuntu
One Control Panel.

Creating an Ubuntu One account using the Ubuntu One Control Panel

In the launcher, click the Ubuntu One buon.

Figure 3.28: Launcher Icon
is will open the Ubuntu One Control Panel.

Figure 3.29: Control Panel Initial View

Click the Join now buon. e Create Ubuntu One account dialog will
appear.

Figure 3.30: Control Panel Create Account

Fill in the details requested. Make sure you use a valid email address that
only you have access to. e squiggly text below your details is a captcha.
You need to re-type the captcha text back into the text box below. Because

https://one.ubuntu.com
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captchas are automatically generated, they can sometimes be difficult to
read. If you get one that is indecipherable, just click the circular blue arrow
to generate another.

You should review the terms and conditions before signing up. When The captcha acts as a check that it really is a
person filling in the form and not a computer
(because a computer won’t be able to read the
captcha text).

you’re happy, click Forward.

Figure 3.31: Control Panel Create Account

You will be sent an email containing the verification code (this may take
a few minutes to arrive, so be patient!). Enter the verification code into the
box and click OK. If all goes well, you will get a congratulatory message
and then see the main Ubuntu One Control Panel. You will also get another
email welcoming you to Ubuntu One. Congratulations, you’re now signed
up!

Using Ubuntu One

Now you’re signed up, there are various things you can do using your
Ubuntu One account:

‣ Manage your cloud data via the Ubuntu One website
‣ Manage your account via the Ubuntu One Control Panel
‣ Set up contact synchronization with underbird
‣ Synchronize your cloud and local files using Nautilus

e following sections cover each of these.

Using the Ubuntu One website

You can access your cloud data through the Ubuntu One website at https://
one.ubuntu.com. Sign in using the same email address and password you
used in the sign up process. Once signed in, you should see your account
dashboard.

e dashboard summarizes your account use and provides a central
point of access. rough the dashboard, you can:

‣ Create ‘post it’ style reminder notes
‣ Manage your contacts

Managing your cloud files and folders

On the dashboard screen, click the Files link. e Files page appears.

https://one.ubuntu.com
https://one.ubuntu.com
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Figure 3.32: Ubuntu One Web Dashboard

Uploading a file to Ubuntu One

‣ Click Upload file. A small pop-up window appears.
‣ Click Browse to open the file selector and select a file to upload.
‣ en click Upload to upload the file.
‣ e file will then appear in your online storage.

You can only upload one file at a time. If
you have a lot of files, it is easier to use file
synchronization, described later.

Once a file has been uploaded, you have several options:

Delete File If you no longer need the file, you can delete it from your ac-
count. You will be asked to confirm this action.

Download file is allows you to retrieve a file from online storage. De-
pending on the type of file and your browser’s configuration, you may
see either a download prompt or the file may be displayed in a new
browser tab. You may need to clickMore on the right hand

side of the page to see these options. You can
also download a file by clicking its name.

Publish File Publishing a file makes it publicly available for other people to
view (but not change). When you publish a file, Ubuntu One will assign
it a unique URL through which the file can be viewed directly. You can
give this URL to anybody who would like to view the file. When a file is
published, its icon becomes embellished with a globe and its public URL
will be shown. To stop publishing the file, click Stop publishing. e file
will no longer be available at the URL and anybody trying to view it will
receive an error message. Be careful not to publish files unintentionally!

Bear in mind that published files can potentially
be viewed by anybody, not just people you
give the URL to: there is always a chance that
other people may stumble across the file’s URL
accidentally—for example, by mistyping the
URL of another file published by somebody
else. If the file is confidential, you should
probably not publish it! You can publish the file
again later if you wish. Its public URL will be the
same as before.

Using Folders

Ubuntu One allows you to group your files into folders to make them easier
to manage, just as you would with local files.

Creating a new folder

Click New folder, enter a name in the pop-up window then click Create.
e new folder will be created and will appear in your storage.
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Adding and deleting files from a folder

In order to manage the files in a folder, you first need to navigate into it so
that it becomes the current folder. You do this by clicking the folder name.
Once in the folder, adding and deleting files is done exactly as before. It
is also possible to create sub-folders (and sub-sub-folders if you wish). To
return to your main folder, click My Storage in the location path.

Deleting a folder

Deleting a folder is similar to deleting a file. Just click Delete folder and
confirm that this is what you want to do. Deleting a folder will also delete
all the files and folders inside it.

Sharing a folder

Sharing a folder allows you to give one or more people access to the folder
and its contents. You can also specify whether each person can modify
the files in the folder or just view them. Anybody you would like to share
a folder with will either need to have an existing Ubuntu One account or
be prepared to sign up for one. To share a folder with someone else, click
Share folder. A pop-up box will appear. Enter the email address of the
person you would like to share with. is person will be sent an email
containing instructions for viewing the shared folder and for signing up
to Ubuntu One if necessary. e share name is the name of the folder as
the other person will see it. For example, you might have a folder called
Pix_2011_06_Small, but want to share it as the more friendly Our Holiday
Photos. e Allow modification check box specifies whether the sharer will
be able to modify the contents of the folder (that is, to add, edit, or delete
files and sub-folders). If the box is not ticked, they will be restricted to read-
only access. Click Share this folder to begin sharing. You can share a folder
with several people by repeating these steps for each person in turn. You
can stop sharing a folder with someone by clicking Stop sharing.

Sharing is not the same as publishing. Sharing
is more secure because there is no public URL
for the folder and the people you share with
have to be authenticated by signing in to their
Ubuntu One account.

Accepting a share invitation from someone else

If you are invited to share a folder by someone else, you will receive an
email containing a link. Clicking the link will take you to the Ubuntu One
website where you can log in and accept the share. Aer you have done so,
the shared folder will appear in your list of files.

Figure 3.33: Web Files Shared Folder

If you have been allowed to modify the folder by the sharer, you will be
able to add, edit and delete files and sub-folders as if the folder was one of
your own. If you don’t have modify permissions, you won’t be able to make
any changes.

Files in folders shared by other people do not
count towards your 5GB storage allowance,
because the files are not actually stored in your
account.
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Using the Ubuntu One Control Panel

e Ubuntu One Control Panel gives you a quick and easy way to manage
your Ubuntu One account. e control panel is opened by clicking the
Ubuntu One buon in the launcher.

Figure 3.34: Control Panel Account

e control panel has four tabs:

‣ Account: lets you amend your account details
‣ Cloud Folders: lets you control file and folder synchronization between

your current device and your Ubuntu One account
‣ Devices: lets you manage the devices aached to your Ubuntu One

account
‣ Services: lets you set up and manage additional synchronization options,

such as synchronizing your contacts.

When you first open the Ubuntu One Control
Panel, you may see the Introductory page (with
the Join Now option) shown in the ‘Creating
an Ubuntu One subscription’ section. At this
point, the Control Panel is connecting to your
Ubuntu One account. Once this has been done,
the page will change to the Welcome to Ubuntu
One page shown here.

The Cloud Folders tab

e Cloud Folders tab lets you control which folders are being synchro-

You can also control folder synchronization
through Nautilus (see later).

nized. You can specify whether a cloud folder is synchronized with a local
folder by ticking or clearing the Sync locally? check box.

This controls the synchronization with your cur-
rent device only. You can choose to synchronize
different cloud folders with different devices.
For example, if someone is sharing a folder
with you, you may only want to synchronize
it with your desktop computer and not with
your laptop or smartphone. (Of course, you can
always access any cloud folder via the Ubuntu
One website whether or not it is synchronized).

The Devices tab

e Devices tab lists the devices that have been set up to synchronize with
your Ubuntu One account, with the current device highlighted. ere are
two uses for this tab. Firstly, you can remove a device so that it no longer
synchronizes. Secondly, you can configure bandwidth throling to limit
the amount of your connection’s capacity that Ubuntu One will use during
synchronization. By default, there is no throling, but you may wish to
change this if you find that synchronization is affecting your other online
activities, such as web-browsing. Obviously, the more the bandwidth is
throled, the longer it will take to synchronize files.

The Services tab

e services tab allows you to configure additional synchronization fea-
tures. By default, synchronization of files is always enabled. However, it
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is possible to synchronize other information as well—i.e., your contacts,
Tomboy notes and soware selection. If you intend to use these extra fea-
tures, you should install the ubuntuone-desktopcouch package, by clicking
the Install now buon on this page.

Synchronizing Contacts with Thunderbird

Your Ubuntu One account can synchronize contacts between the following
sources:

‣ Your Facebook account
‣ Your mobile phone
‣ Your underbird address book

Thunderbird synchronization

Synchronization is handled by a underbird plug-in, which can be in- Thunderbird contact synchronization is
currently only available for Ubuntu. For other
operating systems, you will need to access
contacts through the Ubuntu One website.

stalled from the Services tab of the Ubuntu One Control Panel.
Click the Install now buon in the Contacts section to install the plug-

You need to have installed the ubuntuone-
desktopcouch package first.

in. Once installed, the ‘Enable Contacts Sync’ check-box will be ticked.
Aer a synchronization cycle, you will see your online contacts appear

You may need to restart Thunderbird to
activate the plug-in.

in the Ubuntu One folder in your underbird address book. Synchroniza-
tion is bi-directional: if you add a contact to your Ubuntu One address book,
it will appear in your Ubuntu One account and vice versa.

Using Ubuntu One with Nautilus

Basic file and folder synchronization using Nautilus

If you created your Ubuntu One account using the Ubuntu One Control
Panel and have uploaded some files, you may be surprised to see that copies
of these files have appeared in the “Ubuntu One” folder in your home folder.
is is Ubuntu One’s file synchronization feature at work. Synchroniza-
tion is the process of replicating files and folders between devices and your
Ubuntu One account. e synchronization occurs continuously in the back-
ground (as long as you are connected to the Internet) and is bi-directional,
so that changes to either the local or cloud copy of a file will be replicated
to the other. By default, the “Ubuntu One” folder is automatically synchro-
nized. However, it is possible to synchronize other folders as well.

In Nautilus, synchronized folders are indicated with a tick mark. You can only synchronize folders in your home
folder.

Figure 3.35: Ubuntu One Folder Icon

Because the “Ubuntu One” folder is automatically synchronized, it pro-
vides quick and easy access to your cloud storage: any files or folders you
create in this folder will automatically be synchronized to your Ubuntu
One account with no further effort on your part. is is much easier than
manually uploading and downloading files via the Ubuntu One website. If
you make a lot of changes to synchronized files and folders in a short time,
the synchronization process may not be able to keep up with them all im-
mediately. is is especially likely to happen if you have a slow Internet
connection or you have restricted the bandwidth that synchronization is al-
lowed to use. However, the pending changes will all eventually get wrien.

e synchronization state of each file or folder is indicated by a badge
on its icon: a green tick means the file is synchronized, whilst a circle of
green and blue arrows means synchronization is pending or underway. In
the screenshot below, quote.txt is up to date, but ‘LargeFile.txt’ is still being
synchronized.

You can also get an overview of the synchro-
nization state from the Ubuntu One Control
Panel, which will show either “File Sync in
progress” or “File Sync is up-to-date.” However,
the Control Panel does not show the state of
individual files.
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Figure 3.36: Ubuntu Nautilus Badges

You can make any changes you like to the local copy of the file and they
will automatically be synchronized to Ubuntu One. is table summarises
how changes to the local file are synchronized:

Ubuntu One File Actions

Action Effect in Cloud Notes

Move file: into
Ubuntu One
folder

Remote file
created

Any new file that appears in the Ubuntu
One folder will automatically begin to be
synchronized.

Update file: edit
and save

Remote file up-
dated to new
contents

Rename file Remote file
renamed

Delete file Remote file
deleted

Move file: to
another (un-
synchronized)
folder

Remote file
deleted

Because the file has been removed from
the Ubuntu One folder, this is treated as
a deletion. e file is no longer under
synchronization.

Synchronizing additional folders

You can specify additional folders that should be synchronized, as long as
they are in your home folder. For instance, you may wish to synchronize
your Documents folder so that your documents are available on all your
devices. To synchronize another folder, navigate to the folder in Nautilus,
then tick the Synchronize this folder.

Alternatively, right-click a folder icon to display its shortcut menu, then
select Ubuntu One ‣ Synchronize is Folder.

Encrypting files for security

You can give yourself an extra layer of security by encrypting sensitive This is not a very robust encryption method. If
you need greater protection, consider using an
application such as GPG (GNU Privacy Guard)
that uses cryptographic keys rather than
passwords.

files before puing them on Ubuntu One. is will help protect you if your
Ubuntu One account is compromised. Here is a simple way to do this:

‣ In Nautilus, right-click on the file you want to encrypt and select Com-
press….
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Figure 3.37: Nautilus Sync

‣ e “Compress” dialog will appear with your filename selected.
‣ For the filetype, choose .zip.
‣ Click the arrow next to Other Options to expand the section and see the

Password box.
‣ Enter a password, then click Create.

A new file will be created with a .zip extension in the same folder as your
original document. is file contains an encrypted version of the original
file, which you can then safely upload to Ubuntu One.

Make sure you only upload the encrypted version of the file to Ubuntu One and
not the original! Don’t use your account password to protect your document. If
somebody knows your account password, they will probably try this first.

Some applications, such as LibreOffice, can already create password-
protected documents. If a document is already encrypted, there is no need
to re-encrypt it.

e .zip format will also try to compress your file, so you may find that
the encrypted file is smaller than the original. Don’t worry about this: none
of your information has been lost and when you decrypt the file, it will be
exactly the same as before.

Decrypting an encrypted file

To recover the original document, double-click the .zip file. is will open
the Archive Manager application. Click the Extract buon on the toolbar,
specify a location for the decrypted file, then click Extract. At this point,
you will be prompted to enter the original password so that the file can be
decrypted.

The Shared With Me folder

Shared With Me is a special folder where folders that other people are
sharing with you can be synchronized. By default, shared folders are not
synchronized. To enable synchronization, use the Cloud Folders tab of the
Ubuntu One Control Panel and ensure the Sync locally? box is ticked for
the shared folder you want to synchronize. e folder will then appear in
the Shared With Me folder and begin to synchronize. Once the synchro-
nization is complete, the folder emblem will change from circular blue and
green arrows to a green tick.





4 Hardware

Using your devices

Ubuntu supports a wide range of hardware, and support for new hardware
improves with every release.

Hardware identification

To identify your hardware you can install the following application: Click
Ubuntu Soware Center from the Unity launcher. When the “Ubuntu
Soware Center” window opens, use the search box in the top right and
search for the following: sysinfo. Now select the Application, click Install
and enter your password to install the application.

To run the application, search for Sysinfo at the Dash search bar. Click
on the program once you find it. e Sysinfo program will then open a
window with information about the hardware that is part of your system.

Displays

Hardware drivers

A driver consists of code that is packaged in a file, which tells your com-
puter how to communicate with a piece of hardware. Every component in a
computer requires a driver to function, whether it’s the printer,  player,
hard disk, or graphics card.

A majority of graphics cards are manufactured by three well-known Your graphics card is the component in your
computer that outputs to the display. When
you’re watching videos on YouTube, viewing
DVDs, or simply enjoying the smooth transition
effects when you maximize/minimize your
windows, your graphics device is doing the hard
work behind the scenes.

companies: Intel, /, and  Corp. You can find your video card
manufacturer by referring to your computer’s manual, looking for the
specifications of your particular model on the Internet, or by using the com-
mand lspci in a terminal. e Ubuntu Soware Center houses a number
of applications that can tell you detailed system information. SysInfo is one
such program that you can use to find relevant information about your Sys-
tem devices. Ubuntu comes with support for graphics devices manufactured
by the above companies, and many others, out of the box. at means you
don’t have to find and install any drivers yourself, Ubuntu takes care of it
all.

Keeping in line with Ubuntu’s philosophy, the drivers that are used by
default for powering graphics devices are open source. is means that
the drivers can be modified by the Ubuntu developers and problems with
them can be fixed. However, in some cases a proprietary driver (restricted
driver) provided by the company may provide beer performance or fea-
tures that are not present in the open source driver. In other cases, your
particular device may not be supported by any open source drivers yet. In
those scenarios, you may want to install the restricted driver provided by
the manufacturer.

For both philosophical and practical reasons, Ubuntu does not install
restricted drivers by default but allows the user to make an informed choice.
Remember that restricted drivers, unlike the open source drivers for your
device, are not maintained by Ubuntu. Problems caused by those drivers
will be resolved only when the manufacturer wishes to address them.
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To see if restricted drivers are available for your system, press the Su-
per/Windows key on your keyboard to show the dash or click the Ubuntu
icon on the Unity launcher, and search for Additional Drivers. If a driver
is provided by the company for your particular device, it will be listed there.
You can simply click Activate to enable the driver. is process requires an
active Internet connection and it will ask for your password. Once installa-
tion is complete you may have to reboot your computer to finish activating
the driver.

e Ubuntu developers prefer open source drivers because they allow
any problem to be identified and fixed by anyone with knowledge within
the community. Ubuntu development is extremely fast and it is likely that
your device will be supported by open source drivers. You can use the
Ubuntu Live  to check your device’s compatibility with Ubuntu before
installing, or go online to the Ubuntu forums or to http://www.askubuntu.
com to ask about your particular device.

Another useful resource is the official online
documentation (http://help.ubuntu.com), which
contains detailed information about various
graphics drivers and known problems. This
same documentation can be found by searching
for Yelp in the Dash search bar or by pressing
F1 on your keyboard.

Setting up your screen resolution

One of the most common display related tasks is seing your screen resolu-
tion.

Ubuntu correctly identifies your native screen resolution by itself and Displays are made up of thousands of tiny
pixels. Each pixel displays a different color,
and when combined they all display the image
that you see. The native screen resolution is a
measure of the amount of actual pixels on your
display.

sets it for you. However, due to a wide variety of devices available, some-
times it can’t properly identify your resolution.

To set or check your screen resolution, go to System Settings ‣Displays.
e “Displays” window shows you your monitor’s name, size, screen res-
olution, and refresh rate. From the Resolution drop-down menu you can
select the resolution of your choice.

Adding an extra display

Sometimes, you may want to add more than one display device to your
desktop, or may want to add an external monitor to your laptop. Doing
this is quite simple. Whether it’s an extra monitor, LCD TV, or a projector,
Ubuntu can handle it all. Ubuntu supports the addition of multiple displays
by default, which is as easy as plug and play. Ubuntu recognizes almost
all the latest monitors, TVs and projectors by default. Sometimes it may
happen that your additional display is not detected when you connect it to
the machine. To resolve this, go to System Settings ‣Displays and click on
Detect Displays. is will detect the monitors connected to the machine.
is menu can also be found from the Power Off menu on the top panel.
You can also search for Displays at the Dash search bar. Now, there are two
modes which you can enable for your displays. One option is to spread your
desktop across two or more monitors. is is particularly useful if you are
working on multiple projects and need to keep an eye on each of them at
the same time. e second option is to mirror the desktop onto each of the
displays. is is particularly useful when you are using a laptop to display
something on a larger screen or a projector. To enable this option just check
the box beside Mirror displays and click Apply to save the seings. You
will get a pop-up notification asking if you want to keep the current seing
or revert to the previous seing. Click to keep the current seing.

http://www.askubuntu.com
http://www.askubuntu.com
http://help.ubuntu.com
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Connecting and using your printer

Ubuntu supports most new printers. You can add, remove, and change
printer properties by navigating to System Settings ‣ Printing. You can also
search for Printing from the Dash search bar. Opening Printing will display
the “Printing-localhost” window.

When you want to add a printer, you will need to make sure that it is
switched on, and plugged into your computer with a  cable or connected
to your network.

Adding a local printer

If you have a printer that is connected to your computer with a  cable
then this is termed a local printer. You can add a printer by clicking on the
Add Printer buon.

In the le hand pane of the “New Printer” window any printers that you
can install will be listed. Select the printer that you would like to install and
click Forward.

You can now specify the printer name, description and location. Each of If your printer can automatically do double
sided printing, it will probably have a duplexer.
Please refer to the instructions that came with
the printer if you are unsure. If you do have a
duplexer, make sure the Duplexer Installed
option is checked and then click the Forward
button.

these should remind you of that particular printer so that you can choose
the right one to use when printing. Finally, click Apply.

Adding a network printer

Make sure that your printer is connected to your network either with an
Ethernet cable or via wireless and is turned on. You can add a printer by
clicking Add Printer. e “New Printer” window will open. Click the “+”
sign next to Network Printer.

If your printer is found automatically it will appear under Network
Printer. Click the printer name and then click Forward. In the text fields
you can now specify the printer name, description and location. Each of
these should remind you of that particular printer so that you can choose
the right one to use when printing. Finally click Apply.

You can also add your network printer by entering the  address of the
printer. Select “Find Network Printer,” enter the  address of the printer
in the box that reads Host: and press the Find buon. Ubuntu will find the
printer and add it. Most printers are detected by Ubuntu automatically. If
Ubuntu cannot detect the printer automatically, it will ask you to enter the
make and model number of the printer.

The default printer is the one that is automat-
ically selected when you print a file. To set a
printer as default, right-click the printer that
you want to set as default and then click Set As
Default.

Changing printer options

Printer options allow you to change the printing quality, paper size and
media type. ey can be changed by right-clicking a printer and choosing
Properties. e “Printer Properties” window will show; in the le pane,
select Printer Options.

You can now specify seings by changing the drop-down entries. Some
of the options that you might see are explained.

Media Size

is is the size of the paper that you put into your printer tray.
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Media source

is is the tray that the paper comes from.

Color Model

is is very useful if you want to print in Grayscale to save on ink, or to
print in Color, or Inverted Grayscale.

Media type

Depending on the printer you can change between:

‣ Plain Paper
‣ Automatic
‣ Photo Paper
‣ Transparency Film
‣  or  Media

Print quality

is specifies how much ink is used when printing, Fast Dra using the
least ink and High-Resolution Photo using the most ink.

Sound

Ubuntu usually detects the audio hardware of the system automatically
during installation. e audio in Ubuntu is provided by a sound server
named PulseAudio. e audio preferences are easily configurable with the
help of a very easy to use  which comes preinstalled with Ubuntu.

Volume icon and Sound Preferences

A volume icon, siing on the top right corner of the screen, provides quick
access to a number of audio related functions. When you le-click on the
volume icon you are greeted with four options: A mute option at the very
top, a slider buon which you can move horizontally to increase/decrease
volume, a shortcut to the default music player Banshee and an option for
accessing the Sound Preferences. Selecting Sound Preferences opens up
another window which provides access to sound themes, hardware, input
and output preferences. Sound Preferences can also be found if you go to
System Settings ‣ Sound.

Sound Effects e first tab which shows up by default is Sound Effects. You can add new sound themes by installing
them from Software Center (e.g., Ubuntu
Studio’s GNOME audio theme.) You will get the
installed sound themes from the drop down
menu. You can also enable window and button
sounds.

You can disable the existing sound theme or configure it with the options
available.

Hardware e Hardware tab will have a list of all the sound cards available
A microphone is used for making audio/video
calls which are supported by applications like
Skype or Empathy. It can also be used for sound
recording.

in your system. Usually there is only one listed; however, if you have a
graphics card which supports  audio, it will also show up in the list.

Input e third tab is for configuring audio Input.You will be able to use You should note that by default in any Ubuntu
installation, the input sound is muted. You
will have to manually unmute to enable your
microphone to record sound or use it during
audio/video calls.

this section when you have an in-built microphone in your system or if
you’ve pluged in an external microphone. You can also add a bluetooth
headset to your input devices which can serve as a microphone. You can
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increase/decrease and mute/unmute input volume from this tab. If there is
more than one input device, you will see them listed in the white box which
reads Choose a device for sound input.

By default, the volume in Ubuntu is set to
maximum during installation.

Output e Output tab is used for configuring the output of audio. You If you change your sound output device, it will
remain as default.can increase/decrease and mute/unmute output volume and select your

preferred output device. If you have more than one output device, it will be
listed in the section which reads “Choose a device for sound output.” e
default output hardware, which is automatically detected by Ubuntu during
installation will be selected.

Applications e Applications tab is for changing the volume for running The Ubuntu Design Team have made a few
changes to the volume icon in this release of
Ubuntu 11.10.

applications. is comes in handy if you have multiple audio applications
running, for example, if you have Rhythmbox, Totem Movie Player and a
web-based video playing at the same time. In this situation, you will be able
to increase/decrease, mute/unmute volume for each application from this
tab.

More functionality

e icon can control various aspects of the system, application volume and
music players like Banshee. e volume indicator icon can now be easily
referred to as the sound menu, given the diverse functionality of the icon.
Media controls available include play/pause, previous track, and next track. You can start and control the default music

player, Banshee, by simply left clicking on the
sound menu and selecting Banshee from the
list. Clicking the play button also starts the
player.

You can also switch between different playlists from the Choose Playlist
option. ere is also a seek bar which you can manually drag to skip some
portions of any song. If the current playing song has album art, it will
show up beside the name of the current track, otherwise you will see only
the details of the song. It displays the track name, the artist name and the
album name of the current track.

Using a webcam

Webcams oen come built into laptops and netbooks. Some computers,
such as Apple desktops, have a webcam built into their display. If you
purchase a webcam because your computer doesn’t have its own, it will
most likely have a  connection. To use a  webcam, plug it into an
empty  port on your computer.

Almost all new webcams are detected by Ubuntu automatically. You can There are several applications which are useful
if you have a webcam. Cheese can capture
pictures with your webcam and VLC media
player can capture video from your webcam.
You can install these from the Ubuntu Software
Center.

configure webcams for individual applications such as Skype and Empathy
from the application’s setup menu. For webcams which do not work right
away with Ubuntu, visit https://wiki.ubuntu.com/Webcam for help.

Scanning text and images

Scanning a document or an image is very simple in Ubuntu. Scanning is
handled by the application Simple Scan. Most of the time, Ubuntu will
simply detect your scanner and you should just be able to use it. To scan a
document, follow these steps:

. Place what you want to scan on the scanner.
. Click to open the Dash and enter scan.
. Click on Simple Scan.

https://wiki.ubuntu.com/Webcam
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. Click to choose between Text or Photo from Document ‣ Scan ‣Text.
. Click Scan.
. Click the Paper Icon to add another page.
. Click Save to save.

You can save the scanned documents and pictures in jpeg. You can also
save in pdf format to enable opening in Acrobat Reader. To do that, add the
extension “.pd” at the end of the filename.

Help! Ubuntu can’t find my scanner!

If your scanner is not detected, Ubuntu may give you a “No devices avail-
able” message when trying to scan. ere may be a reason why Ubuntu
cannot find your scanner.

‣ Simply unplug the scanner and plug it back in. If it is a newer  scan-
ner, it is likely that it will just work.

‣ e driver for your scanner is not being automatically loaded. Restart
your system. It might help!

‣ Your scanner is not supported in Ubuntu. e most common type
of scanner not supported is old parallel port or Lexmark All-in-One
printer/scanner/faxes.

‣  project listing of supported scanners. e  (Scanner Access
Now Easy) project provides most of the back-ends to the scanning so-
ware on Ubuntu.

‣ Check https://wiki.ubuntu.com/HardwareSupportComponentsScanners
to find out which scanners work with Ubuntu.

Other devices

USB

USB ports are available as standard on almost all computers available now.
ey are used to connect a multitude of devices to your computer. ese
could include portable hard drives, flash drives, removable //Blu-ray
drives, printers, scanners and mobile phones. When connected, flash drives
and portable hard drives are automatically detected—the file manager will
open and display the contents of the drive. You can then use the drives
for copying data to and from the computer. All new cameras, camcorders
and mobile phone  cards are automatically detected by Ubuntu. ese
SD cards have different types of data, so a window will appear with a drop
down menu to choose between video, audio import and the file manager
—you can choose your desired action from this menu.

Firewire

Firewire is a connection on some computers that allows you to transfer data Firewire is officially known as IEEE 1394. It
is also known as the Sony i.LINK and Texas
Instruments Lynx.

from devices. is port is generally used by camcorders and digital cameras.
If you want to import video from your camcorder you can do so by

connecting your camcorder to the Firewire port. You will need to install a
program called Kino which is available in the Ubuntu Soware Center. To find out more about Kino, visit http://www.

kinodv.org/.

Bluetooth

Bluetooth is a wireless technology that is widely used by different types of
devices to connect to each other. It is common to see a mouse or a keyboard

https://wiki.ubuntu.com/HardwareSupportComponentsScanners
http://www.kinodv.org/
http://www.kinodv.org/
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that supports Bluetooth. You can also find  devices, mobile phones,
headsets, music players and many other devices that can connect to your
desktops or laptop and let you transfer data, listen to music, or play games
as an example.

If your computer has Bluetooth support then you should see a Bluetooth
icon in the top panel, usually near the volume icon. Click on the Bluetooth
icon to open a popup menu with several choices, such as an option to Turn
off Bluetooth.

Figure 4.1: The Bluetooth applet menu.

e Bluetooth preferences can also be accessed from System Settings ‣
Bluetooth. If you want to connect a new device—for example, to have a
mobile phone send pictures or videos to your computer—select Setup new
device….

Ubuntu will open a window for new device setup. When you click For-
ward, Ubuntu will show you how many Bluetooth devices are present near
your computer. e list of available devices might take a minute or so to
appear on the screen as your system scans for these devices. Each device
will be displayed as soon as it is found by Ubuntu. Once a device you’d like
to connect with appears in the list, click on it. en, choose a  number
by selecting PIN options.

ree predefined  numbers are available, but you can also create a When you pair two Bluetooth devices, you are
letting each device trust the other one. After
you pair two devices, they will automatically
connect to each other in the future without
requiring a PIN.

custom . You will need to enter this  on the device you will be pairing
with Ubuntu.

Once the device has been paired, Ubuntu will open the “Setup com-
pleted” window. In Ubuntu, your computer is hidden by default for security
reasons. is means that your Ubuntu system can search other Bluetooth
devices, but others cannot find your Ubuntu system when they perform a
search on their own computer. If you would like to let another device find
your computer, you will have to explicitly allow your computer to be found.
To allow your computer to be found, select “Make computer discoverable”
in Bluetooth preferences. You can also click on the Bluetooth icon and
select Visible to make your computer discoverable.

You can also add a fancy name for your Bluetooth-enabled Ubuntu sys-
tem by changing the text under Friendly Name.

Another feature present in the Bluetooth icon menu is “Send files to
device.” Use this option to send a file to a mobile phone without pairing
with the computer. Android devices need to be paired at all times,

even while transferring files.





5 Software Management

Software management in Ubuntu

As discussed in Chapter : Working with Ubuntu, Ubuntu offers you a
wide range of applications for your daily work. Ubuntu comes with a basic
set of applications for common tasks like surfing the Internet, checking
your email, listening to music, and organizing your photos and videos.
Sometimes you may need an extra level of specialization: for example you
may want to retouch your photos, run some soware for your business,
or play some new games. In each of these cases you can search for an
application, install it and use it—usually, with no extra cost.

Figure 5.1: Software Center icon

Soware in Ubuntu is delivered as packages, simplifying the installa-

We recommend Ubuntu Software Center for
searching, installing and removing applications,
although you still have the possibility to use the
command-line application apt-get, or install
and use the advanced application Synaptic
Package Manager.

tion to one click. A package is a compressed file archive containing every-
thing needed to run the application. Packages can also contain information
describing which other applications, called dependencies or libraries, are
needed. Linux is designed in a way that any library can be updated without
having to reinstall the complete application, minimizing hard drive usage by
leing other applications use the same library.

Most other operating systems require a user to purchase commercial
soware (online or through a physical store), or search the Internet for a
free alternative (if one is available). e correct installation file must then
be verified for integrity, downloaded and located on the computer, followed
by the user proceeding through a number of installation prompts and op-
tions. By default Ubuntu gives you a centralized point with two different
ways to browse the repositories for searching, installing and removing so-
ware.

‣ Ubuntu Soware Center
‣ Command line apt-get

Searching, installing and/or removing applications with Ubuntu Soware
Center is the easiest and most comfortable way. It is recommended for all
kinds of users, starting from beginners to the most experienced.

Using the Ubuntu Software Center

ere are numerous ways to install soware on an operating system. In
Ubuntu, the quickest and easiest way to find and install new applications is
through the Ubuntu Soware Center.

To start the application, click on the Ubuntu Soware Center icon in the
launcher, or click on the Dash and search for Ubuntu Soware Center.

e Ubuntu Soware Center can be used to install applications that are
available in the official Ubuntu repositories. e Soware Center window
has two parts—a list of categories on the le, a banner at the top, and two
featured areas on the right. Clicking on a category will take you to a list
of related applications. For example, the Internet category contains Firefox
Web Browser. e featured areas highlight What’s New and Top Rated
soware. Each area shows different application icons. Just click an icon to
get more information on the application or to install it. To see all soware
the area contains, click More.
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Figure 5.2: You can install and remove applica-
tions from your computer using the Software
Center.

ree sections at the top represent your current view of the Soware
Center’s catalog. Click the All Soware buon to see soware that is avail-
able to install, click Installed to see a list of soware that is already installed
on your computer, or click History to see previous installations and dele-
tions organized by date.

Find your application

Ubuntu Soware Center displays different sources in the “Get Soware”
section. Clicking the arrow next to “All Soware” will show a list of in-
dividual sections. Selecting “Provided by Ubuntu” will show free official
soware, “For Purchase” will show soware for purchasing, and “Canonical
Partners” will show soware from partners of Canonical, such as Adobe.

If you are looking for an application, you may already know a specific
name (for example, VLC Media Player), or you may just have a general
category in mind (for example, the Sound and Video category includes a
number of different soware applications such as video converters, audio
editors, and music players).

To help you find the right application, you can browse the Soware
Center catalog by clicking on the category that reflects the type of soware
you are looking for, or use the Search field at the top right of the window to
look for specific names or keywords.

When you select a category, you will be shown a list of applications.
Some categories have sub-categories—for example, the Games category has
subcategories for Simulation and Card Games. To move through categories
you can use the back and forward buons at the top of the window.

Installing software

Once you have found an application you would like to try, installing it is
just one click away.

To install soware:
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. Click the Install buon to the right of the selected package to install it. If
you would like to read more about the soware package before installing
it, first click on “More Info.” is will take you to a short description of
the application, as well as a screenshot and a Web link when available.
Related add-ons will be listed below the application’s description. You
can click Install from this screen as well. In addition, if you use the You must have administrative privileges, and

you will need to be connected to the Internet
for the Software Center to work. To learn how
to set up your Internet connection, see Getting
online.

Gwibber micro-blogging application, you can hit the “Share…” link below
the description of an application to tell your friends about it.

. Aer clicking Install, enter your password into the authentication win-
dow that appears. is is the same password you use to log in to your
account. You are required to enter it whenever installing or removing
soware in order to prevent someone without administrator access
from making unauthorized changes to your computer. If you receive an
Authentication Failure message aer typing in your password, check
that you typed it correctly by trying again. If the error continues, this
may mean that your account is not authorized to install soware on the
computer.

. Wait until the package is finished installing. During the installation
(or removal) of programs, you will see an animated icon of rotating
arrows to the le of the In Progress buon in the sidebar. If you like, you
can now go back to the main browsing window and choose additional
soware packages to be installed by following the steps above. At any
time, clicking the Progress buon on the top will take you to a summary
of all operations that are currently processing. Here you can also click
the X icon to cancel any operation.

Once the Soware Center has finished installing an application, it is ready
to be used. You can start the newly installed application by going to the
Dash and typing the name of the application in the search bar. You may
want to add the application to the Launcher.

Removing software

Removing applications is very similar to installing them. First find the in-
stalled soware in Ubuntu Soware Center. You can click on the Installed
buon which will show all the installed soware listed in different cate-
gories. Scroll down to the application you wish to remove. If you click on
the arrow next to Installed buon, you will find a list of soware providers,
which can help you to narrow your search. You also can enter keywords in
the Search field to quickly find installed soware, or you can search by date
in the History tab (more on History below).

To remove soware:

. Click the Remove buon to the right of the selected application.
. Enter your password into the authentication window that appears. Re-

moving Soware also requires that you enter your password to help
protect your computer against unauthorized changes. e package will
then be queued for removal, and will appear under the progress section
in the top.

Removing a package will also update your menus accordingly.
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Software history

e Ubuntu Soware Center keeps track of past soware management
in the History section. is is useful if you wish to revert installations or
removals and do not remember the application’s name.

ere are four buons in the history section—All Changes, Installations,
Updates and Removals. Clicking one will show a list of days that action
occurred. If you click the arrow next to a day, a list of individual packages
will be shown, along with what was done with them and at what time. e
History section shows all soware installation history, not just changes
made within the Soware Center. For example, packages updated through
the Update Manager will also be listed.

Managing additional software

Although the Ubuntu Soware Center provides a large library of appli-
cations to choose from, initially only those packages available within the
official Ubuntu repositories are listed. At times, you may be interested in a
particular application that is not available in these repositories. If this hap-
pens, it is important to understand some alternative methods for accessing
and installing soware in Ubuntu, such as downloading an installation file
manually from the Internet, or adding extra repositories. First, we will look
at how to manage your repositories through Soware Sources.

Software Sources

e Ubuntu Soware Center lists only those applications that are available
in your enabled repositories. Repositories can be added or removed through
the Soware Sources application. To open this, click on the Dash and enter You can also open Software Sources from the

Ubuntu Software Center. Simply go to Edit ‣
Software Sources.

Software Sources. en open the application from the results shown.

Managing the official repositories

When you open Soware Sources, it shows you the Ubuntu Soware tab
where the first four options are enabled by default. The Ubuntu Software tab lists the official

Ubuntu repositories, each containing different
types of packages.Canonical-supported open source soware (main) is repository contains

all the open-source packages that are maintained by Canonical.
Community-maintained open source soware (universe) is repository

contains all the open-source packages that are developed and maintained
by the Ubuntu community.

Proprietary drivers for devices (restricted) is repository contains propri-
etary drivers, which may be required to utilize the full capabilities of
some of your devices or hardware.

Closed-source packages are sometimes
referred to as non-free. This is a reference to
freedom of speech, rather than monetary cost.
Payment is not required to use these packages.

Soware restricted by copyright or legal issues (multiverse) is repository
contains soware that may be protected from use in some states or
countries by copyright or licensing laws. By using this repository you
assume responsibility for the usage of any packages that you install.

Source code is repository contains the source code that is used to build
the soware packages from some of the other repositories. e Source Building applications from source is an ad-

vanced process for creating packages, and
usually only concerns developers. You may
also require source files when using a custom
kernel, or if trying to use the latest version of
an application before it is released for Ubuntu.
As this is a more advanced area, it will not be
covered in this manual.

code option should not be selected unless you have experience with
building applications from source.
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Selecting the best software server

Ubuntu provides and allows many servers around the world to mirror the
packages from the sources listed under “Managing the official repositories.” Ubuntu grants permission to many servers all

across the world to act asmirrors. That is, they
host an exact copy of all the files contained in
the official Ubuntu repositories.

When selecting a server, you may want to consider the following:

Distance to server. is will affect the speed you can achieve with the file
server.

Internet Service Provider. Some Internet service providers offer cheaper, or
even unlimited free downloads from their own servers.

ality of server. Some servers may only offer downloads at a capped
speed, limiting the rate at which you can install and update soware on
your computer.

Ubuntu will automatically choose an appropriate server while installing,
and as such these seings should not be changed unless your physical
location changes drastically or if you feel a higher speed should be achieved
by your Internet connection. e guide below will help in choosing an
optimal server.

Ubuntu provides a tool for selecting the server that provides the fastest
connection with your computer.

. Click the dropdown box next to “Download from:” in the Soware
Sources window.

. Select “Other…” from the list.
. In the “Server Selection” window that appears. Click the Select Best

Server buon in the upper right. Your computer will now aempt a
connection with all the available servers, then select the one with the
fastest speed.

If you are happy with the automatic selection, click Choose Server to
return to the Soware Sources window.

If you are not happy with the automatic selection or prefer not to use
the tool, the fastest server is oen the closest server to you geographically.
In this case simply choose “Other” then find the nearest location to your
computer. When you are happy with the seings chosen click Choose
Server to return to the Soware Sources window.

If you do not have a working Internet connection, updates and programs
can be installed from the installation media itself by inserting your media
and clicking the box under “Installable from /.” Once this box is
checked the media within the/ drive will function as an online
repository and as such the soware on the media will be installable from
the Ubuntu Soware Center.

Adding more software repositories

Ubuntu makes it easy to add additional, third-party repositories to your A PPA is a Personal Package Archive. These
are online repositories used to host the latest
versions of software packages, digital projects,
and other applications.

list of soware sources. e most common repositories added to Ubuntu
are called s. ese allow you to install soware packages that are not
available in the official repositories, and automatically be notified whenever
updates for these packages are available.

If you know the web address of a ’s Launchpad site, adding it to your
list of soware sources is relatively simple. To do so, you will need to use
the Other Soware tab in the “Soware Sources” window.

On the Launchpad site for a , you will see a heading to the le called
“Adding this PPA to your system.” Underneath will be a short paragraph
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containing a unique  in the form of ppa:test-ppa/example. Highlight this
 by selecting it with your mouse, then right-click and select Copy.

Figure 5.3: This is an example of the Launchpad
page for the Lifesaver PPA. Lifesaver is an
application that is not available in the official
Ubuntu repositories. However, by adding
this PPA to your list of software sources, it
would then be easy to install and update this
application through the Software Center.

Return to the “Soware Sources” window, and in the Other Soware tab
click Add… at the boom. A new window will appear, and you will see the
words “Apt line:” followed by a text field. Right-click on the empty space in
this text field and select Paste, and you should see the  appear that you
copied from the s Launchpad site earlier. Click Add Source to return to
the “Soware Sources” window. You will see a new entry has been added
to the list of sources in this window, with a selected check box in front
meaning it is enabled.

If you click Close in the boom right corner of this window, a message
will appear informing you that “e information about available soware
is out-of-date.” is is because you have just added a new repository to
Ubuntu, and it now needs to connect to that repository and download a
list of the packages that it provides. Click Reload, and wait while Ubuntu
refreshes all of your enabled repositories (including this new one you just
added). When it has finished, the window will close automatically.

Congratulations, you have just added a  to your list of soware
sources. You can now open the Soware Center and install applications
from this , in the same way you previously installed applications from
the default Ubuntu repositories.

Manual software installation

Although Ubuntu has extensive soware available, on some occasions you
may want to manually install soware packages that are not available in the
repositories. If there is not a  for the soware, you will need to install it
manually. Before you choose to do so, make sure you trust the package and
its maintainer.

Packages in Ubuntu have a .deb extension. Double-clicking a package

ppa:test-ppa/example


  

will open an overview page in the Soware Center, which will give you
more information about that package.

e overview gives some technical information about that package, a
website link (if applicable) and the option to install. Clicking Install will
install the package just like any other installation in the Soware Center.

Updates and upgrades

Ubuntu also allows you to decide how to manage package updates through
the Updates tab in the Soware Sources window.

Ubuntu updates

In this section, you are able to specify the kinds of updates you wish to
install on your system, and usually depends on your preferences around
stability, versus having access to the latest developments.

Important security updates ese updates are highly recommended to
ensure your system remains as secure as possible. ese are enabled by
default.

Recommended updates ese updates are not as important for keeping your
system secure, but will mean your packages always have the most recent
bug fixes or minor updates that have been tested and approved. is
option is also enabled by default.

Pre-released updates is option is for those who would rather remain
up-to-date with the very latest releases of applications, at the risk of in-
stalling an update that has unresolved bugs or conflicts. Note that it is
possible that you will encounter problems with these updated applica-
tions, therefore this option is not enabled by default.

Unsupported updates ese are updates that have not yet been fully tested
and reviewed by Canonical. Some bugs may occur when using these
updates, and so this option is also not enabled by default.

Automatic updates

e middle section of this window allows you to customize how your sys-
tem manages updates, such as the frequency with which it checks for new
packages, as well as whether it should install important updates right away
(without asking for your permission), download them only, or just notify
you about them.

Release upgrade

Here you can decide which system upgrades you would like to be notified Every 6 months, Canonical will release a new
version of the Ubuntu operating system. These
are called normal releases. Every four normal
releases—or 24 months—Canonical releases
a long-term support (LTS) release. Long-term
support releases are intended to be the most
stable releases available, and are supported for
a longer period of time.

about.

Never Choose this if you would rather not be notified about any new
Ubuntu releases.

Normal releases Choose this if you always want to have the latest Ubuntu
release, regardless of whether it is a Long Term Support release or not.
is option is recommended for normal home users.

Long Term Support releases only Choose this option if you need a release
that will be more stable and have support for a longer time. If you use
Ubuntu for business purposes, you may want to consider selecting this
option.





6 Advanced Topics

Ubuntu for advanced users

By now, we hope you understand how using Ubuntu can make your com-
puting experience easier, safer, and more efficient. So far, we’ve provided
detailed instructions on geing the most from Ubuntu’s basic features. In
this chapter, we’ll detail some of Ubuntu’s more advanced features—like
the terminal, a powerful utility that can help you accomplish tasks without
the need for a graphical user interface (). We’ll also discuss some ad-
vanced security measures you can implement to make your computer even
safer. We’ve wrien this chapter with advanced users in mind. If you’re
new to Ubuntu, don’t feel as though you’ll need to master these topics to
get the most out of your new soware (you can quite easily skip to the next
chapter without consequence). However, if you’re looking to expand your
knowledge of Ubuntu, we encourage you to keep reading.

Introduction to the terminal

roughout this manual, we have focused primarily on the graphical desk-
top user interface. However, in order to fully realize the power of Ubuntu,
you may want to learn how to use the terminal.

What is the terminal?

Most operating systems, including Ubuntu, have two types of user in-
terfaces. e first is a graphical user interface (). is is the desktop,
windows, menus, and toolbars that you click to get things done. e second,
and much older, type of interface is the command-line interface ().

e terminal is Ubuntu’s command-line interface. It is a method of
controlling some aspects of Ubuntu using only commands that you type on
the keyboard.

Why would I want to use the terminal?

You can perform most day-to-day activities without ever needing to open
the terminal. However, the terminal is a powerful and invaluable tool that
can be used to perform many useful tasks you might not be able to accom-
plish with a . For example:

‣ Troubleshooting any difficulties that may arise when using Ubuntu
sometimes requires you to use the terminal.

‣ A command-line interface is sometimes a faster way to accomplish a
task. For example, it is oen easier to perform operations on many files
at once using the terminal.

‣ Learning the command-line interface is the first step towards more
advanced troubleshooting, system administration, and soware develop-
ment skills. If you are interested in becoming a developer or an advanced
Ubuntu user, knowledge of the command-line will be essential.
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Opening the Terminal

You can open the terminal by clicking Dash ‣Applications ‣Terminal. The terminal gives you access to what is called a
shell. When you type a command in the terminal
the shell interprets this command, resulting
in the desired action. Different types of shells
accept slightly different commands. The most
popular is called “bash,” and is the default shell
in Ubuntu.

When the terminal window opens, it will be largely blank apart from
some text at the top le of the screen, followed by a blinking block. is
text is your prompt—it displays your login name and your computer’s
name, followed by the current directory. e tilde (~) means that the current

In GUI environments the term “folder” is
commonly used to describe a place where
files are stored. In CLI environments the
term “directory” is used to describe the same
thing and this metaphor is exposed in many
commands (i.e., cd or pwd) throughout this
chapter.

directory is your home directory. Finally, the blinking block is the cursor
—this marks where text will be entered as you type.

To test a terminal command, type pwd and press Enter. e terminal
should display /home/yourusername. is text is called the “output.” You
have just used the pwd (print working directory) command, which outputs
(displays) the current directory.

Figure 6.1: The default terminal window allows
you to run hundreds of useful commands.

All commands in the terminal follow the same approach: Type a com-
mand, possibly followed by some parameters, and press Enter to perform
the specified action. Oen some output will be displayed that confirms the Parameters are extra segments of text,

usually added at the end of a command, that
change how the command itself is interpreted.
These usually take the form of -h or --
help, for example. In fact, --help can be
added to most commands to display a short
description of the command, as well as a list
of any other parameters that can be used with
that command.

action was completed successfully, although this depends on the command.
For example, using the cd command to change your current directory (see
below) will change the prompt, but will not display any output.

e rest of this chapter covers some very common uses of the terminal.
However, it cannot address the nearly infinite possibilities available to
you when using the command-line interface in Ubuntu. roughout the
second part of this manual, we will continue to refer to the command line,
particularly when discussing steps involved in troubleshooting and the
more advanced management of your computer.

Ubuntu file system structure

Ubuntu uses the Linux file system, which is based on a series of folders in
the root directory. Each of these folders contains important system files that
cannot be modified unless you are running as the root user or use sudo. is
restriction exists for both security and safety reasons: computer viruses will
not be able to change the core system files, and ordinary users should not be
able to accidentally damage anything vital.

Below are some of the most important directories.
e root directory—denoted by /—contains all other directories and files.

Here are the contents of some essential system directories:

/bin & /sbin Many essential system applications (equivalent to C:\Windows)
/etc System-wide configuration files
/home Each user will have a subdirectory to store personal files (for exam-

ple /home/your-username, equivalent to C:\Users or C:\Documents and
Settings)
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Figure 6.2: Some of the most important
directories in the root file system.

/lib Library files, similar to .dll files on Windows
/media Removable media ( and  drives) will be mounted in this

directory
/root is contains the root user’s files (not to be confused with the root

directory)
/usr Pronounced “user,” it contains most program files (not to be confused

with each user’s home directory, equivalent to C:\Program Files)
/var/log Contains log files wrien by many applications

Every directory has a path. e path is a directory’s full name—it de-
scribes a way to navigate the directory from anywhere in the system.

For example, the directory /home/your-username/Desktop contains
all the files that are on your Ubuntu desktop. e path, /home/your-
username/Desktop, can be broken down into a few pieces:

. /—indicates that the path starts at the root directory
. home/—from the root directory, the path goes into the home directory
. your-username/—from the home directory, the path goes into the your-

username directory
. Desktop—from the your-username directory, the path ends up in the

Desktop directory

Every directory in Ubuntu has a complete path that starts with the / (the
root directory) and ends in the directory’s own name.

Directories and files that begin with a period are hidden directories.
ese are usually only visible with a special command or by selecting a
specific option. In the Nautilus you can show hidden files and directories by
selecting View ‣ Show Hidden Files, or by pressing Ctrl+H. ere are many
hidden directories in your home folder used to store program preferences.
For example, /home/your-username/.evolution stores preferences used by
the Evolution mail application.

Mounting and unmounting removable devices

Any time you add storage media to your computer—an internal or external
hard drive, a  flash drive, a —it needs to be mounted before it is
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accessible. Mounting a device means to associate a directory name with the
device, allowing you to navigate to the directory to access the device’s files.

When a device such as a  flash drive or a media player is mounted in
Ubuntu, a folder is automatically created for it in the media directory and
you are given the appropriate permissions to be able to read and write to
the device.

Most file managers will automatically add a shortcut to the mounted
device in the side bar of your home folder, so the device is easy for you to
access. You shouldn’t have to physically navigate to the media directory in
Ubuntu, unless you choose to do so from the command line.

When you’ve finished using a device, you can unmount it. Unmounting a
device disassociates the device from its directory, allowing you to eject it.

Securing Ubuntu

Now that you know a bit more about using the command line, we can use it
to make your computer more secure. e following sections discuss various
security concepts, along with procedures for keeping your Ubuntu running
smoothly, safely, and securely.

Why Ubuntu is safe

Ubuntu is secure by default for a number of reasons:

‣ Ubuntu clearly distinguishes between normal users and administrative
users.

‣ Soware for Ubuntu is kept in a secure online repository, which contains
no false or malicious soware.

‣ Open-source soware like Ubuntu allows security flaws to be easily
detected.

‣ Security patches for open-source soware like Ubuntu are oen released
quickly.

‣ Many viruses designed to primarily target Windows-based systems do
not affect Ubuntu systems.

Basic security concepts

e following sections discuss basic security concepts—like file permissions,
passwords, and user accounts. Understanding these concepts will help you
follow the remaining procedures for securing your computer.

Permissions

In Ubuntu, files and folders can be set up so that only specific users can
view, modify, or run them. For instance, you might wish to share an impor-
tant file with other users, but do not want those users to be able to edit the
file. Ubuntu controls access to files on your computer through a system of
“permissions.” Permissions are seings that you can configure to control
exactly how files on your computer are accessed and used.

To learn more about modifying permissions, visit https://help.ubuntu.
com/community/FilePermissions.

https://help.ubuntu.com/community/FilePermissions
https://help.ubuntu.com/community/FilePermissions
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Passwords

You should use a strong password to increase the security of your com-
puter. Your password should not contain names, common words or com-
mon phrases. By default, the minimum length of a password in Ubuntu is
four characters. We recommend a password with more than the minimum
number of characters. A password with a minimum of eight characters
which includes both upper and lower case leers, numbers and symbols is
considered strong.

Locking the screen

When you leave your computer unaended, you may want to lock the
screen. Locking your screen prevents anyone from using your computer
until your password is entered. To lock the screen:

‣ Click the session menu icon in the right corner of the top panel, then
select Lo Screen, or

‣ press Ctrl+Alt+L to lock the screen. is keyboard shortcut can be
changed in Dash ‣Applications ‣Keyboard Shortcuts

User accounts

Users and groups

When Ubuntu is installed, it is automatically configured for a single person
to use. If more than one person will use the computer with Ubuntu, each
person should have her or his own user account. is way, each user can
have separate seings, documents, and other files. If necessary, you can also
protect files from being viewed or modified by users without administrative
privileges.

Like most operating systems, Ubuntu allows you to create separate user
accounts for each person that uses the computer. Ubuntu also supports user
groups, which allow you to administer permissions for multiple users at the
same time.

Every user in Ubuntu is a member of at least one group—the group’s
name is the same as the name of the user. A user can also be a member of
additional groups. You can configure some files and folders to be accessible
only by a user and a group. By default, a user’s files are only accessible by
that user; system files are only accessible by the root user.

Figure 6.3: Add, remove and change the user
accounts.
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Managing users

You can manage users and groups using the Users and Groups administra-
tion application. To find this application, click Session Indicator ‣ Systems
and Settings ‣User Accounts.

To adjust the user and group seings, first select the user that you want
to modify from the list. en click “Change…” next to the element that you
want to make changes to. You will need to input your password in order to
make changes to user and group seings.

Adding a user Click the Add buon which appears underneath a list of
the current user accounts that have already been created. A window will
appear that has two fields. e Name field field is for a friendly display
name. e Username field is for the actual username. Fill in the requested
information, then click OK. A new dialog box will appear asking you to
enter a password for the user you have just created. Fill out the fields, then
click OK. Privileges you grant to the new user can be altered in “Users
Seings”.

Modifying a user Click on the name of a user in the list of users, then click
on the Change… buon, which appears next to each of following options:

‣ Account type:
‣ Password:

For more advanced user options click on the Advanced Settings buon.
Change the details as required in the dialog that appears. Click OK to save
the changes.

Deleting a user Select a user from the list and click Delete. Ubuntu will
deactivate the user’s account, and you can choose whether remove the
user’s home folder or leave it.

Managing groups

Click on the Manage Groups buon to open the group management dialog.

Adding a group To add a group, click Add. In the dialog that appears,
enter the group name and select the names of users you would like to add to
the group.

Modifying a group To alter the users in an existing group, select a group
and click on the Properties buon. Select and deselect the users as required,
then click OK to apply the changes.

Deleting a group To delete a group, select a group and click Delete.

Applying groups to files and folders

To change the group associated with a file or folder, open the Nautilus file
browser and navigate to the appropriate file or folder. en, either select
the folder and choose File ‣ Properties from the menubar, or right-click on
the file or folder and select Properties. In the Properties dialog that appears,
click on the Permissions tab and select the desired group from the Groups
drop-down list. en close the window.
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Using the command line

You can also modify user and group seings via the command line. We
recommend that you use the graphical method above unless you have a
good reason to use the command line. For more information on using the
command line to modify users and groups, see the Ubuntu Server Guide at
hps://help.ubuntu.com/./serverguide/C/user-management.html

System updates

Good security depends on an up-to-date system. Ubuntu provides free
soware and security updates. You should apply these updates regularly.
See Updates and upgrades to learn how to update your Ubuntu computer
with the latest security updates and patches.

Trusting third party sources

Normally, you will add applications to your computer via the Soware Cen-
ter, which downloads soware from the Ubuntu repositories as described
in Chapter : Soware Management. However, it is occasionally necessary
to add soware from other sources. For example, you may need to do this
when an application is not available in the Ubuntu repositories, or when
you need a newer version of the one available in the Ubuntu repositories.

Additional repositories are available from sites such as getdeb.net and
Launchpad s, which can be added as described in Soware Sources. You
can download the  packages for some applications from their respective
project sites on the Internet. Alternately, you can build applications from
their source code (an advanced method of installing and using applications).

Using only recognized sources such as a project’s site, , or various
community repositories (such as getdeb.net) is more secure than down-
loading applications from an arbitrary (and perhaps less reputable) source.
When using a third party source, consider its trustworthiness, and be sure
you know exactly what you’re installing on your computer.

Firewall

A firewall is an application that protects your computer against unautho-
rized access by people on the Internet or your local network. Firewalls
block connections to your computer from unknown sources. is helps
prevent security breaches.

Uncomplicated Firewall () is the standard firewall configuration
program in Ubuntu. It is a program that runs from the command line, but
a program called Gufw allows you to use it with a graphical interface. See
Chapter : Soware Management to learn more about installing the Gufw
package.

Once it’s installed, start Gufw by clicking Dash ‣Applications ‣ Firewall
configuration. To enable the firewall, select the Enable option. By default,
all incoming connections are denied. is seing should be suitable for
most users.

If you are running server soware on your Ubuntu system (such as a
web server, or an  server), then you will need to open the ports these
services use. If you are not familiar with servers, you will likely not need to
open any additional ports.

https://help.ubuntu.com/11.10/serverguide/C/user-management.html
http://getdeb.net
http://getdeb.net
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To open a port click on the Add buon. For most purposes, the Precon-
figured tab is sufficient. Select Allow from the first box and then select the
program or service required.

e simple tab can be used to allow access on a single port, and the
Advanced tab can be used to allow access on a range of ports.

Encryption

You may wish to protect your sensitive personal data—for instance, finan-
cial records—by encrypting it. Encrypting a file or folder essentially “locks”
that file or folder by encoding it with an algorithm that keeps it scrambled
until it is properly decoded with a password. Encrypting your personal data
ensures that no one can open your personal folders or read your private
data without your private key.

Ubuntu includes a number of tools to encrypt files and folders. is
chapter will discuss two of these. For further information on using en-
cryption with either single files or email, see Ubuntu Community Help
documents at hps://help.ubuntu.com/community.

Home folder

When installing Ubuntu, it is possible to encrypt a user’s home folder. See
Chapter : Installation for more on encrypting the home folder.

Private folder

If you have not chosen to encrypt a user’s entire home folder, it is possible
to encrypt a single folder—called Private—in a user’s home folder. To do
this, follow these steps:

. Install the ecryptfs-utils soware package from the Ubuntu Soware
Center. (For more information about the Soware Center, review Using
the Ubuntu Soware Center.)

. Use the terminal to run ecryptfs-setup-private to set up the private
folder.

. Enter your account’s password when prompted.
. Either choose a mount passphrase or generate one.
. Record both passphrases in a safe location. ese are required if you ever

have to recover your data manually.
. Log out and log back in to mount the encrypted folder.

Aer the Private folder has been set up, any files or folders in it will
automatically be encrypted.

If you need to recover your encrypted files manually see https://help.
ubuntu.com/community/EncryptedPrivateDirectory.

https://help.ubuntu.com/community
https://help.ubuntu.com/community/EncryptedPrivateDirectory
https://help.ubuntu.com/community/EncryptedPrivateDirectory


7 Troubleshooting

Resolving problems

Sometimes, things may not work as they should. Luckily, problems that
are encountered while working with Ubuntu are oen easily fixed. Below,
we offer a guide for resolving the basic problems that users may encounter
while using Ubuntu. If you need any additional help beyond what this
chapter provides, take a look at other support options that are discussed in
Finding additional help and support later in this book.

Troubleshooting guide

e key to an effective troubleshooting is to work slowly, complete all
of troubleshooting steps, and to document the changes that you make to
Ubuntu. is way, you will be able to undo your work, or give fellow users
the information about your previous aempts in cases when you need to
turn to the community for support.

Ubuntu fails to start after I’ve installed Windows

Occasionally you may install Ubuntu and then decide to install Microso
Windows as a second operating system running side-by-side with Ubuntu.
is is supported by Ubuntu, but you might also find that aer installing
Windows you will no longer be able to start Ubuntu.

When you first turn on your computer, a “bootloader” must start Ubuntu
or another operating system. When you installed Ubuntu, you installed an A bootloader is the initial software that loads

the operating system when you switch on the
computer.

advanced bootloader called  which allows you to choose between the
various operating systems on your computer, such as Ubuntu, Windows,
Solaris or Mac OS X. However, when you installed Windows, it replaced the
 with its own bootloader, thus removing the ability to choose which
operating system you’d like to use. You can restore  and regain the
ability to choose your operating system by using the same  you used to
install Ubuntu.

First, insert your Ubuntu  into your computer and then restart it,
making sure to have your computer start from the  (see Chapter : Instal-
lation). Next, choose your language (e.g., English) and select Try Ubuntu.
Once Ubuntu starts, click on the top-most icon in the launcher (the Dash
icon). en, search for Terminal using the search box and then select Ter-
minal in the search results. A window should open with a blinking prompt
line. Enter the following, and press Enter:

$ sudo fdisk -l

Disk /dev/hda: 120.0 GB, 120034123776 bytes
255 heads, 63 sectors/track, 14593 cylinders
Units = cylinders of 16065 * 512 = 8225280 bytes

Device Boot Start End Blocks Id System
/dev/sda1 1 1224 64228+ 83 Linux
/dev/sda2 * 1225 2440 9767520 a5 Windows
/dev/sda3 2441 14593 97618972+ 5 Extended
/dev/sda4 14532 14593 498015 82 Linux swap
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Partition table entries are not in disk order

The device (/dev/sda1, /dev/sda2, etc) we are
looking for is identified by the word “Linux” in
the System column. Modify the instructions
below if necessary, replacing /dev/sda1 with
the name of your Linux device.

is output shows that your system (Linux, on which Ubuntu is based)
is installed on device /dev/sda, but your computer is booting to /dev/sda
(where Windows is located). We need to fix this by telling the computer to
boot to the Linux device instead.

To do this, first create a place to connect your existing existing Ubuntu
installation with your temporary troubleshooting session:

$ sudo mkdir /media/root

Next, link your Ubuntu installation and this new folder:

$ sudo mount /dev/sda1 /media/root

If you’ve done this correctly, then you should see the following:

$ ls /media/root
bin dev home lib mnt root srv usr
boot etc initrd lib64 opt sbin sys var
cdrom initrd.img media proc selinux tmp vmlinuz

Now, you can reinstall :

$ sudo grub-install --root-directory=/media/root /dev/sda
Installation finished. No error reported.
This is the contents of the device map /boot/grub/device.map.
Check if this is correct or not. If any of the lines is incorrect,
fix it and re-run the script grub-install.
(hd0) /dev/sda

Finally, remove the Ubuntu disc from your  drive, reboot your
computer, and then start enjoying your Ubuntu operating system once
again.

is guide may not work for all Ubuntu users due to differences in the
various system configuration. Still, this is the recommended and most
successful method for restoring the  bootloader. If you are following
this guide and if it does not restore  on your computer, then try the
other troubleshooting methods at https://help.ubuntu.com/community/
RecoveringUbuntuAfterInstallingWindows.

Ubuntu doesn’t present the login screen when my computer boots

e simplest and easiest way to correct this issue is to reset the graphics
configuration. Press and hold Ctrl+Alt+F1. You should now see a black and
white screen with a prompt for your username and password.

(Characterswill not appear on the screen as you
enter your password. This behavior is normal
and was implemented for security purposes).

Enter your username, and press Enter. en, enter your password and
press Enter. Next, enter the following commands, pressing Enter aer each
line. You will be asked for your password again.

$ sudo cd /etc/X11
$ sudo mv ./xorg.conf ./xorg.conf_old
$ sudo service gdm stop
$ sudo X -configure
$ sudo mv ./xorg.conf.new ./xorg.conf
$ sudo reboot now

Now Ubuntu will reboot, and your login screen should be restored.

https://help.ubuntu.com/community/RecoveringUbuntuAfterInstallingWindows
https://help.ubuntu.com/community/RecoveringUbuntuAfterInstallingWindows
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I forgot my password

If you forget your password in Ubuntu, you will need to reset it using the
“Recovery mode.”

To start the Recovery mode, shut down your computer and then start
again. As the computer starts up, press Shift. Select the Recovery mode
option using the arrow keys on your keyboard. Recovery mode should be
the second item in the list.

Figure 7.1: This is the grub screen in which you
can choose recovery mode.

Wait until Ubuntu starts up—this may take a few minutes. Once booted,
you will not be able to see a normal login screen. Instead, you will be pre-
sented with the Recovery Menu. Select root using the arrow keys and press
Enter.

You will now be at a terminal prompt:

root@ubuntu:~#

To reset your password, enter:

# passwd username

Replace “username” above with your username, aer which Ubuntu will
prompt you for a new password. Enter your desired password and press the
Enter key and then re-type your password again, and press Enter. (Ubuntu
asks for your password twice to make sure you did not make a mistake
while typing). Once you have restored your password, return to the normal
system environment by entering:

# init 2

Login as usual and continue enjoying Ubuntu.

I accidentally deleted some files that I need

If you’ve deleted a file by accident, you may be able to recover it from
Ubuntu’s trash folder. is is a special folder where Ubuntu stores deleted
files before they are permanently removed from your computer.

To access the trash folder click on the Trash icon at the boom of the
Unity Launcher.

If you want to restore deleted items from the trash:

. Open Trash
. Click on each item you want to restore to select it. Press and hold Ctrl

to select multiple items.
. Click Restore Selected Items to move the deleted items back to their

original locations.

How do I clean Ubuntu?

Over time, Ubuntu’s soware packaging system can accumulate unused
packages and temporary files. ese temporary files, also called caches,
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contain files from all of the packages that you have installed. Over time this
cache can grow quite large. Cleaning out the cache allows you to reclaim
space on your computer’s hard drive for storing your documents, music,
photographs, or other files.

To clear the cache, you can either use the clean, or the autoclean option
for the command-line program apt-get.

The clean command will remove every
single cached item, while the autoclean
command only removes cached items that can
no longer be downloaded (these items are
often unnecessary).

To run clean, open Terminal and enter:

$ sudo apt-get clean

Packages can also become unused over time. If a package was installed to
assist with running another program—and that program was subsequently
removed you no longer need the supporting package. You can remove it
with apt-get autoremove.

Load Terminal and enter:

$ sudo apt-get autoremove

I can’t play certain audio or video files

Many of the formats used to deliver rich media content are proprietary,
meaning they are not free to use, modify, or distribute with an open-source
operating system like Ubuntu. erefore, Ubuntu does not include the ca-
pability to use these formats by default; however, users can easily configure
Ubuntu to use these proprietary formats. For more information about the
differences between open source and proprietary soware, see Chapter :
Learning More.

If you find yourself in need of a proprietary format, you may install
the files necessary for using this format from the Ubuntu Soware Center.
Ensure that you have Universe and Multiverse repositories enabled before
continuing. See the Soware Sources section to learn how to do this. When
you are ready to continue, install the necessary soware as follows:

. Open the Ubuntu Soware Center by searching for it from the Dash (the
top-most buon on the Launcher).

. Search for ubuntu-restricted-extras by typing “Ubuntu restricted
extras” in the search box on the right-hand side of the Ubuntu Soware
Center main window. When the Soware Center finds the appropriate
soware, click the arrow next to its title.

. Click Install, then wait while Ubuntu installs the soware.

One program that can play many of these formats is VLC media player.
It can be installed from the Ubuntu Soware Center. Once Ubuntu has
successfully installed this soware, your rich media content should work
properly.

How can I change my screen resolution?

e image on every monitor is composed of millions of lile colored dots
called pixels. Changing the number of pixels displayed on your monitor is
called “changing the resolution.” Increasing the resolution will make the
displayed images sharper, but will also tend to make them smaller. e
opposite is true when screen resolution is decreased. Most monitors have
a “native resolution,” which is a resolution that most closely matches the
number of pixels in the monitor. Your display will usually be sharpest when
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your operating system uses a resolution that matches your display’s native
resolution.

e Ubuntu configuration utility Displays allows users to change the
resolution. Open it by clicking on the session indicator and then on Dis-
plays…. e resolution can be changed using the drop-down list within
the program. Picking options higher up on the list (for example, those with
larger numbers) will increase the resolution.

Figure 7.2: You can change your display
settings.

You can experiment with various resolutions by clicking Apply at the
boom of the window until you find one that is comfortable for you. Typ-
ically the highest resolution will be the native resolution. Selecting a res-
olution and clicking Apply will temporarily change the screen resolution
to the selected value and a dialog box will also be displayed. It allows you
to revert to the previous resolution seing or keep the new resolution. e
dialog box will disappear in  seconds, restoring the old resolution.

Figure 7.3: You can revert back to your old
settings if you need to.

is feature was implemented to prevent someone from being locked
out of the computer by a resolution that distorts the monitor and makes it
unusable. When you have finished seing the screen resolution, click Close.

Ubuntu is not working properly on my Apple MacBook or MacBook Pro

When installed on notebook computers from Apple—such as the MacBook
or MacBook Pro—Ubuntu does not always enable all of the computer’s
built-in components, including the iSight camera and the Airport wireless
Internet adapter. Luckily, the Ubuntu community offers documentation
on fixing these and other problems. If you are having trouble installing or
using Ubuntu on your Apple notebook computer, please follow the instruc-
tions at https://help.ubuntu.com/community/MacBook. You can select the
appropriate guide aer identifying your computer’s model number. For
instructions on doing this, visit the web page above.

Ubuntu is not working properly on my Asus EeePC

When installed on netbook computers from Asus—such as the EeePC—
Ubuntu does not always enable all of the computer’s built-in components,

https://help.ubuntu.com/community/MacBook
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including the keyboard shortcut keys and the wireless Internet adapter.
e Ubuntu community offers documentation on enabling these com-
ponents and fixing other problems. If you are having trouble installing
or using Ubuntu on your Asus EeePC, please follow the instructions at
https://help.ubuntu.com/community/EeePC. is documentation page con-
tains information pertaining specifically to EeePC netbooks.

To enable many of the features and Function Keys, a quick fix is to add
‘acpi_osi=Linux’ to your grub configuration. From the Terminal

$ gksudo gedit /etc/default/grub

and very carefully change the line

GRUB_CMDLINE_LINUX_DEFAULT="quiet splash"

to

GRUB_CMDLINE_LINUX_DEFAULT="quiet splash acpi_osi=Linux"

Save and close the file. en, from the terminal:

sudo update-grub

Aer the command finishes, and you restart the computer, you will be able
to use the Fn Keys normally.

My hardware is not working properly

Ubuntu occasionally has difficulties running on certain computers, gen-
erally when hardware manufacturers use non-standard or proprietary
components. e Ubuntu community offers documentation to help you
troubleshoot many common issues that may arise from this situation, in-
cluding problems with wireless cards, scanners, mouse and printers. You
can find the complete hardware troubleshooting guide on Ubuntu’s sup-
port wiki, accessible at https://wiki.ubuntu.com/HardwareSupport. If your
hardware problems persist, please see Geing more help for more trou-
bleshooting options or information on obtaining support or assistance from
an Ubuntu user.

Getting more help

is guide does not cover every possible workflow, task or issue in Ubuntu.
If you require assistance beyond the information in the manual, you can
find a variety of support opportunities online.

More details about many support options available to you can be found
at Finding additional help and support later in this book.

https://help.ubuntu.com/community/EeePC
https://wiki.ubuntu.com/HardwareSupport


8 Learning More

What else can I do with Ubuntu?

By now, you should be able to use Ubuntu for most of your daily activities
—such as browsing the web, sending email, and creating documents. But
you may be interested in learning about other versions of Ubuntu you
can integrate into your digital lifestyle. In this chapter, we’ll introduce
you to additional versions of Ubuntu specialized for certain tasks. We’ll
also provide you with resources for answering any remaining questions
you may have, and tell you how you can get involved in the worldwide
community of Ubuntu users. But first, we’ll discuss the technologies that
make Ubuntu a powerful collection of soware.

Open source software

Ubuntu is open source soware. Open source soware differs from pro-
prietary soware—soware whose source code is not freely available for
modification or distribution by anyone but the rightsholder. Microso The source code of a program is the collection

of files that have been written in a computer
language to make the program.

Windows and Adobe Photoshop are examples of proprietary soware.

Proprietary software is software that cannot be
copied, modified, or distributed freely.

Unlike proprietary soware applications, the soware included with
Ubuntu is specifically licensed to promote sharing and collaboration. e
legal rules governing Ubuntu’s production and distribution ensure that
anyone can obtain, run, or share it for any purpose she or he wishes.
Computer users can modify open source soware like Ubuntu to suit
their individual needs, to share it, to improve it, or to translate it into
other languages—provided they release the source code for these mod-
ifications so others can do the same. In fact, the terms of many open
source licensing agreements actually make it illegal not to do so. For
more information regarding Ubuntu’s soware licensing standards, see
http://www.ubuntu.com/project/about-ubuntu/licensing.

Because open source soware is developed by large communities of
programmers distributed throughout the globe, it benefits from rapid de-
velopment cycles and speedy security releases (in the event that someone
discovers bugs in the soware). In other words, open source soware is
updated, enhanced, and made more secure every day as programmers all
over the world continue to improve it.

Aside from these technical advantages, open source soware also has
economic benefits. While users must adhere to the terms of an open source
licensing agreement when installing and using Ubuntu, they needn’t pay
to obtain this license. And while not all open source soware is free of
monetary costs, much is.

To learn more about open source soware, see the Open Source Initia-
tive’s open source definition, available at http://www.opensource.org/docs/
definition.php.

Distribution families

Ubuntu is one of several popular operating systems based on Linux (an
open source operating system). ese Linux-based operating systems—

http://www.ubuntu.com/project/about-ubuntu/licensing
http://www.opensource.org/docs/definition.php
http://www.opensource.org/docs/definition.php
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called Linux “distributions,”—may look different from Ubuntu at first glance,
but they share similar characteristics because of their common roots. A distribution, or “distro,” is an operating

systemmade from open source applications,
which are bundled together to make them
easier to install and use.

Linux distributions can be divided into two broad families: the Debian
family and the Red Hat family. Each family is named for a distribution on
which subsequent distributions are based. For example, “Debian” refers
to both the name of a Linux distribution as well as the family of distribu-
tions derived from Debian. Ubuntu is part of this family. When describing
relationships between various open source projects, soware developers
oen use the metaphor of tributaries connecting to a common body of
water. For this reason, you may hear someone say that Ubuntu is located
“downstream” from Debian, because alterations to Debian flow into new
versions of Ubuntu. Additionally, improvements to Ubuntu usually trickle
“upstream”—back to Debian and its family members. Other distributions
in the Debian family include Linux Mint, Xandros, and CrunchBang Linux.
Distributions in the Red Hat family include Fedora, openSUSE, and Man-
driva.

e most significant difference between Debian-based and Red Hat-
based distributions is the system each uses for installing and updating
soware. ese systems are called “package management systems.” Debian Package management systems are the means by

which users can install, remove, and organize
software installed on computers with open
source operating systems like Ubuntu.

soware packages are  files, while Red Hat soware packages are 
files. e two systems are generally incompatible. For more information
about package management, see Chapter : Soware Management.

You will also find Linux distributions that have been specialized for
certain tasks. Next, we’ll describe these versions of Ubuntu and explain the
uses for which each has been developed.

Choosing amongst Ubuntu and its derivatives

Just as Ubuntu is based on Debian, several distributions are subsequently
based on Ubuntu. Each differs with respect to the soware included as part
of the distribution. Some are developed for general use, while others are
designed for accomplishing a more narrow set of tasks.

Alternative interfaces

Ubuntu features a graphical user interface () based on the open source
 desktop. As we explained in Chapter : e Ubuntu Desktop, a
“user interface” is a collection of soware elements—icons, colors, windows,
themes, and menus—that determines how someone may interact with a
computer. Some users prefer using alternatives to , so they have
created Ubuntu distributions featuring different user interfaces. ese
include:

‣ Kubuntu, which uses the  graphical environment instead of the
 environment found in Ubuntu;

‣ Lubuntu, which uses the  graphical environment instead of the
 environment found in Ubuntu; and

‣ Xubuntu, which uses the  graphical environment instead of the
 environment found in Ubuntu.

Additionally, each of these distributions may contain default applications
different from those featured in Ubuntu. For instance, the default music
player in Ubuntu is Banshee, but in Lubuntu the default music player is
Aqualung, and in Kubuntu the default is Amarok. Be sure to investigate
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these differences if you are considering installing an Ubuntu distribution
with an alternative desktop environment.

For more information about these and other derivative distributions, see
http://www.ubuntu.com/project/derivatives.

Task-specific distributions

Other Ubuntu distributions have been created to accomplish specific tasks
or run in specialized seings.

Ubuntu Server Edition

e Ubuntu Server Edition is an operating system optimized to perform
multi-user tasks when installed on servers. Such tasks include file shar- A server is a computer that’s been configured to

manage, or “serve,” files many people wish to
access.

ing and website or email hosting. If you are planning to use a computer
to perform tasks like these, you may wish to use this specialized server
distribution in conjunction with server hardware.

is manual does not explain the process of running a secure web server
or performing other tasks possible with Ubuntu Server Edition. For details
on using Ubuntu Server Edition, refer to the manual at http://www.ubuntu.
com/business/server/overview.

Edubuntu

Edubuntu is an Ubuntu derivative customized for use in schools and other
educational institutions. It contains soware similar to that offered in
Ubuntu, but also features additional applications—like a collaborative text
editor and educational games.

For additional information regarding Edubuntu, visit http://www.
edubuntu.org/

Ubuntu Studio

is derivative of Ubuntu is designed specifically for people who use com-
puters to create and edit multimedia projects. It features applications to
help users manipulate images, compose music, and edit video. While users
can install these applications on computers running the desktop version of
Ubuntu, Ubuntu Studio makes them all available immediately upon installa-
tion.

If you would like to learn more about Ubuntu Studio (or obtain a copy
for yoursel), visit http://ubuntustudio.org/home.

Mythbuntu

Mythbuntu allows users to turn their computers into entertainment sys-
tems. It helps users organize and view various types of multimedia content
such as movies, television shows, and video podcasts. Users with  tuners
in their computers can also use Mythbuntu to record live video and televi-
sion shows.

To learn more about Mythbuntu, visit http://www.mythbuntu.org/.

Finding additional help and support

is guide cannot possibly contain everything you’ll ever need to know
about Ubuntu. Because Geing Started with Ubuntu . could never an-

http://www.ubuntu.com/project/derivatives
http://www.ubuntu.com/business/server/overview
http://www.ubuntu.com/business/server/overview
http://www.edubuntu.org/
http://www.edubuntu.org/
http://ubuntustudio.org/home
http://www.mythbuntu.org/
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swer all your questions, we encourage you to take advantage of Ubuntu’s
vast community when seeking further information, troubleshooting tech-
nical issues, or asking questions about your computer. Next, we’ll discuss a
few of these resources so you can learn more about Ubuntu or other Linux
distributions.

Live chat

If you are familiar with Internet relay chat (), you can use chat clients
such as XChat or Pidgin to join the channel #ubuntu on irc.freenode.net.
Here, hundreds of volunteer users can answer your questions or offer sup-
port in real time.

LoCo teams

Within the Ubuntu community are dozens of local user groups called “LoCo
teams”. Spread throughout the world, these teams offer support and advice,
answer questions and promote Ubuntu in their communities by hosting
regular events. To locate and contact the LoCo team nearest you, visit
http://loco.ubuntu.com/.

Official Ubuntu Documentation

e Ubuntu Documentation team maintains a series of official wiki pages In addition to official Ubuntu and community
help, you will often find third-party help avail-
able on the Internet. While these documents
can often seem like great resources, some
could be misleading or outdated. It’s always
best to verify information from third-party
sources before taking their advice. When possi-
ble, rely on official Ubuntu documentation for
assistance with Ubuntu.

designed to assist both new and experienced users wishing to learn more
about Ubuntu. e Ubuntu community endorses these documents, which
serve as a reliable first point of reference for users seeking help online. You
can access these at http://help.ubuntu.com. To get to the built-in Ubuntu
Desktop Guide, press F1 on your desktop, or type yelp in the Dash.

The Ubuntu Forums

e Ubuntu Forums are the official forums of the Ubuntu community. Mil-
lions of Ubuntu users use them daily to seek help and support from one
another. You can create an Ubuntu Forums account in minutes. To create
an account and learn more about Ubuntu from community members, visit
http://ubuntuforums.org.

Launchpad Answers

Launchpad, an open source code repository and user community, provides a
question and answer service that allows anyone to ask questions about any
Ubuntu-related topic. Signing up for a Launchpad account requires only
a few minutes. Ask a question by visiting Launchpad at https://answers.
launchpad.net/ubuntu/+addquestion.

Ask Ubuntu

Ask Ubuntu is a free community driven estion and Answer website for
Ubuntu users and developers. It is part of the Stack Exchange network of
websites. is is one of the best Ubuntu support resources available for free.
Visit http://www.askubuntu.com to get started.

http://loco.ubuntu.com/
http://help.ubuntu.com
http://ubuntuforums.org
https://answers.launchpad.net/ubuntu/+addquestion
https://answers.launchpad.net/ubuntu/+addquestion
http://www.askubuntu.com
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Search Engines

Because Ubuntu is a popular open source operating system, many users
have wrien about it online. erefore, using search engines to locate
answers to your questions about Ubuntu is oen an effective means of
acquiring help. When using search engines to answer questions about
Ubuntu, ensure that your search queries are as specific as possible. In other
words, a search for “Unity interface” will return results that are less useful
than those associated with the query “how to use Ubuntu Unity interface”
or “how to customize Ubuntu Unity interface.”

Community support

If you’ve exhausted all these resources and still can’t find answers to your
questions, visit Community Support at http://www.ubuntu.com/support/
community.

The Ubuntu community

Surrounding Ubuntu is a global community of passionate users who want to
help others adopt, use, understand, and even modify or enhance Ubuntu. By
choosing to install and run Ubuntu, you’ve become part of this community.
As you learn more about Ubuntu, you may wish to collaborate with others
to make it beer—to discuss the future of Ubuntu, to report soware bugs
you discover, to promote Ubuntu to new users, to share Ubuntu advice,
or to answer other users’ questions. In this section, we’ll discuss a few
community projects that can connect you to other Ubuntu users.

Full Circle Magazine

Full Circle Magazine is “the independent magazine for the Ubuntu Linux
community.” Released every month, Full Circle Magazine contains reviews
of new soware (including games) for Ubuntu, step-by-step tutorials for
projects you can undertake with Ubuntu, editorials discussing important
issues in the Ubuntu community, and Ubuntu tips from other users. You can
download issues of Full Circle Magazine at http://fullcirclemagazine.org/.

The Ubuntu UK Podcast

Produced by members of the UK’s Ubuntu LoCo team, this bi-weekly online
audio broadcast (or “podcast”) features lively discussion about Ubuntu, and
oen includes interviews with Ubuntu community members who work to
improve Ubuntu. Episodes are available at http://podcast.ubuntu-uk.org/. A podcast is a radio-style broadcast available as

an audio file for download to computers and
portable media players.

OMG! Ubuntu!

OMG! Ubuntu! is a weblog that aims to inform the Ubuntu community
about Ubuntu news, events, announcements, and updates in a timely fash-
ion. It also allows Ubuntu users to discuss ways they can promote or share
Ubuntu. You can read this blog or subscribe to it at http://www.omgubuntu.
co.uk/.

http://www.ubuntu.com/support/community
http://www.ubuntu.com/support/community
http://fullcirclemagazine.org/
http://podcast.ubuntu-uk.org/
http://www.omgubuntu.co.uk/
http://www.omgubuntu.co.uk/
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Contributing to this manual

You can also participate in the Ubuntu community by contributing to this
manual. You might choose to write new content for it, edit its chapters
so they are easier for new Ubuntu users to understand and use, or trans-
late it in your own language. You may also provide the screenshots found
throughout the manual. To get involved in the Ubuntu Manual Project, visit
http://ubuntu-manual.org/getinvolved.

http://ubuntu-manual.org/getinvolved


A License

Creative Commons Attribution–ShareAlike 3.0 Legal Code

  (  )       
    (“”  “”).   
   /   .    
          
 .

        ,  
          .   
        ,   
         
    .

. Definitions

(a) “Adaptation” means a work based upon the Work, or upon the Work
and other pre-existing works, such as a translation, adaptation,
derivative work, arrangement of music or other alterations of a lit-
erary or artistic work, or phonogram or performance and includes
cinematographic adaptations or any other form in which the Work
may be recast, transformed, or adapted including in any form recog-
nizably derived from the original, except that a work that constitutes
a Collection will not be considered an Adaptation for the purpose of
this License. For the avoidance of doubt, where the Work is a musical
work, performance or phonogram, the synchronization of the Work in
timed-relation with a moving image (“synching”) will be considered
an Adaptation for the purpose of this License.

(b) “Collection” means a collection of literary or artistic works, such
as encyclopedias and anthologies, or performances, phonograms
or broadcasts, or other works or subject maer other than works
listed in Section () below, which, by reason of the selection and
arrangement of their contents, constitute intellectual creations, in
which the Work is included in its entirety in unmodified form along
with one or more other contributions, each constituting separate and
independent works in themselves, which together are assembled into
a collective whole. A work that constitutes a Collection will not be
considered an Adaptation (as defined below) for the purposes of this
License.

(c) “Creative Commons Compatible License” means a license that is
listed at http://creativecommons.org/compatiblelicenses that has been
approved by Creative Commons as being essentially equivalent to this
License, including, at a minimum, because that license: (i) contains
terms that have the same purpose, meaning and effect as the License
Elements of this License; and, (ii) explicitly permits the relicensing
of adaptations of works made available under that license under this
License or a Creative Commons jurisdiction license with the same
License Elements as this License.

(d) “Distribute” means to make available to the public the original and
copies of the Work or Adaptation, as appropriate, through sale or
other transfer of ownership.

http://creativecommons.org/compatiblelicenses
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(e) “License Elements” means the following high-level license aributes
as selected by Licensor and indicated in the title of this License: Ari-
bution, ShareAlike.

() “Licensor” means the individual, individuals, entity or entities that
offer(s) the Work under the terms of this License.

(g) “Original Author” means, in the case of a literary or artistic work, the
individual, individuals, entity or entities who created the Work or if
no individual or entity can be identified, the publisher; and in addition
(i) in the case of a performance the actors, singers, musicians, dancers,
and other persons who act, sing, deliver, declaim, play in, interpret or
otherwise perform literary or artistic works or expressions of folklore;
(ii) in the case of a phonogram the producer being the person or legal
entity who first fixes the sounds of a performance or other sounds;
and, (iii) in the case of broadcasts, the organization that transmits the
broadcast.

(h) “Work” means the literary and/or artistic work offered under the
terms of this License including without limitation any production
in the literary, scientific and artistic domain, whatever may be the
mode or form of its expression including digital form, such as a book,
pamphlet and other writing; a lecture, address, sermon or other work
of the same nature; a dramatic or dramatico-musical work; a choreo-
graphic work or entertainment in dumb show; a musical composition
with or without words; a cinematographic work to which are assim-
ilated works expressed by a process analogous to cinematography;
a work of drawing, painting, architecture, sculpture, engraving or
lithography; a photographic work to which are assimilated works ex-
pressed by a process analogous to photography; a work of applied art;
an illustration, map, plan, sketch or three-dimensional work relative
to geography, topography, architecture or science; a performance; a
broadcast; a phonogram; a compilation of data to the extent it is pro-
tected as a copyrightable work; or a work performed by a variety or
circus performer to the extent it is not otherwise considered a literary
or artistic work.

(i) “You” means an individual or entity exercising rights under this Li-
cense who has not previously violated the terms of this License with
respect to the Work, or who has received express permission from
the Licensor to exercise rights under this License despite a previous
violation.

(j) “Publicly Perform” means to perform public recitations of the Work
and to communicate to the public those public recitations, by any
means or process, including by wire or wireless means or public
digital performances; to make available to the public Works in such a
way that members of the public may access these Works from a place
and at a place individually chosen by them; to perform the Work to
the public by any means or process and the communication to the
public of the performances of the Work, including by public digital
performance; to broadcast and rebroadcast the Work by any means
including signs, sounds or images.

(k) “Reproduce” means to make copies of the Work by any means includ-
ing without limitation by sound or visual recordings and the right
of fixation and reproducing fixations of the Work, including storage
of a protected performance or phonogram in digital form or other
electronic medium.
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. Fair Dealing Rights. Nothing in this License is intended to reduce, limit,
or restrict any uses free from copyright or rights arising from limitations
or exceptions that are provided for in connection with the copyright
protection under copyright law or other applicable laws.

. License Grant. Subject to the terms and conditions of this License, Licen-
sor hereby grants You a worldwide, royalty-free, non-exclusive, perpet-
ual (for the duration of the applicable copyright) license to exercise the
rights in the Work as stated below:

(a) to Reproduce the Work, to incorporate the Work into one or more
Collections, and to Reproduce the Work as incorporated in the Collec-
tions;

(b) to create and Reproduce Adaptations provided that any such Adap-
tation, including any translation in any medium, takes reasonable
steps to clearly label, demarcate or otherwise identify that changes
were made to the original Work. For example, a translation could be
marked “e original work was translated from English to Spanish,”
or a modification could indicate “e original work has been modi-
fied.”;

(c) to Distribute and Publicly Perform the Work including as incorpo-
rated in Collections; and,

(d) to Distribute and Publicly Perform Adaptations.
(e) For the avoidance of doubt:

i. Non-waivable Compulsory License Schemes. In those jurisdictions
in which the right to collect royalties through any statutory or
compulsory licensing scheme cannot be waived, the Licensor re-
serves the exclusive right to collect such royalties for any exercise
by You of the rights granted under this License;

ii. Waivable Compulsory License Schemes. In those jurisdictions
in which the right to collect royalties through any statutory or
compulsory licensing scheme can be waived, the Licensor waives
the exclusive right to collect such royalties for any exercise by You
of the rights granted under this License; and,

iii. Voluntary License Schemes. e Licensor waives the right to col-
lect royalties, whether individually or, in the event that the Licen-
sor is a member of a collecting society that administers voluntary
licensing schemes, via that society, from any exercise by You of the
rights granted under this License.

e above rights may be exercised in all media and formats whether
now known or hereaer devised. e above rights include the right to
make such modifications as are technically necessary to exercise the
rights in other media and formats. Subject to Section (), all rights
not expressly granted by Licensor are hereby reserved.

. Restrictions. e license granted in Section  above is expressly made
subject to and limited by the following restrictions:

(a) You may Distribute or Publicly Perform the Work only under the
terms of this License. You must include a copy of, or the Uniform Re-
source Identifier (URI) for, this License with every copy of the Work
You Distribute or Publicly Perform. You may not offer or impose any
terms on the Work that restrict the terms of this License or the abil-
ity of the recipient of the Work to exercise the rights granted to that
recipient under the terms of the License. You may not sublicense the
Work. You must keep intact all notices that refer to this License and
to the disclaimer of warranties with every copy of the Work You Dis-
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tribute or Publicly Perform. When You Distribute or Publicly Perform
the Work, You may not impose any effective technological measures
on the Work that restrict the ability of a recipient of the Work from
You to exercise the rights granted to that recipient under the terms
of the License. is Section (a) applies to the Work as incorporated
in a Collection, but this does not require the Collection apart from
the Work itself to be made subject to the terms of this License. If You
create a Collection, upon notice from any Licensor You must, to the
extent practicable, remove from the Collection any credit as required
by Section (c), as requested. If You create an Adaptation, upon notice
from any Licensor You must, to the extent practicable, remove from
the Adaptation any credit as required by Section (c), as requested.

(b) You may Distribute or Publicly Perform an Adaptation only under the
terms of: (i) this License; (ii) a later version of this License with the
same License Elements as this License; (iii) a Creative Commons juris-
diction license (either this or a later license version) that contains the
same License Elements as this License (e.g., Aribution-ShareAlike
. US)); (iv) a Creative Commons Compatible License. If you license
the Adaptation under one of the licenses mentioned in (iv), you must
comply with the terms of that license. If you license the Adaptation
under the terms of any of the licenses mentioned in (i), (ii) or (iii) (the
“Applicable License”), you must comply with the terms of the Ap-
plicable License generally and the following provisions: (I) You must
include a copy of, or the URI for, the Applicable License with every
copy of each Adaptation You Distribute or Publicly Perform; (II) You
may not offer or impose any terms on the Adaptation that restrict
the terms of the Applicable License or the ability of the recipient of
the Adaptation to exercise the rights granted to that recipient under
the terms of the Applicable License; (III) You must keep intact all
notices that refer to the Applicable License and to the disclaimer of
warranties with every copy of the Work as included in the Adapta-
tion You Distribute or Publicly Perform; (IV) when You Distribute or
Publicly Perform the Adaptation, You may not impose any effective
technological measures on the Adaptation that restrict the ability of a
recipient of the Adaptation from You to exercise the rights granted to
that recipient under the terms of the Applicable License. is Section
(b) applies to the Adaptation as incorporated in a Collection, but this
does not require the Collection apart from the Adaptation itself to be
made subject to the terms of the Applicable License.

(c) If You Distribute, or Publicly Perform the Work or any Adaptations
or Collections, You must, unless a request has been made pursuant
to Section (a), keep intact all copyright notices for the Work and
provide, reasonable to the medium or means You are utilizing: (i) the
name of the Original Author (or pseudonym, if applicable) if supplied,
and/or if the Original Author and/or Licensor designate another party
or parties (e.g., a sponsor institute, publishing entity, journal) for ari-
bution (“Aribution Parties”) in Licensor’s copyright notice, terms of
service or by other reasonable means, the name of such party or par-
ties; (ii) the title of the Work if supplied; (iii) to the extent reasonably
practicable, the URI, if any, that Licensor specifies to be associated
with the Work, unless such URI does not refer to the copyright no-
tice or licensing information for the Work; and (iv) , consistent with
Ssection (b), in the case of an Adaptation, a credit identifying the
use of the Work in the Adaptation (e.g., “French translation of the
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Work by Original Author,” or “Screenplay based on original Work
by Original Author”). e credit required by this Section (c) may be
implemented in any reasonable manner; provided, however, that in
the case of a Adaptation or Collection, at a minimum such credit will
appear, if a credit for all contributing authors of the Adaptation or
Collection appears, then as part of these credits and in a manner at
least as prominent as the credits for the other contributing authors.
For the avoidance of doubt, You may only use the credit required by
this Section for the purpose of aribution in the manner set out above
and, by exercising Your rights under this License, You may not im-
plicitly or explicitly assert or imply any connection with, sponsorship
or endorsement by the Original Author, Licensor and/or Aribution
Parties, as appropriate, of You or Your use of the Work, without the
separate, express prior wrien permission of the Original Author,
Licensor and/or Aribution Parties.

(d) Except as otherwise agreed in writing by the Licensor or as may be
otherwise permied by applicable law, if You Reproduce, Distribute
or Publicly Perform the Work either by itself or as part of any Adap-
tations or Collections, You must not distort, mutilate, modify or take
other derogatory action in relation to the Work which would be prej-
udicial to the Original Author’s honor or reputation. Licensor agrees
that in those jurisdictions (e.g. Japan), in which any exercise of the
right granted in Section (b) of this License (the right to make Adap-
tations) would be deemed to be a distortion, mutilation, modification
or other derogatory action prejudicial to the Original Author’s honor
and reputation, the Licensor will waive or not assert, as appropriate,
this Section, to the fullest extent permied by the applicable national
law, to enable You to reasonably exercise Your right under Section
(b) of this License (right to make Adaptations) but not otherwise.

. Representations, Warranties and Disclaimer
         ,
         
      , , ,
  , ,  , 
  , ,     ,
,        , 
,       ,   
.        
 ,        .

. Limitation on Liability.       
 ,            
   , , ,  
           
,           
.

. Termination

(a) is License and the rights granted hereunder will terminate automat-
ically upon any breach by You of the terms of this License. Individuals
or entities who have received Adaptations or Collections from You
under this License, however, will not have their licenses terminated
provided such individuals or entities remain in full compliance with
those licenses. Sections , , , , , and  will survive any termination
of this License.
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(b) Subject to the above terms and conditions, the license granted here is
perpetual (for the duration of the applicable copyright in the Work).
Notwithstanding the above, Licensor reserves the right to release
the Work under different license terms or to stop distributing the
Work at any time; provided, however that any such election will not
serve to withdraw this License (or any other license that has been, or
is required to be, granted under the terms of this License), and this
License will continue in full force and effect unless terminated as
stated above.

. Miscellaneous

(a) Each time You Distribute or Publicly Perform the Work or a Collec-
tion, the Licensor offers to the recipient a license to the Work on the
same terms and conditions as the license granted to You under this
License.

(b) Each time You Distribute or Publicly Perform an Adaptation, Licensor
offers to the recipient a license to the original Work on the same
terms and conditions as the license granted to You under this License.

(c) If any provision of this License is invalid or unenforceable under
applicable law, it shall not affect the validity or enforceability of the
remainder of the terms of this License, and without further action
by the parties to this agreement, such provision shall be reformed
to the minimum extent necessary to make such provision valid and
enforceable.

(d) No term or provision of this License shall be deemed waived and no
breach consented to unless such waiver or consent shall be in writing
and signed by the party to be charged with such waiver or consent.

(e) is License constitutes the entire agreement between the parties
with respect to the Work licensed here. ere are no understandings,
agreements or representations with respect to the Work not specified
here. Licensor shall not be bound by any additional provisions that
may appear in any communication from You. is License may not be
modified without the mutual wrien agreement of the Licensor and
You.

() e rights granted under, and the subject maer referenced, in this
License were draed utilizing the terminology of the Berne Conven-
tion for the Protection of Literary and Artistic Works (as amended on
September , ), the Rome Convention of , the WIPO Copy-
right Treaty of , the WIPO Performances and Phonograms Treaty
of  and the Universal Copyright Convention (as revised on July
, ). ese rights and subject maer take effect in the relevant
jurisdiction in which the License terms are sought to be enforced
according to the corresponding provisions of the implementation of
those treaty provisions in the applicable national law. If the standard
suite of rights granted under applicable copyright law includes addi-
tional rights not granted under this License, such additional rights are
deemed to be included in the License; this License is not intended to
restrict the license of any rights under applicable law.

Creative Commons Notice

Creative Commons is not a party to this License, and makes no warranty
whatsoever in connection with the Work. Creative Commons will not be
liable to You or any party on any legal theory for any damages whatsoever,
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including without limitation any general, special, incidental or consequen-
tial damages arising in connection to this license. Notwithstanding the
foregoing two () sentences, if Creative Commons has expressly identified
itself as the Licensor hereunder, it shall have all rights and obligations of
Licensor.

Except for the limited purpose of indicating to the public that the Work
is licensed under the CCPL, Creative Commons does not authorize the use
by either party of the trademark “Creative Commons” or any related trade-
mark or logo of Creative Commons without the prior wrien consent of
Creative Commons. Any permied use will be in compliance with Creative
Commons’ then-current trademark usage guidelines, as may be published
on its website or otherwise made available upon request from time to time.
For the avoidance of doubt, this trademark restriction does not form part of
the License.

Creative Commons may be contacted at http://creativecommons.org/.

http://creativecommons.org/




Glossary
Canonical Canonical, the financial backer of Ubuntu, provides support for

the core Ubuntu system. It has over  paid staff members worldwide
who ensure that the foundation of the operating system is stable, as well
as checking all the work submied by volunteer contributors. To learn
more about Canonical, go to http://www.canonical.com.

cursor e (usually) blinking square or vertical line used to show you
where text will appear when you start typing. You can move it around
with the arrow keys on your keyboard prompt in a terminal or other
text-input application.

decrypted When you decrypt an encrypted file it becomes decrypted, and
viewable. Encrypted files on Ubuntu are not recognizable in any lan-
guage, they are just a string of random numbers and leers until they are
decrypted using a password.

desktop environment A generic term to describe a  interface for humans
to interact with computers. ere are many desktop environments such
as , ,  and  just to name a few.

  stands for Dynamic Host Configuration Protocol, it is used by a
 server to assign computers on a network an  address automati-
cally.

dialup connection A dialup connection is when your computer uses a mo-
dem to connect to an  through your telephone line.

distribution A distribution is a collection of soware that is already com-
piled and configured ready to be installed. Ubuntu is an example of a
distribution.

dual-booting dual-booting is the process of being able to choose one of two
different operating systems currently installed on a computer from the
boot menu. Once selected your computer will then boot into whichever
operating system you chose at the boot menu. Dual booting is oen used
generically, and may refer to booting among more than two operating
systems.

Ethernet port An Ethernet port is what an Ethernet cable is plugged into
when you are using a wired connection.

  (which once stood for  Network Object Model Environ-
ment) is the default desktop environment used in Ubuntu.

 e  (which stands for Graphical User Interface) is a type of user in-
terface that allows humans to interact with the computer using graphics
and images rather than just text.

  stands for Internet Service Provider, an  is a company that provides
you with your Internet connection.

kernel A kernel is the central portion of a Unix-based operating system,
responsible for running applications, processes, and providing security
for the core components.

http://www.canonical.com
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maximize When you maximize an application in Ubuntu it will fill the
whole desktop, excluding the panels.

MeMenu e MeMenu in Ubuntu . allows you to manage your pres-
ence on social networking services. It also allows you to publish status
messages to all of your accounts by entering updates into a text field.

output e output of a command is any text it displays on the next line
aer typing a command and pressing enter, e.g., if you type pwd into a
terminal and press Enter, the directory name it displays on the next line
is the output.

package Packages contain soware in a ready-to-install format. Most of
the time you can use the Soware Center instead of manually installing
packages. Packages have a .deb extension in Ubuntu.

parameter Parameters are special options that you can use with other
commands in the terminal to make that command behave differently, this
can make a lot of commands far more useful.

partition A partition is an area of allocated space on a hard drive where
you can put data.

partitioning partitioning is the process of creating a partition.
prompt e prompt displays some useful information about your computer,

it can be customized to display in different colors as well as being able to
display the time, date and current directory as well as almost anything
else you like.

proprietary Soware made by companies that don’t release their source
code under an open source license.

router A router is a specially designed computer that using its soware and
hardware, routes information from the Internet to a network. It is also
sometimes called a gateway.

server A server is a computer that runs a specialized operating system and
provides services to computers that connect to it and make a request.

shell e terminal gives access to the shell, when you type a command into
the terminal and press enter the shell takes that command and performs
the relevant action.

Soware Center e Soware Center is where you can easily manage so-
ware installation and removal as well as the ability to manage soware
installed via Personal Package Archives.

terminal e terminal is Ubuntu’s text only interface, it is a method of
controlling some aspects of the operating system using only commands
entered via the keyboard.

USB Universal Serial Bus is a standard interface specification for connect-
ing peripheral hardware devices to computers. USB devices range from
external hard drives to scanners and printers.

wired connection A wired connection is when your computer is physically
connected to a router or Ethernet port with a cable, this is the most
common connection for desktop computers.

wireless connection A network connection that uses a wireless signal to
communicate with either a router, access point, or computer.



Credits
is manual wouldn’t have been possible without the efforts and contribu-
tions from the following people:

Team leads

Benjamin Humphrey—Project Creator
Kevin Godby—Lead TEXnician
Rick Fosburgh—Editor in Chief (Maverick, Oneiric)
John Xygonakis—Authors Coordinator  Translation Maintainer
Hannie Dumoleyn—Translation Maintainer
orsten Wilms—Design
Adnane Belmadiaf—Web development

Authors

Herat Gandhi Amrish
Bryan Behrenshausen
Senthil Velan Bhooplan
Mario Burgos
Sayantan Das
Patrick Dickey

Che Dean
Hannie Dumoleyn
Will Kromer
Simon Lewis
Ryan Macnish
Mez Pahlan

Brian Peredo
Kartik Sulakhe
Tom Swartz
Ryan Ward
David Wales
John Xygonakis

Editors

Alan Beebe
Bryan Behrenshausen
Bob Bolin
Mario H. Burgos
Sara de la Cruz
Sayantan Das
Hannie Dumoleyn

Rick Fosburgh
Kevin Godby
haydoni
Ilya Haykinson
Linda Horne
Isabell Long
Ryan Macnish

Sam Mercier
Paco Patag
James Romines
Anthony Venable
Chris Woollard
Uli

Designers

orsten Wilms

Developers

Adnane Belmadiaf Kevin Godby



     .

Translation editors

Fran Diéguez (Galician)
Hannie Dumoleyn (Dutch)
Shazedur Rahim Joardar (Bengali)

Xuacu Saturio (Asturian)
Daniel Schury (German)
Shrinivasan (Tamil)

Chris Woollard (British English)
John Xygonakis (Greek)

Special thanks

Chris_Ilias
Manualbot
crocodoc.com

e Ubuntu Documentation Team
e Ubuntu Community Learning Project

Past contributors

Jason Cook (Editor)
Jamin Day (Editor)
Joe Burgess (Author)
omas Cantara (Author)
Kelvin Gardiner (Author)
Ma Griffin (Author)
Wolter Hellmund (Author)
Josh Holland (Author, Translation Maintenance)

Benjamin Humphrey (Author, Project Leader)
Luke Jennings (Author, Editor, Developer)
Elan Kugelmass (Author)
Alexander Lancey (Author)
Neil Tallim (Developer)
David Nel (Designer)
K. Vishnoo Charan Reddy (Designer)
Wolter Hellmund (Designer)



Index

Apple, see MacBook
audio, see sound

Bluetooth, 
boot

cannot choose Ubuntu, 

Canonical, 
command line, see terminal

Debian, , see also Linux
display

adding secondary display, 
changing resolution, 
resolution, troubleshooting, 

EeePC
help, troubleshooting, 

email
address book, 
reading, 
replying, 
underbird setup, 

encryption, see security

files
browsing for, 
deleting and recovering, 
search, 
searching for, 

Firewall
installing, 
using, 

FireWire, see IEEE 
folders

searching for, 

groups, see also users
adding, 
deleting, 
modifying, 

hardware
troubleshooting, 

help
chat, live, 
documentation, 
forums, 

IEEE , 
install, Ubuntu, 

Windows installer, 

kernel, 

Linux, –
Linux distributions, 
login screen

missing, 

MacBook
help, troubleshooting, 

MacOS X, see MacBook
monitor, see display

password, see security
printer

add via USB, 
adding via network, 
using, 

scanner
troubleshooting, 
using, 

screen, see display
security

basic concepts, 
encrypting personal folders, 
passwords, 
passwords, reseing, 
permissions, 

Shuleworth, Mark, 
soware

removing, 
adding repository, 
installing, 
open source, 
repositories, about, 

Soware Center, Ubuntu, 
sound

will not play, 
volume, preferences, 

startup
Ubuntu, see boot

system requirements, 

terminal
about, 
using, 

Ubuntu
clean

removing temporary files, 
definition of, 
derivatives, 
downloading, 
history of, 
philosophy of, 
server, 

Ubuntu Promise, 
Unity

overview, 
Unix, , 
USB, 
users, see also groups

adding, 
deleting, 
modifying, 

video
will not play, 

volume, see sound

webcam, 





is book was typeset with XƎLATEX.

e book design is based on the Tue-LATEX document classes available at http://code.google.com/p/tufte-latex/.

e text face is Linux Libertine, designed by Philipp H. Poll. It is an open font available at http://linuxlibertine.sf.net/.

e captions and margin notes are set in Ubuntu, a font commissioned by Canonical and designed by Dalton Maag. It is freely
available for download at http://font.ubuntu.com/.

e terminal text and keystrokes are set in Bera Mono, originally developed by Bitstream, Inc. as Bitstream Vera.

e screenshots were captured using ickshot, available at http://ubuntu-manual.org/quickshot.

e cover and title page pictograms contain shapes taken from the Humanity icon set, available at https://launchpad.net/humanity.

e title page and cover were designed using Inkscape, available at http://inkscape.org/.

http://code.google.com/p/tufte-latex/
http://linuxlibertine.sf.net/
http://font.ubuntu.com/
http://ubuntu-manual.org/quickshot
https://launchpad.net/humanity
http://inkscape.org/

	Title page
	Contents
	Prologue
	Welcome
	Ubuntu Philosophy
	A brief history of Ubuntu
	Is Ubuntu right for you?
	Contact details
	About the team
	Conventions used in this book

	Installation
	Getting Ubuntu
	The Live CD/USB stick
	Installing Ubuntu
	Ubuntu installer for Windows

	The Ubuntu Desktop
	Understanding the Ubuntu desktop
	Unity
	The Dash
	Browsing files on your computer
	Using Launcher
	Workspaces
	Managing windows
	Nautilus file manager
	Searching for files and folders on your computer
	Customizing your desktop
	Accessibility
	Session options
	Getting help

	Working with Ubuntu
	All the applications you need
	Getting online
	Browsing the web
	Reading and composing email
	Using instant messaging
	Microblogging
	Viewing and editing photos
	Watching videos and movies
	Listening to audio and music
	Burning CDs and DVDs
	Working with documents, spreadsheets, and presentations
	Ubuntu One
	Getting started with Ubuntu One
	Using Ubuntu One

	Hardware
	Using your devices
	Hardware identification
	Displays
	Connecting and using your printer
	Sound
	Using a webcam
	Scanning text and images
	Other devices

	Software Management
	Software management in Ubuntu
	Using the Ubuntu Software Center
	Managing additional software
	Manual software installation
	Updates and upgrades

	Advanced Topics
	Ubuntu for advanced users
	Introduction to the terminal
	Ubuntu file system structure
	Securing Ubuntu
	Why Ubuntu is safe
	Basic security concepts
	Users and groups
	System updates
	Firewall
	Encryption

	Troubleshooting
	Resolving problems
	Troubleshooting guide
	Getting more help

	Learning More
	What else can I do with Ubuntu?
	Open source software
	Distribution families
	Choosing amongst Ubuntu and its derivatives
	Finding additional help and support
	The Ubuntu community
	Contributing to this manual

	License
	Creative Commons Attribution–ShareAlike 3.0 Legal Code
	Creative Commons Notice

	Glossary
	Credits
	Team leads
	Authors
	Editors
	Designers
	Developers
	Translation editors
	Special thanks
	Past contributors

	Index
	Colophon

